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Part I

Getting Started

Introdu
tion

Denemo lets you 
reate musi
al s
ores. You 
an type musi
 in using the keyboard or play it in using a MIDI 
ontoller or the

mi
rophone input. You 
an edit your musi
 � the input display window shows you what you are working on in musi
 notation

� and you 
an playba
k to 
he
k how it sounds. The Print View window shows the �nal printed s
ore, typeset to the highest

standards used in the musi
 publishing industry � thanks to the Lilypond musi
 typesetting program.

This separation of the �nal typesetting window from the input display avoids the 
onstant dragging about of overlapping

notation whi
h is typi
al of musi
 notation programs. It also means you are less likely to input a slur when you mean a tie,

or a whole note rest when you mean a whole measure rest, for example � these often look similar in the typeset and are

easily 
onfused, but Denemo's input display makes 
lear the distin
tion. Nevertheless, if you do wish to tweak the appearan
e

dragging and re-positioning of some notation is possible on the �nal typeset display.

Some Terminology

Besides the terms well-known to musi
ians, musi
 notation has some spe
ialized names and Denemo uses some terms with

spe
i�
 meanings whi
h you should know:

� A movement is a 
ontinous stret
h of musi
 (all the measures following on from ea
h other) su
h as a song in a songbook,

or a movement in a symphony.

� A s
ore is one or more movements usually interspersed with titles.

� A sta� has the usual meaning, but note that it may 
ontain several lines of musi
 (voi
es). A Denemo sta� may also be

typeset as a line of Chord Symbols, Fret Diagrams, or a line of dynami
s markings above or below some other sta�.

� The term voi
e is used in two senses: as a line of musi
 moving independently on a sta�, and (as in Voi
e 1, Voi
e 2 ), a

voi
e that has its stems in one dire
tion, with 
orresponding 
hanges to the pla
ing of ties, slurs, ornaments et
). Voi
es

are normally displayed on separate sta�s in the Denemo Display to make them easy to edit; the LilyPond typesetter has

the task of pla
ing them on the same sta�.

� A 
hord is one or more notes of the same duration making a single musi
al obje
t. If the notes are of di�erent durations

then they have to be pla
ed in separate voi
es, they 
an't be a 
hord, though they may appear so (by sharing stems) in

the typeset.

� A system is what might be 
alled a �line� of the musi
 on the page, that is all the musi
 (over several sta�s) that sounds

together starting at the left-hand margin and ending at the right margin.

� Markup is text � e. g. titles � that 
an have additional 
hara
ters to indi
ate bold or itali
, repositioning et
. In Denemo

this may even in
lude syntax for snippets of musi
, note-names fret diagrams et
., so that these 
an appear in the text.

� Sta� Spa
es a unit of measurement: the distan
e between adja
ent lines in a sta�. Generally when you need to spe
ify

a distan
e in Denemo this is the unit used. So the Markup to System spa
ing is the spa
ing between the last title and

the �rst sta�.

� Part is used with a spe
ial sense in Denemo: ea
h sta� has a part name asso
iated with it (printed at top left of the

sta�, with a green ba
kground for editing it). All sta�s with the same part name (or with none) are typeset together

by the Print Part 
ommand.

� http://lilypond.org/do
/v2.18/Do
umentation/musi
-glossary/index.htmlis a good guide espe
ially for non-native speak-

ers of English.

1 Input Methods

Most people will start with playing around with Denemo using the mouse, but by the time you are reading this you will

want something more e�
ient. Try using the p
 keyboard. By default, keys a to g represent the note names and 0 to 6 the

di�erent durations (whole note, half note et
). When the 
ursor is appending (blue) pressing key 0 will insert a whole note

at the 
ursor. Pressing the a key will append the nearest A. If the duration of the next note is the same you 
an simply type

the note name, it will use the last entered duration. There are keypresses (+/-, and plus/minus on the numeri
 keypad) to

set sharp/�at/double-sharp/double-�at for the next entered note and to sharpen or �atten. Use +/- with the shift key to

sharpen or �atten an existing note. Likewise, Shift with a number key edits the duration of a note.

When the 
ursor is moved on to a note (with the arrow key or mouse) the 
ursor turns green and then a to g edits the

note name. To insert a note before a note at the 
ursor use a double strike A,A to G,G. When the 
ursor is green tothe keys
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Shift-0 to Shift-6 
hange the duration of the note, while 0 to 6 insert a note before the 
ursor. (If you use the numeri


keypad you 
an use Shift-KP0 to Shift-KP6 for this). The arrow keys move the 
ursor around, the period key adds a dot

while Alt-a to Alt-g add notes to the 
hord at the 
ursor. Ins inserts a note in a 
hord whether the 
ursor is on (green) or

after (blue) a note, a double Del, Del removes it.

When in the appending position the 
ursor shows as a large blue or red re
tangle on a note-position. Blue indi
ates a note


an be appended at that point without over�owing the measure. Red indi
ates that the measure is already full. When the


ursor is a smaller green re
tangle it indi
ates that you are not in the appending position: you 
an edit the note/obje
t at

the 
ursor or insert before it. The verti
al blue line indi
ates the insertion point.

For a more detailed des
ription of Denemo's various input methods, see A Survey of the Input Methods. You 
an �nd

more short
uts by exploring the menu system � e. g. under the Notes/Rests menu the Sele
t Duration submenu gives Remove

Dot with the short
ut Control-period shown in blue next to the 
ommand.

Alternatively, a list is available in the Help menu. There are thousands of 
ommands in Denemo, so get to know the

Command Center5 where you 
an sear
h for 
ommands by key words su
h as slur, ossia, beam, Da Capo, 
res
. et
.

Initially, Denemo starts with tooltips popping up almost everywhere. When they be
ome too annoying you 
an tame them

with Help->Turn Ex
essive Tooltips (O�/On), and you 
an further delay the remaining tooltips appearing via Edit->Change

Preferen
es.

And on
e you have stopped playing around with the mouse for entering notes you 
an hide the palettes at the side to give

more room for the musi
 display (right 
li
k and Edit Palette).

1.1 Some Common Keyboard Short
uts

Here are a few of the keyboard short
uts that are 
ommonly used in Denemo.

� Letters a to g edit the note at the 
ursor to be A-G, if the 
ursor is in the appending position then notes are added.

Letters A-G (either CapsLo
k or Shift) tapped twi
e insert a note at the 
ursor.

� Numbers 0 to 6 are used to refer to the note durations Whole Note . . . 64th Note. They insert a duration at the


ursor, whi
h you then give a pit
h to with a note name. With the shift key held (or the CapsLo
k on) 0 to 6 edits

the duration of the note at the 
ursor. The 
orresponding Numeri
 Keypad keys 
an be used instead.

� The period (.) dots a note, Ctrl-. removes a dot, on the numeri
 keypad De
imal (.) 
y
les through dotted, double-

dotted, no-dot.

� Alt-0 to Alt-6 inserts a rest.

� Alt-a to Alt-g Add notes to a 
hord. Or position the 
ursor and use Insert to add a note, Ctrl-Insert to remove

it.

� 7 starts a slur, 8 extends it, while 9 redu
es it.

� Shift-/ inserts a 
autionary a

idental.

� Es
 swit
hes between various views of the musi
 whi
h 
an allow more musi
 on the s
reen at on
e.

� TAB alternately inserts a start or stop triplet marker.

� Multiply (* on the numeri
 keypad) ties/unties the note at the 
ursor.

� Divide (/ on the numeri
 keypad) sets/usets the note at the 
ursor as a gra
e note.

� Add/Subtra
t (+/- on the numeri
 keypad) sharpens/�attens the note at the 
ursor. On the main keyboard +/- make

the next inserted note sharper/�atter.

Two-key short
uts are also available su
h as "B,s" for start repeat barline and "B,e" for end repeat barline. An alternative

set of short
uts for a to g and 0 to 6 is available via the Input menu.

1.2 Some Common Mouse Short
uts

Here are a few of the mouse short
uts that are 
ommonly used in Denemo (keyboards may vary, for 
ontrol, shift, alt et


modi�ers). Note that under the Input menu is an option to turn on more mouse-friendly buttons, this is the default for

Windows users.

� Left-button 
li
k moves the 
ursor to the obje
t indi
ated by the blue 
ir
le.

� S
roll Wheel pans up/down to bring sta�s out of view into the window.

� Shift Key and S
roll Wheel pans the s
ore left/right.

� Control Key and S
roll Wheel zooms.
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� Right-button 
li
k edits at the 
ursor.

� Double-
li
k brings up the Obje
t Inspe
tor on the 
urrent obje
t, from there you 
an laun
h the Obje
t Editor.

� Shift-right-button 
li
k edits things atta
hed to the obje
t at the 
ursor.

� Double 
li
k left-button des
ribes the obje
t 
li
ked on.

� Ctrl-Shift left-button drag allow you to move stu� in the display if it is 
luttered. Typesettting is not a�e
ted.

� Ctrl-Shift Key and Right mouse button gives the menu of dire
tives to insert at the 
ursor.

1.3 Some Common Uses of MIDI in

The MIDI keyboard too 
an be 
ustomized to perform di�erent a
tions. Usually, playing notes adds or edits the s
ore (like

hitting note names at the p
-keyboard). With the sustain pedal pressed 
hords are generated (the Alt key 
an be used for

this too). If the interval between the notes played is augmented or diminished it is played on a di�erent 
hannel, so that you

are alerted to possible pit
h spelling errors (e. g. inputting A-sharp for B-�at). By holding down the Ctrl key a s
ore 
an be


he
ked by playing the notes � the 
ursor only advan
es if the 
orre
t note is played, and the Shift key 
an be held down

to route the MIDI keyboard straight to the output (e. g. to 
he
k a phrase before playing it in). There is a button in the

MIDI-in Controls to do this too, as well as a 
ontrol to set the range of sharps and �ats to be used. With the �Use Rhythm

Entry for MIDI in� 
he
ked, the duration keys 
reate pure durations (notes 
olored yellow/brown) � you 
an enter as mu
h of

the rhythm as you wish, and then play the notes on top.

1.4 Note and Rest Entry Palettes

On starting Denemo for the very �rst time a series of palettes are pla
ed near the main window with buttons to insert and


hange notes. For more serious use these just waste spa
e, so by right 
li
king on them and 
hoosing Edit this Palette they


an be hidden.
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Part II

Using Denemo

2 General Con
epts

The unit of work in Denemo is a musi
al s
ore, whi
h 
an be saved in a single �le (with .denemo su�x). This is represented

on the s
reen by a "tab". If you have several tabs open at on
e they appear just above the musi
 in the main window, and

you 
an swit
h between them by 
li
king on the tab.

One s
ore may 
ontain several movements, whi
h you 
an move between (PgUp, PgDown), insert dupli
ate, merge and delete

with the Movements menu. A movement is a 
ontinuous pie
e of musi
 with titles et
.

When you have more than one movement numbered buttons appear in the s
ore titles bar for you to navigate by. The �rst

thing on the status bar after any pending a

idental is the movement number.

In the top 
orner of the Display is a �ag i
on whi
h sets values that apply to the whole movement. Here you 
an 
ontrol

whi
h sta�s are visible in the display, whi
h are muted on playba
k, and edit any other properties of the movment.

Within a movement there are sta�s (arranged verti
ally). Ea
h Denemo Sta� has in turn a Denemo Voi
e and within the

voi
e are the Denemo Obje
ts. These 
an be notes, 
hords, key 
hanges, time signature 
hanges, voi
e 
hange obje
ts and

Denemo Dire
tive obje
ts (see Denemo Dire
tives). The sta� properties in
lude things like the number of lines (usually 5)

the MIDI instrument sound for playba
k and the amount of spa
e allotted in the display for the sta�. Before ea
h sta� are

buttons to 
ontrol properties of the sta� � �ags to set for visibility, mute, non-printing and the sta� number whi
h 
an be


li
ked to edit other sta� properties.

The notes and 
hords are displayed in 
onventional format (though not fully typeset). The position of Denemo Dire
tive

obje
ts in the musi
 is marked with a �sti
k and blob� and it is a

ompanied either by a drawing (e. g. of a double barline)

and/or some text to des
ribe it. These are used for most things that are not 
hords or notes et
: Metronome marks, repeat

barlines et
 are good examples. In this example the 
aesura is a Denemo Dire
tive obje
t marked by the sti
k and blob before

the last note and drawn on the sta� in an approximate representation of its typeset appearan
e.
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Denemo Dire
tives 
an also be atta
hed to 
hords, individual notes in a 
hord, to a sta�, to a movement or to the s
ore; in

these 
ases the dire
tive 
an be thought of as an attribute of the obje
t it is atta
hed to. In the above example the trill sign

is atta
hed to the se
ond note and this dire
tive 
an be inspe
ted and edited using the Obje
t Inspe
tor10 and Obje
t Editor

11. Denemo Dire
tives atta
hed to the sta�, movement or s
ore 
an be inspe
ted/edited too, using the relevant editors 12,

13.

If there is more than one voi
e on a sta� it is best displayed on a separate sta� in the Denemo Display, for ease of editing

� the 
lef is drawn pale and there is no time signature for su
h extra voi
es so it is easy to understand what is going on. The

Print Preview window as usual shows the �nal typeset appearan
e. The 
lef in this 
ase only a�e
ts the display, and any time

signature or key signature set on it would also only a�e
t the display.

In the Denemo display a 
ursor shows where the next note will be entered/edited. It is red for an over-full bar, blue for

appending into an under-full one and green when editing (i. e. on an already entered obje
t).

The menus in Denemo are unusual: they not only let you do some parti
ular a
tion, but also ea
h menu item lets you add

the 
ommand to a palette, enquire what the a
tion does in more detail and set keyboard/mouse short
uts for the a
tion. A

single keystroke 
an be set as a short
ut simply by pressing the key while the menu item is sele
ted. All the extra fun
tionality

of menu items 
an be a

essed by right-
li
king the menu item, while the usual left 
li
k is for exe
uting the a
tion itself. The

menus 
an always be torn o� for working with parti
ular items (e. g. working with di�erent movements or with measures,

dynami
s et
.). When you pla
e a 
ommand in a palette you 
an add to an existing palette or 
reate a new one � you 
an


hoose or 
reate any number of these, free-�oating or do
ked in the main display. Also available by right-
li
king is 
reating

new a
tions � often by modifying ones that are already there � using the S
heme s
ripting window.

When a �le is loaded it opens at the point where you left o� editing it. The position and size of the window is restored as

well as the position and size of the sour
e pdf you are trans
ribing from.
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Figure 1: Denemo Main Window

3 Denemo Main Window

The main window has menus and toolbars at the top, and palettes at top and/or right hand side. Whi
h menus and palettes

are shown are sele
ted via the View menu. At the bottom left is a status button showing whi
h movement you are in and

what sort of obje
t the Denemo Cursor is on - 
li
king on this button lets you inspe
t/edit that obje
t. Bottom right is a


ommand button - it shows the last used 
ommand and any messages the 
ommands may have given. Cli
king on this button

opens the Command Center5 on the last used 
ommand, giving full information about what the 
ommand did. The fun
tion

key Fn12 re-exe
utes the 
ommand. When a MIDI �lter is a
tive it is displayed at bottom right.

In between is where the musi
 input is displayed, the Denemo Display area. When zoomed out you see just the few

measures you are working on. By dragging the red bar at the bottom of the s
ore upwards you get spa
e for more of the

musi
. If you have many sta�s they may not all �t: you 
an still s
roll the display to see several lines of just one or two sta�s

for instan
e.

You 
an hide sta�s in the display if needed using the Sta�s->Display E�e
ts menu. If you need more room you 
an hide the

menus (using the View Menu, short
ut Es
 key), and arrange a �page view� of the input musi
 � useful when using playba
k.

At the start of ea
h sta� are the sta� tools: the �ag i
on lets you set whether the sta� will be muted or non-printing and

various other properties set on the sta�; below that the sta� number 
an be 
li
ked to edit the Denemo Dire
tives whi
h you

have installed on the sta�. All these are available from the Sta�/Voi
es menu.

3.1 The Denemo Display

The area showing the input musi
 is 
alled the Denemo display. It shows sta�s and voi
es and the musi
 interspersed with

any Dire
tives. The ba
kground is grayed out when the fo
us is elsewhere � 
li
k on the display to start typing in notes. The

ba
kground is also 
olored when input from any atta
hed MIDI keyboard is not being used for appending/editing the s
ore

(as it is by default).

The default view has a single system stret
hing o� the sides of the window � the a
tual division into lines and pages for the

typeset s
ore is done in the Print View7. In order to see more of the musi
 on the s
reen at one time there are three 
hanges

to the default view you 
an make. Firstly by pressing the Es
 key you 
an swit
h between three views, two of whi
h have no

menus taking up spa
e. At the bottom of any of these is a red line whi
h 
an be dragged up to split the display into separate

lines. Using this you 
an display more bars of musi
 at the expense of seeing more sta�s for ea
h system (the s
rolling allows

you to 
hoose whi
h sta�s to 
on
entrate on). As usual, this division into lines has nothing to do with the typeset view �

widening the window will 
hange the positions of the �line breaks� but have no e�e
t on the �nal typeset s
ore. A
tual line

breaks in the typeset are managed by the LilyPond typesetter and 
an be overruled by 
ommands in the Dire
tives menu.

The se
ond way of getting to see more of the musi
 is simply to zoom the Denemo Display (Ctrl-mouse wheel is best).
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Again this is purely for the input display � you use 
ommands in the S
ore and Dire
tives menu to 
ontrol the size of sta�s,

titles et
. in the �nal typeset s
ore.

Lastly with large (deep) s
ores � or
hestral s
ores for instan
e � you may want to hide sta�s in the display while you work

on others. For example, you may want to hide all but the woodwind se
tion. The 
ommands for this are in the Sta�s menu �

you may want to 
hange the keyboard short
uts for navigating sta�s (Ctrl-up arrow et
) to invoke the sta� moves that skip

over hidden sta�s in this 
ase.

3.1.1 The Page View

The third of the three Denemo display modes that you get with the Es
 key is 
alled the Page View � it is set up initially

with a small zoom fa
tor and several systems showing. In this view the 
ursor highlighting has a large green 
ir
le around the


ursor position and the display will animate during playba
k. As the musi
 starts playing the se
ond system down the page

the top of the page is �turned over� so that, as you rea
h the bottom of the page your eye 
an move up to the top of the page

and follow the musi
 on. On
e the musi
 starts again at the top of the new page the rest of the page is �lled in repla
ing the

old page.

3.1.2 Transition Animation

One of the problems with moving about a s
ore looking at the input musi
 is that it 
an be di�
ult to see qui
kly where

the 
ursor has moved to. An even more tri
ky situation arises when deleting empty measures � often the next measure is

empty too, so it 
an appear that nothing has happened, it seems the 
ommand to delete a measure isn't working. What has

happened is that another empty measure has moved in from the right and the display looks un
hanged.

To avoid these problems these transitions are animated � the measure 
oming in from the right 
an be visually seen to

shunt in from the side; similarly sta�s move up from below and the 
ursor arrives at its new position by shrinking onto it. All

these animation e�e
ts (and the page animation of the previous se
tion) 
an be turned o� via View->Highlight Cursor.

3.2 The Main Menubar

The Main Menubar has menus for overall 
ontrol of the program. It 
ontains the following submenus:

� File

� Navigation

� Edit

� View

� Input

� Playba
k

� More

� Edu
ational

� Help

3.2.1 File

Use the File menu to perform global operations related to storing and retrieving from �le systems, importing from Musi
XML,

MIDI, and LilyPond formats, printing full s
ore or parts, exporting to MIDI, Ogg, Wav, LilyPond (parts or s
ore), PDF and

Png formats. This is also where you open PDF �les 
ontaining sour
e material � e. g. manus
ripts � that you wish to trans
ribe

or proof-reading 
omments you wish to in
orporate in your s
ore. Another sort of sour
e material 
an be loaded from here �

audio �les 
an be loaded for trans
ribing as well as MIDI �les.

The New 
ommand starts a new s
ore, while New Tab 
reates an empty s
ore while leaving the 
urrent s
ore open � a

line of tabs appears at the top of the display for swit
hing between these. Note that you do not have to have multiple s
ores

open to 
opy and paste between s
ores � opening a new s
ore does not alter the 
lipboard.

Open Submenu

The Open 
ommand (Ctrl-o) opens a Denemo �le for editing. Open Template opens one of the templates provided with

Denemo � this is like open ex
ept the �le on
e opened be
omes untitled, for
ing you to give it a name on saving. Open

Example is similar, but here the s
ores are intended as examples of how to do parti
ular things � they 
an also serve as a pla
e

to 
opy and paste from. Open Custom Template opens the dire
tory where templates you have 
reated with Save Template

are stored. If you 
reate a template 
alled Default.denemo then the 
ommand Open Default Template will load it (Ctrl-n).

Add Sta�s and Add Movements take sta�s or movements from the Denemo �le 
hosen and add them to the 
urrent s
ore.

Open inNew does a 
ombination of New Tab and Open.
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Open Proof Read PDF is for adding proof reading annotations into your s
ore, see se
tion 25.

Open Sour
e for Trans
ribing allows you to open the sour
e material you are trans
ribing from so that links 
an be pla
ed

in your s
ore to the relevant pla
e in that do
ument. For more details see the se
tion 22

Open re
ent gives a

ess to a list of re
ently open s
ores (you 
an 
ontrol how many via the preferen
es).

Open Sour
e Audio loads an audio �le 
reating empty measures with the audio displayed as a series of note-onsets in a

line at the top of the display. The note-onsets 
an be dragged to a
hieve syn
hronization and tempo-mat
hing between the

notated bars and the audio. You 
an then add the notes (by ear) and play the two in syn
 to listen for dis
repan
ies. This is

best explained by the video demos (see www.denemo.org).

Open Sour
e MIDI opens a MIDI �le it 
omes with 
omprehensive instru
tions. Note that many MIDI �les are not suitable

for trans
ription � MIDI des
ribes sounds, not notation.

3.2.2 Navigation

This has the 
ommands for moving the 
ursor around the s
ore, bookmarks, and seeking pla
es in the s
ore by 
ontent

(�sear
h�).

Bookmarks

The 
ommands 
over �nding the next/previous bookmark and moving to a bookmark by name.

Cursor

This in
ludes moving the 
ursor by measure, sta�, and within a 
hord. There are moves that skip sta�s that are hidden in

the display and ones that skip over sta�s that are voi
es to move to the next primary sta�.

Seek

This has a 
ommands to sear
h for rhythmi
 patterns, note sequen
es, empty measures, next higher/lower note, empty

measures . . . The sear
h fa
ility in
ludes the equivalent of �sear
h and repla
e�: by re
ording a sequen
e of edits in the

S
heme Window, the sear
hed for items 
an be edited by 
hoosing the Exe
ute S
heme option when found.

MIDI

These are 
ommands to move along the note onsets in an imported MIDI �le (guided MIDI import).

3.2.3 Edit

The Edit menu 
olle
ts 
ommand for editing: mostly editing obje
ts in the display, the Denemo Obje
tsbut also editing

global properties of the s
ore and your preferen
es.

There are 
ommands for deleting the obje
t before the 
ursor, the obje
t at the 
ursor and for partially deleting from the

obje
t at the 
ursor (e. g. deleting notes from 
hords). Other delete 
ommands are in the Obje
t Menu (deleting movements,

sta�s, measures et
).

There are 
ommands for editing all the Denemo Obje
ts of a 
hosen type a
ross the whole of a s
ore. Commands for

managing the sele
tion are also here. Editing using the keyboard to invoke a palette button is here too (usual short
ut is p).

Here, too, you invoke editing the Preferen
es.

The NotationMagi
k submenu is for generating random notes, re�e
ting, reversing, shu�ing notes, swapping passages et


� the sort of things 
omputers 
an do with musi
 easily but humans �nd more di�
ult.

Copy/Cut and Paste

The usual short
uts (Ctrl-
 Ctrl-x Ctrl-v) are set by default operating on the sele
tion . With no sele
tion the Copy


ommand 
opies an attribute atta
hed to the note/
hord at the 
ursor, su
h as an ornament or �ngering. If there is more

than one attribute set you are asked to 
hoose whi
h to 
opy. If there are none, the obje
t at the 
ursor is 
opied. In all 
ases

the 
opied item is highlighted in green so you 
an be sure that your keypress has been �heard�.

Sele
t submenu

Here are 
ommands for sele
tion parts of the musi
 (e.g. for 
ut and paste, or to apply a 
ommand to the sele
tion). Here

sele
ted musi
 
an be spanned by being bra
keted with a pair of Denemo Dire
tives. A spe
ial 
ase of this is 
reating a passage

whi
h 
an then be swapped with the 
orresponding musi
 in the sta� below using a 
ommand in the NotationMagi
k menu.

3.2.4 View

Use the View menu to toggle toolbars and palettes used with the mouse.
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Hide/Show Menus

Three ways of showing the Denemo display area are supported. With/without the menus and as a multiline page (a
tually,

any page 
an be a multi-line page, but usually the third one is 
hosen for this). This 
ommand 
y
les through the three

displays � usually the Es
ape key is the short
ut.

Typeset Musi


Shows the s
ore as engraved by the LilyPond typesetter in the Print View window. Some things su
h as the shape of slurs

and position of marks 
an be edited here graphi
ally.

Playba
k

Shows the s
ore engraved on one (long!) page for playing ba
k. You 
an 
li
k on a note to start playing ba
k at that point,

or drag over a range to play that range, or shift-drag to loop over the range. All the standard playba
k 
ontrols (see below)

also work on this view.

Command Center

Sear
h for 
ommands by entering likely words, set up one key or two key short
uts, load 
ustomized short
uts or 
ommands

. . .

S
ore Layout

Show the s
ore layouts asso
iated with this s
ore. The s
ore layout is the �nal se
tion of the LilyPond syntax that des
ribes

how to layout the sta�s, voi
es, lyri
s, titles et
.

Snippets

Shows a menu bar with snippets � a sele
tion of Denemo Obje
ts used either for pasting or to de�ne a rhythmi
 pattern to

be followed when entering pit
hes. (see se
tion 6)

Tools

The 
onventional i
ons for Open, Print et


Playba
k Controls

When 
he
ked a set of playba
k/re
ord 
ontrols are pla
ed above the display (see se
tion 3.4)

Midi In Controls

When 
he
ked a set of 
ontrols for a 
onne
ted MIDI keyboard are pla
ed above the display (see se
tion 3.5)

S
ore Titles, Controls et


If this is 
he
ked any Titles, indent settings et
 applying to the s
ore and movement 
an be shown as buttons above the

display. (They must be 
reated with their graphi
 �eld set for this, not all 
ommands use that, so nothing may show).

Obje
t Menu

Menus of all the Denemo 
ommands listed under type of obje
t from S
ore down to the types of Denemo Obje
ts (e. g. 
lef


hange obje
ts, notes . . . ).

LilyPond

Pops up a window for 
ustomizing the syntax that Denemo generates for the LilyPond engraver to typeset and viewing any

errors LilyPond reports.

S
heme S
ript

Pops up a window for showing s
ripts written in S
heme. These 
an be exe
uted or saved as new 
ommands. Sequen
es of


ommands 
an be re
orded here.

S
ore

This hides/shows the main Denemo display . This is probably useless for most people, but might help a very old slow ma
hine

playba
k smoothly.
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Cursor Highlighting (O�/On)

The 
ursor �ashes, and in the page view3.1.1 it is 
ir
led. The rate of �ash is set in the Preferen
es. The 
ursor animation is

turned on/o� with this too.

Palettes

Gives a

ess to palettes of buttons that 
an be arranged to make 
ommands available via mouse or keyboard (via the A
tivate

Palette Button 
ommand).(see se
tion 4)

Display Zoom

Zoom the main Denemo display (usually done with 
trl-mouse wheel).

Obje
t Inspe
tor

Opens the Obje
t Inspe
tor10 on the 
urrent obje
t.

3.2.5 Input

Use the Input menu to sele
t external sour
es (Audio from the Mi
 input or MIDI) for inputting notes to Denemo. To use

these you should review the settings in Edit->Change Preferen
es MIDI and audio tabs �rst � 
hange the setting for the

ba
kend from �default� to the spe
i�
 
ontroller you have.

Here too there are 
ommands to 
hange the way the inputs (keyboard, mouse and MIDI) behave.

3.2.6 More

Use the More menu add 
ommands to Denemo. Extra 
ommands are available (those whi
h not everyone will want) via

this menu. More Commands gives 
ommands shipped with Denemo, while My Commands gives ones that you have 
reated

lo
ally. Note that the extra 
ommands 
an also be loaded at the menu where you are looking for them (you right-
li
k on a

menu item, and if there are more 
ommands for that menu the More Commands for this Menu item will show),

3.2.7 Playba
k

Use the Playba
k menu to listen to the 
urrent movement. Denemo lets you hear your s
ore, using an internal synthesizer.

There are 
ommands to play through the all the notes or to observe repeats or to play just the 
hord or notes at the 
ursor

and to play at a shifted pit
h. The default playba
k is qui
k and simple rendering of the musi
 � good for 
he
king pit
h and

rhythm. For more sophisti
ated playba
k open the Playba
k View9 where the playba
k happens on a fully typeset s
ore.

Playba
k uses a pair of marks to de
ide where to start and stop playing. These appear in the display as verti
al green and

red lines down through the notes 
on
erned when the playba
k 
ontrol panel is visible. These markers 
an be moved about by

the arrow buttons on either side of the play button in the Playba
k Controls 3.4 and they are set for you by the Play from

Cursor to End, Play Musi
 at Cursor, Performan
e and other 
ommands in this menu.

3.2.8 Edu
ational

There are games and exer
ises to help learn notation and to improve your re
ognition of intervals. Mostly quite simple, but a

more sophisti
ated example is a 
ommand that loads Handel's �gured bass exer
ises and allows you to try them out, re
ording

your playing and then reporting on any parallel intervals. Tea
hers with an interest in programming 
an 
reate further games

using the S
heme window and save them for use by their pupils.

3.2.9 Help

Use the Help menu to get help using Denemo. A list of the short
uts is available (in
luding any you have set yourself), a

feature-pa
ked s
ore 
an be loaded, the ex
essive help 
an be tamed, and your browser 
an be laun
hed on the Denemo 
hat

room for asking questions dire
tly from other users.

3.3 Toolbar

Use the Toolbar to a

ess 
ommon Denemo 
ommands via a mouse 
li
k. The Toolbar 
ontains the following i
ons:

I
on Des
ription

Creates a new do
ument.

Opens the Open File dialog box.
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I
on Des
ription

Saves the 
urrent �le

Runs LilyPond to 
onvert the 
urrent �le to PDF and sends it to the printer for printing

Jumps to the �rst measure of the movement.

Jumps to the last measure of the movement.

3.4 Playba
k Controls

As with all 
ontrols and menu items you should hover over the buttons with the mouse to get an explanation of what they

do.

The playba
k starts at the playba
k start marker (a line in green down the s
ore in the Denemo Display) and stops at the

playba
k end marker (a red line). These lines are not displayed all the time, just on
e the play has been used at least on
e.

The start/end markers 
an be altered with the arrow keys on either side of the Play and Re
ord buttons. The arrows to the

left adjust the playba
k start, those to the right the playba
k end (hover over the arrows for details).

The Play Sele
tion button plays the sele
tion or, if no sele
tion plays from the Denemo 
ursor position to the end.

The Mute Sta�s button allows you to sele
t groups of sta�s to play, muting others.

Always Full Volume if 
he
ked means that the dynami
s in the pie
e are ignored � good for 
he
king note pit
hes are


orre
t.

Playing of se
tions of the musi
 and looping is possible (in
luding editing as the musi
 loops, so that you 
an listen to

di�erent possibilities) as well as re
ording the audio output (mixed with anything you play on your MIDI keyboard if you

have re
ording set in the MIDI 
ontrols).

The master tempo and volume 
an be set, whi
h will be overridden by tempo and dynami
s pla
ed in the musi
.

Re
ording the audio output is also possible as well as real-time slow down of the audio playing ba
k (not to be 
onfused

with simply setting a slower tempo!). This last is used when trans
ribing from audio (See File->Open->Open Sour
e Audio).

While playing ba
k the note(s) being played are highlighted � the page view mode3.1.1 of the Denemo Display is useful

for letting you follow the musi
 in the input display. You may need to adjust the window size and the division into systems

(drag the horizontal red divider) to get a good e�e
t from this.

Playba
k is not restri
ted to equal temperament � the drop down menu allows you to 
hoose from a variety of histori


temperaments for playba
k.

All these 
ommands 
an be used in 
onjun
tion with the Playba
k View window, whi
h lets you see the playba
k animated

on a properly typeset s
ore. And you 
an also initiate playba
k from the Typeset View by 
li
king on noteheads there.
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3.5 Midi In Controls

These are the 
ontrols for a MIDI keyboard atta
hed to the 
omputer. You should set the MIDI InputDevi
e to your

devi
e in the Preferen
es to be sure all features are working.

The Enharmoni
 Sele
tion 
ontrol lets you determine what a

idental will be used for the MIDI notes � e.g whether to

enter C-sharp or D-�at. The buttons at ea
h end 
hange the enharmoni
 range sharper/�atter.

As you enter musi
 if you enter an augmented or dimished interval a di�erent instrument is used for the playba
k whi
h

helps you avoid pit
h-spelling errors. (See Edit->Change Preferen
es->Audio pit
h spelling 
hannel/program 16.6 to turn

this o�/
hange instrument).

[Appending/Editing℄ button: This shows how MIDI in will be treated. Press Control/Shift/Alt keys to modify or 
li
k

and sele
t Listening to input MIDI, Che
king notes in the s
ore against input MIDI or Appending/Editing at the 
ursor.

[Swit
h to Play Along Playba
k℄ button: When you press Play with this option set, the musi
 will not advan
e past

the 
ursor until you play the note. (Mute the 
urrent sta� to prevent double sounding of notes)

The [re
ord℄ button allows you to re
ord from your MIDI keyboard while the s
ore is playing ba
k. (Press MIDI re
ord

button then start playba
k). On
e the playba
k is stopped anything you have played on the MIDI keyboard has been re
orded

and two buttons Convert and Delete will appear. If you press start playba
k again (without re
ord) the MIDI re
ording will

be played ba
k with the s
ore, on
e you are happy with it then it 
an be 
onverted to notation or if, you want to try again,

deleted.

3.6 Obje
t Menus

The obje
t menu bar gives a set of menus give ordered by the obje
ts (notes, sta�s, measures . . . ) that they relate to. This

division 
annot be perfe
t � some a
tivities 
ould be pla
ed in di�erent menus, so you need to be prepared to sear
h for


ommands using the The Command CenterCommand Center.

Note: Dynami
s, Slurs, Trills, Tempo Indi
ations et
 are in the Notes/Rests menu (if atta
hed to a note or 
hord) or

Dire
tives menu (if standalone obje
ts) . The advantage of atta
hing them to a note is that they 
an be moved around as

a unit, but the standalone obje
ts are generally easier to drag in the Print View should that be needed.

3.6.1 S
ore Menu

The s
ore menu lets you 
ontrol things that apply to all the movements of the 
urrent s
ore. Also here is the Che
k S
ore


ommand whi
h should be your �rst port of 
all if your s
ore will not typeset.

The S
ore Properties 
ommand gives a

ess to some built-in properties that a�e
t the whole pie
e � paper size and display

apperan
e.

The S
ore Properties Editor 
ommand runs the 12S
ore and Movement Properties Editor, open on the S
ore Editor pane.

Titles Submenu

There are two sorts of titles. Book titles have a separate title page with titles for individual movements whi
h 
an be listed

in an automati
ally generated table of 
ontents. Simple titles give a Title and (optionally) movement titles on the same page.

Comments (�Criti
al Comments�) 
an be pla
ed on 
hords/notes/rests in the s
ore and these 
an be automati
ally 
olle
ted

into an appendix using the Book Titles->Epilog submenu.

A Table of Contents 
an be automati
ally generated from the movement titles by setting Book Titles->Table of Contents

Title.

Graphi
 title pages 
an also be 
reated. These 
an be 
reated by invoking the Inks
ape ve
tor graphi
s editor from within

Denemo, or using it externally to 
reate the title page. A sample title page is in
luded both as an en
apsulated post
ript

(EPS) �le and as a s
alable ve
tor graphi
s (SVG) �le. The latter is the form to use for editing the page to suit your needs,

but it should also be saved as an EPS �le as this is the format used to in
lude it in the typeset s
ore.

Typesetter Submenu

Here su
h things as the overall font size to typeset the s
ore, the rules for spa
ing systems and titles, any global transposition,


ontrol of page numbering, margins et
 
an be set.

The beaming rules 
an be set both in general (invoke Set Beaming Rules without a sele
tion) or with ex
eptions (by

invoking with a sele
tion that has been beamed manually using the [ and ℄ 
ommands from the Notes/Rests->Beaming
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menu). Use this latter to break up very short notes, for example, that would otherwise be beamed together while leaving the

longer durations as normal.

3.6.2 Movements Menu

As with the S
ore Menu there may be Denemo Dire
tives atta
hed to the movement � e.g titles to be pla
ed at the head of

the movement will have a Denemo Dire
tive asso
iated with them. Other 
ontrols that 
an be applied on a per-movement

basis in
lude the barline and notehead style, printing of a 
ustos at line ends, the indent before the �rst system (whi
h 
an

also be set on the s
ore-wide basis).

Various s
ore 
he
king routines work at movement level from this menu and a 
ommand to re-bar the movment (or a

sta� or part of a sta�) is also here as �Adjust the Measure Lengths� � this 
an also be used just to 
he
k that the Denemo

�measures� 
orrespond with the a
tual typeset measures (whi
h always follow the durations/time signatures) or to re-bar a

sta� or passage or movement if you have 
hanged your mind or got out of step.

Again there are titles menus for either simple or book titles, and for inserting graphi
s between movements. These 
an be

used as de
orative separators between movements or to insert 
olumns of verses at the end of songs (ea
h song is a separate

�movement�).

The Typesetter submenu for the Movements Menu holds 
ommands that a�e
t the 
urrent movement: per-movement

transposition, inserting blank pages (to avoid page turns), page breaks, 
ustos at the end of lines, note head style to apply to

the whole movement, behavior of sta�s that are resting for an entire system et
. Also here is a 
ommand to allow polymetri


sta�s . When set time signatures 
an di�er between sta�s, and barlines do not have to align a
ross an entire system. Denemo's

display 
opes with showing polymetri
 sta�s on the whole, though you may need to use Measures->Hidden Measure to even

up sta�s in the display and mark measures with Measures->Ignore Measure Duration Error to prevent them being 
olored in

the display.

3.6.3 Sta�/Voi
es Menu

Things su
h as the musi
 
rossing to another sta�, or Ossia sta�s are 
ontained here, along with 
ommands for deleting parts

of the sta�, setting up multi-measure rests for a whole sta�, muting the sta� during playba
k,

The Sta� Properties Submenu

This 
overs su
h things as the type of sta� (e. g. Normal Notation, Tablature, Chord Symbols, Fret Diagrams) as well as the

sta� appearan
e and the playba
k instrument, instrument name or ambitus to be typeset at the start of the sta� and more.

For histori
al reasons, some properties su
h as part-name are �built-in� and have their own dialog to set the values. All


an be a

essed from the Sta� Properties Editor from this menu.

The Add Sta� Submenu

This allows adding sta�s to the 
urrent movement. Piano sta�s 
an be added as well as spe
ialized sorts of sta� for dynami
s,

marks (so that they appear on
e for all layouts), and 
oulés (diagonal lines positioned between thirds in some musi
). The

Add Stru
tured Sta� 
ommand dupli
ates the 
urrent sta� with regard to measures and time signature 
hanges, ready for the

insertion of musi
. Add Sta� for Instrument allows you to add the sta�(s) needed for various instruments (e. g. organ) with

the ranges of a

eptable notes for the instrument set on the sta�(s).

Sta�s with �mirrored� musi
 
an also be added. In this 
ase the sta� does not have musi
 of its own, instead the musi


mirrors that in another sta�. By setting the part-name on su
h a sta� a greater variety of parts 
an be printed from one

s
ore without needing to 
reate a 
ustom layout for them. For example, two �ute parts 
an be printed separately and as a


ombined (�divisi�) part, using the same musi
. Any marks et
 that need to be handled di�erently 
an be made 
onditional

on the part name.

The Voi
es Submenu

Voi
es in Denemo are like sta�s but are typeset on the pre
eding sta� to a
hieve single-sta� polyphony. The Denemo Display

is normally set to display any extra voi
es on a separate sta� so as to make it easy to work with � the voi
es have their


lef displayed in yellow and do not show a key signature as these are supplied by the main sta� (or �primary voi
e�). Voi
es

will also normally be assigned to voi
e numbers 1,2,3,4 using the Initial Voi
e 
ommands in this menu (this 
ontrols the

stemming, slur positions et
). Voi
es 
an 
hange their voi
e number during the musi
 � the 
ommands for this are in the

Dire
tives->Typesetter->Voi
es menu as they insert stem 
hange obje
ts in between the notes.

As with sta�s, voi
es 
an be 
reated with no musi
 of their own, simply mirroring musi
 from another sta�.

The Playba
k Submenu

In this menu you 
an mute the sta�, apply 
ustom durations to notes and arrange that gra
e notes are given a 
ustom duration

rather than having a zero duration whi
h they have by default. Use this menu to give the Denemo playba
k a jazz swing

e�e
t or to playba
k with inégalité. These 
ustom durations do not a�e
t the typesetting nor the Playba
k View9 (whi
h uses

MIDI generated by LilyPond).
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The Display E�e
ts Submenu

Here you 
an 
hoose to hide sta�s from the display so that you 
an see distantly pla
ed sta�s side by side (e. g. in large

or
hestral s
ores). The lo
ation of su
h �hidden� sta�s is indi
ated by a 
olored line between the sta�s above and below. The

sta�s remain hidden until you move the 
ursor on to them. If you are using this and navigating with the keyboard you may

want to reset the key short
uts for sta� navigation 
ommands to use variants that skip over the hidden sta�s. Some sta�s

(e.g Cli
k Tra
k are hidden by default as you do not normally edit them.

You 
an also give more/less room in the display to the sta�s via this menu.

The Sta� Groupings (Bra
es) Submenu

The bra
es at the start of ea
h system are 
ontrolled from here. The order that you add the bra
es determines whi
h are

outside whi
h. The bra
es are displayed to the left of the sta� and 
an be edited/
he
ked there with the mouse.

3.6.4 Clefs Menu

All sorts of 
lefs 
an be sele
ted � the Set Initial and Clef Change 
ommands give a

ess to standard 
lefs. The Clef Chooser


ommand lets you set more exoti
 
lefs su
h as Drum 
lef and even things like the Gregorian 
hant C 
lef using the LilyPond

syntax (e. g. vati
ana-do3).

Typeset-only and Display-only 
lefs enable you to work with a voi
e whi
h is being typeset on a di�erent sta�, while

keeping the musi
 in the sta� you wish to see it in or for entering musi
 in a familiar sta� whi
h is to be typeset in an

unfamiliar one.

3.6.5 Keys Menu

Setting the initial key or a key signature 
hange or to sharpen or �atten the key signature at the 
ursor. You 
an also 
li
k

on the key signature itself to sharpen/�atten. The key signature 
an be hidden when typeset.

3.6.6 Time Signatures Menus Menu

Besides basi
 time signatures various variants (numeri
, single digit . . . ) are here. There is also beaming 
ontrol applying

just to the 
urrent passage (for beaming rules for the whole s
ore see the S
ore->Typesetter menu or for the whole movement

Movement->Typesetter menu).

Cadenza Time allows un-metered musi
 to by typeset 
onveniently. While in Cadenza Time no barlines ex
ept ones you

expli
itly pla
e are typeset, and no beaming is done ex
ept where you expli
itly set beaming indi
ations. You 
an use as many

Denemo �bars� as you �nd 
onvenient � they will not 
ause barlines to be typeset. Other parts have to be given Cadenza

Time too, and �lled with non-printing rests to mat
h the duration of the musi
 being typeset.

3.6.7 Measures Menu Menu

Besides 
ommands to insert/delete/navigate/merge/split measures (in one or all sta�s) this menu in
ludes 
ommands to set

an upbeat (ana
rusis, pi
kup) measure at the start, or a short measure (e. g. during partial �rst & se
ond time bars). First

and se
ond time bars markers themselves are to be found in the Dire
tives->Markings->Spanning menu .

The whole measure repeat sign is here and some 
ommands to 
he
k the measure for errors or to widen or narrow the

measure in the display.

3.6.8 Chords Menu

Here are 
ommands to add notes to a 
hord either at the 
ursor, by note name or at an interval above the bass. Whole 
hords


an have their enharmoni
 spelling 
hanged up or down.

3.6.9 Notes/Rests Menu

This 
overs inserting, deleting and modifying notes in pit
h, duration and appearan
e and all sorts of things that are atta
hed

to note obje
ts su
h as slurs, phrasing slurs, ties, beaming 
ontrols, ornaments (trill, turn, . . . ), gra
e notes, arti
ulations

(sta

ato, tenuto . . . ), �ngerings, textual markings, 
res
. and dim. (both hairpins and extended 
res
. � po
o � a

� po
o style) 
hord symbols (�fake 
hords�), �gured bass. Dynami
 markings su
h as f and p are separate obje
ts (see

Dire
tives->Markings->Dynami
s).

Also here is the tuplet menu, for groups of notes that have a duration that is a fra
tion of the written duration, su
h as

triplets. These a
tually insert tuplet start and end obje
ts, before and after the notes 
on
erned so, stri
tly speaking they

should 
ome in a separate mis
ellaneous obje
ts 
ategory. As usual, the most useful 
ommands have short
uts already � Tab

starts/stops a triplet alternately (so you 
an press it on
e, enter the notes and press it again to �nish the triplet). And the

two key short
ut Keypad 7, Keypad 7 turns the note entered into a triplet of notes (with Control as well they are slurred).

This is set as a two-key short
ut so that you 
an type it in as a triplet rhythm: e. g. the three keypresses 4, KP_7, KP_7

will give a triplet of three 1/16th notes.
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The Append/Edit Note Submenu

So 
alled be
ause in appending position the note names a, b, 
 . . . append a note while when the 
ursor is on an note it edits

the note to have the note-name indi
ated. The other note edit 
ommands here are shifting up and down an o
tave, sharpening

or �attening. Cautionary and reminder a

identals are here too � to set the style of a

identals (e. g. if they are repeated in

various 
ir
umstan
es) see the S
ore->Typesetter menu.

The Note Insertion Submenu

This menu has 
ommands for inserting notes at (i. e. before the obje
t at) the 
ursor position. The double key press A, A

inserts the note A in the prevailing duration (more 
ommonly people press a duration key 0, 1, . . . followed by a note name).

If you enter a note and then sharpen you will hear both note and sharpened note � to avoid this use the �Sharpen Next

Note� 
ommand (likewise for �atten, use twi
e for double-sharp,�at) the default key presses are '=' and '-' for these.

The Append/Insert Duration Submenu

So 
alled be
ause the 
ommands 0, 1, 2 . . . append a note when the 
ursor is in the appending position or enter a note if the


ursor is on an obje
t. If you have a MIDI keyboard (and it is designated in the preferen
es under the MIDI tab) then the

note will be purely rhythmi
 (yellow/brown) playing a pit
h will turn it into a real note. Here is the 
ommand for entering a

snippet (whi
h 
an be a 
omplete rhythmi
 pattern) as well as Breve and Longa for early musi
.

There are also a set of 
omands for appending notes whi
h will be slurred from previous notes (Control-0, et
) whi
h

means that you 
an enter slurs as you enter the rhythm of a bar without extra key presses (whi
h would otherwise break the

rhythm of your entry).

The Edit Duration Submenu

Here are the 
ommands for 
hanging the duration of the note/rest/
hord at the 
ursor as well as doubling or dividing the

note at the 
ursor.

Besides 
ommands for dotting notes there are 
ommands for turning the note at the 
ursor into a dotted rhythm of two

notes and for entering a dotted rhythm with two key presses (so as to keep in rhythm � e. g. 3, KP_9 gives dotted 1/8 note,

1/16th note, and the 
orresponding slurred one with Control).

The Rest Insertion Submenu

Besides inserting rests (Alt-0 et
) you 
an insert non-printing rests (where voi
es are silent) and move rests out of the way in

polyphoni
 situations where LilyPond doesn't do what you want. Whole measure rests and multi-measure rests are here too

with 
ontrol over their numbering.

The Sele
t Duration Submenu

The 
ommands to expli
itly set the prevailing duration are here (though usually this is set by inserting a duration) and, more

importantly the 
ommand to sele
t a snippet as the prevailing duration (Shift+ Spa
e) after whi
h entered notes follow the

pattern of the snippet.

3.6.10 Dire
tives Menu

This 
overs all the things that aren't notes but sit in between them � standalone Denemo Dire
tives. The most useful for

regular musi
 notation are barlines, dynami
 markings, tempo marks, rehearsal marks et
 in the Markings submenu. There

is an enormous 
olle
tion of stu� here though.

All obje
ts, in
luding Denemo Dire
tives 
an be inspe
ted and edited via the Obje
t Editor

One general feature is the Conditional Dire
tives whi
h 
an be used to restri
t a dire
tive to a parti
ular type of s
ore

layout (e. g. only to be used when printing a part, or a full s
ore). This 
an be used, for example, to prevent a 
ue being

printed on the full s
ore (as it is only relevant when printing the part).

Note there is a further 
lass of Denemo Dire
tives, the ones atta
hed to notes/
hords/sta�s/movements/s
ores � these

dire
t the typesetter to do spe
ial things su
h as atta
h �ngerings, ornaments et
. Denemo Dire
tives are des
ribed in a

separate se
tion31.

3.6.11 Lyri
s Menu

See se
tion 19 for a des
ription of how lyri
s are handled in Denemo. The lyri
s menu in
ludes the following 
ommands:

Add Lyri
 Verse Appends a verse to the verses atta
hed to the 
urrent sta�.

Insert a Highlighted Lyri
 inserts a bold and/or itali
 word into the lyri
s at the 
urrent lyri
 
ursor position.
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Skip Syllables in Sele
tion Inserts spe
ial syntax to skip the number of notes you 
urrently have sele
ted in the

Denemo Display.

This is useful if you have a musi
al introdu
tion or interlude in a song.

Insert Stanza Number Asks you for some text (usually the number of the verse) and inserts the spe
ial syntax to

typeset this before the next syllable, leaving the syllable position undisturbed. Normally the lyri
 
ursor should be at the

stanza/verse start.

Syllable Alignment Inserts spe
ial syntax to 
ause the text to be aligned with its start or end below the note (rather

than the default 
entered position). This may be useful for 
hanted text.

Melismata

� During Word, with Slur � The typeset s
ore will print hyphen(s), if needed, showing 
ontinuation to the end of the slur

� Word End, with Slur � The typeset s
ore will print a lyri
 extender to the end of the slur (a 
ontinuous unders
ore).

� During Word, no Slur � The typeset s
ore will print the syllable extending under two notes inserting hyphen(s), if

needed, showing 
ontinuation

� Word End, no Slur � The typeset s
ore will print the syllable extending under two notes inserting a lyri
 extender as

needed

� Extend Melisma � The typeset s
ore will extend the melisma over a further note.

Divide Syllables with Hyphen Inserts syntax to typeset hyphen(s) if needed between syllables that underlay su

essive

notes.

Insert Mirrored Verse permits a mirrored 
opy of a verse from another stave to be in
luded on the 
urrrent sta�, for

example when the words for two parts are the same but on separate sta�s. Then if the words need editing, just the �rst 
opy

needs to be 
hanged.

Lyri
 Tie Inserts the syntax to separate two words whi
h should be typeset under one note.

Dynami
 Inserts a dynami
 marking (�, f, p, or pp) dire
tly in the lyri
s. You 
an edit the insert for other dynami
s.

Typeset Verses at End This takes several verses and uses the Movement->Titles->Text after Movement 
ommand to

typeset them at the end of the movement arranging them in 
olumns.You are given a 
hoi
e as to whi
h verse to start from.

Normally you would then delete these verses from the sta� so they are not repeated. Issuing the 
ommand a se
ond time

allows you to delete, repla
e or edit the end-of-movement text.

Change Font Inserts a 
hange the font for the lyri
s from the 
urrent lyri
 
ursor position. Short forms su
h as Sans,

Times 
an be used.

Larger/Smaller Font Size Inserts a 
hange in the font size for the lyri
s from the 
urrent lyri
 
ursor position onwards.

Typeset On/O� Turns typesetting of lyri
s o� or on (this does not a�e
t end-of-movement text).

3.6.12 Notation Magi
k Menu

This has been moved to the Edit Menu.

4 Palettes

Palettes are 
olle
tions of 
ommands arranged as a 
olumn, row or grid of buttons either in a separate window or do
ked in

the Main Window.

The buttons are not just for mouse users � palette buttons 
an be exe
uted by typing p followed by (part of) the label of

the button followed by the Enter or Return key. The entry for keying in a palette label looks like this:
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At the top is the name of the palette that is a
tive, in this 
ase the �General� palette. You 
an swit
h to a di�erent palette

with TAB � the palette does not have to be displayed on the s
reen, but if you type a label that does not exist it will be

shown to remind you.

To make full use of the keyboard for exe
uting 
ommands from your palettes you should edit the labels so that they are

easy to type & memorable. Put the shorter ones �rst as you do not need to type all of the label, just enough to sele
t the

needed button. Right-
li
king on a palette button allows you to edit the button, 
hanging the label or tooltip, dupli
ating

the button (e. g. to 
reate an edited version of its s
ript) and more, as in the following popup:

You 
an also edit the palette itself by right 
li
king on any button and 
hoosing the Edit this Palette submenu (shown open

above). You 
an make the palette �ll up horizontally or verti
ally and restri
t the number of 
olumns/rows respe
tively. You


an do
k/undo
k palettes as well and hide palettes that are not needed (you 
an also hide undo
ked palettes by dismissing

their window).

In the View menu you 
an sele
t a palettes of 
ommands to display or show all the palettes and then hide the ones you

don't want.

You should make palettes your best friend � when you �nd a 
ommand in the menu system that you need right 
li
k on

it and 
hoose Add to Palette. This way you will build up one or more 
olle
tions of 
ommands that you need.

Palette buttons 
an also be 
reated dire
tly from obje
ts or Denemo Dire
tives so that you 
an dupli
ate them in your

s
ore without having to 
opy and paste. So, for example if you run Help->Open Feature Pa
ked S
ore and �nd the type of

obje
t or attribute you need there then you 
an run the Obje
t Inspe
tor or one of the editors on it and 
reate a palette

button for installing the same thing in your own s
ore. See the se
tions 1011 1213for more details.

Changes you make to palettes are automati
ally saved when you end the session. (They are stored in a �le 
alled

palettes.xml, whi
h 
an be edited dire
tly by the more te
hie-minded).

4.1 Arti
ulations Palette
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These buttons turn on/o� the arti
ulation. These will apply to the entire sele
tion if you have one and you have the

preferen
e16.2 for that set. Outside slur moves the arti
ulation outside an en
losing slur.

4.2 Barlines Palette

These insert barlines � note only one barline 
an be at one moment in the musi
. The Custom button 
reates a new barline

type, spe
ifying the appearan
e in mid system, end of system, start of system and between sta�s.

4.3 Beaming Palette

The ? button gives the overview for this palette. Rules 
an be set via a dialog with ex
eptions derived from the sele
tion.

4.4 Chord Symbols Palette

The ? button gives the overview for this palette.

4.5 Insert or Append Chords Palette

This palette inserts a 
hord of the given type using the prevailing duration with the root note for the 
hord given by

the 
ursor height and any pending a

idental . The 
hord is inserted and labelled in the Denemo Display with its root and


hord symbol (aka fake
hords). This is typi
ally used on a Chord Symbols sta� (see Sta� Properties menu). You 
an 
reate

additional 
hord types for this palette using the 
ommand View->Palettes->Create Button for Chord Type.

4.6 Custom Ornaments Palette
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Custom ornaments 
an be 
reated as en
apsulated posts
ript �les using the same methods as graphi
 title pages. If you

have a ve
tor graphi
s editor (e. g. inks
ape) installed and in your Preferen
es (Externals tab, Graphi
s Editor) then you 
an

edit from within Denemo. As usual hover over the buttons for instru
tions.

4.7 Dynami
s Palette

The 
res
 - - - and dim - - - buttons start or 
ontinue textual 
res
endi/diminuendi � texts su
h as po
o a po
o 
an be

inserted and the - - - 
an �nish on a dynami
 marking or an end 
res
/dim marker.

4.8 Figured Bass Palette

4.9 MIDI Import Palette

This palette is for guided MIDI import. The instru
tions are in the tooltips.

4.10 Ornaments Palette

Note that there is a separate 
ustom ornaments palette.

4.11 Piano/Organ Notation Palette
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4.12 Polyphony Palette

These are the 
ommands to 
ontrol separate voi
es that appear on a single sta�. The voi
es are best displayed on separate

sta�s in the Denemo display to ease the editing.

4.13 Repeats Palette

The Nth time repeat 
an be used to hold any needed text. If an repeat alternative is less than a bar the Short Measure


ommand 
an be used, and the bar number adjusted if needed.

4.14 Stringed Instruments Palette

Here are 
ommands for �ngerings, string numbers et
. These are atta
hed to individual notes (pla
e the 
ursor on the

note).
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4.15 Tied Notes/Chords Palette

Commands to insert ties on 
hords and individual notes, and to 
ontrol their shape and dire
tion are here.

5 The Command Center

In the View menu you 
an show the Command Center. This has a list of all the Denemo 
ommands, hidden or not, with

their short
ut(s). The box at the top left gives full details of the 
urrently sele
ted 
ommand and its lo
ation in the menu

system. Below that is a sear
h box for �nding any 
ommand you need by mat
hing words in its des
ription or label. By


hoosing �Fuzzy� you will make the sear
h less stri
t � one word 
ould be missing.

The sear
h starts on
e you have typed the fourth letter of any key words you want, so 
he
k after ea
h letter to see if you

have found the 
ommand you need. To sear
h for further 
ommands mat
hing your keywords press Spa
e or Tab or Return

or 
li
k the arrow next to the sear
h box.

The 
ommand 
enter is also where you 
an set one-key short
uts su
h as Ctrl-x and two-key short
uts su
h as Shift-a

followed by Shift-a (whi
h is written as A,A next to the 
ommand). You 
an also look up whi
h 
ommand responds to a

given short
ut, and exe
ute the sele
ted 
ommand here.

In addition you 
an save and load whole sets of short
uts and 
ommands. If you have upgraded your version of Denemo
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and you have ele
ted to keep your 
ustomized 
ommands et
 then you should run the Load a Standard Command Set 
hoosing

Default.
ommands, as some 
ommands may have moved in the menu system. If there are new palettes in an upgraded version

of Denemo then you 
an get them merged in with your own palettes by 
li
king �Load the Standard Palette Set� � this does

not overwrite any palette buttons you may have, so delete any 
ustomised buttons (after dupli
ating, if desired) that you wish

to fet
h from the Denemo distribution.

6 Musi
 Snippets

6.1 Overview

Musi
 snippets are short sele
tions from a voi
e whi
h 
an be stored on the Snippet tool bar. They have two main uses: they


an a
t as a repository of �motifs� whi
h 
an be inserted (Ctrl-Spa
e) at the 
ursor, and they 
an be used as an extension to

the �prevailing duration� idea. In the se
ond use, by sele
ting a snippet as you enter pit
hes the durations are assigned from

the next step in the snippet. The �rst 
ase is espe
ially useful when entering a 
omplex rhythm whi
h is repeated many times

in the pie
e. In all 
ases the snippet 
an 
ontain all sorts of attributes and markings, slurs, beaming indi
ations, ornaments

et
, and these will then all be entered with a single keypress or as you add pit
hes.

6.2 Details

The Snippet tool bar has only one button initially: �Create�. This button lets you 
reate a snippet from the 
urrent sele
tion.

The sele
tion should be a 
ontiguous sele
tion of obje
ts in a single voi
e. On
e 
reated the snippet appears on the snippet

tool bar as a button � the label is generated to indi
ate the 
ontent, and this label 
an be further edited by 
li
king on the

button and 
hoosing �Edit Label�. Other options on 
li
king a snippet button are to insert the snippet, to sele
t the snippet

(in whi
h 
ase as you enter pit
hes they follow the rhythm of the snippet, in
luding any slurs, trills, or arti
ulations that are

in the snippet) et
.

Ctrl-Spa
e inserts the sele
ted snippet or (if none is sele
ted) inserts the snippet that you spe
ify by number. Shift-Spa
e

sele
ts the next snippet (or �rst if none sele
ted), to unsele
t a snippet 
hoose a duration (0, 1 . . . ) to be used instead for

entering pit
hes.

In the insertion 
ase, you may have two or three snippets that apply to a given s
ore � spe
ial bits of text that appear

over notes for example � and you 
an insert them using Ctrl-Spa
e, 1 (or 2 or 3 . . . ) as needed.

In the pattern-following 
ase you will be sele
ting snippets using Shift-Spa
e and then playing in notes (and ba
king up

using ba
kspa
e in 
ase of error � the pattern ba
ks up for you).
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7 The Print View Window

The print view window is shown by 
he
king View->Print View. This view shows the typeset s
ore as it will be printed

on paper. It also allows you to lo
ate the pla
e in the Denemo Display belonging to a parti
ular note or mark in the s
ore,

start playing the musi
 at any note and allows some graphi
al editing of the s
ore.

7.1 The Buttons

� Print starts your system's print dialog to send the typeset s
ore to a printer or �le. Windows print dialog has been

reported to 
rash, if so use the PDF option.

� PDF to generate a PDF do
ument from the s
ore.

� Typeset. O�ers a menu of s
ore layouts to typeset. If only one is available (the Default S
ore Layout) then it typesets

that one.

� Movement. Creates a S
ore Layout 
omprising the 
urrent movement, and then typesets it .

� Part. Creates a S
ore Layout from the 
urrent Part and typesets that. A part 
omprises all the sta�s with the part

name of the 
urrent sta�. (The part name of a sta� is shown above the initial 
lef with a green pat
h on it).

� Refresh. Repeats that last typeset 
ommand. For example, if Part was the last then it typesets the 
urrent part (whi
h

may be di�erent from the one last typeset if the 
ursor is in a di�erent part).

� Omission Criteria. This button is labelled either �No Omission Criterion Set� or with the name of an Omission Criterion.

With it you 
an 
reate an omission 
riterion and set it to 
ontrol the typesetting of the s
ore - see Omission Criteria14.
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� Continuous/Manual. This both indi
ates the 
urrent mode of typesetting and a
ts as a menu for altering it and 
hoosing

how mu
h to typeset in 
ontinuous mode. In 
ontinuous mode the s
ore is re-typeset every time it is altered � 
hoose

the range if the s
ore is large so that it refreshes qui
kly. For entering musi
 rapidly set this to Manual, and re-typeset

on demand.

� Range opens the range dialog. You 
an set the range by sele
ting �All Movements�, �Current Movement� or �Cursor

Context�. In this last one you 
an sele
t the number of bars before and after the 
ursor and the number of sta�s

above and below the 
ursor to typeset. Note that if you sele
t too small a range the typesetting may be di�erent,

as the small amount of musi
 will be spa
ed di�erently to appear well typeset.

� Duplex. Changes the view to show how two-sided printing will work out for page turns.

� Next, Previous. Navigate to the next/previous page of the s
ore. You 
an s
roll or drag as well.

7.2 Mouse Controls

The mouse s
roll wheel enables verti
al panning and with Shift horizontal panning. With Control pressed you 
an zoom the

view, whi
h is very important for re-shaping slurs. Right 
li
k for help with tweaking beam angles, slurs et
.

Shift-Cli
king on a notehead or marking sele
ts the obje
t (blue box appears) and positions the Denemo 
ursor at that

point so that you 
an start editing. Cli
king without shift starts playing at that point � 
li
k again to stop the play.

Right 
li
king in a blank area of the typeset view (normal 
ursor) gives a menu providing help and allowing you to typeset

with the 
ontrol points for 
urves and the lo
ation points of obje
ts marked as red dots and 
rosses. Be sure to turn o� these

red dots and 
rosses before printing or 
reating a 
ustomized s
ore layout, as they are embedded in the s
ore and will print.

7.3 Editing in the Print View � WYSIWYG

On
e you have �nished entering musi
 into Denemo you may �nd that you have a wrong note or two or a missed marking or

slur when looking over the �nished s
ore in the Print View. It is 
onvenient to shift-
li
k (or 
li
k twi
e) on the notehead,

marking et
. to position the Denemo Cursor on the obje
t. For this to work look for the �hand� pointer as you move the

mouse over the typeset s
ore. The hand pointer indi
ates a pla
e where if you 
li
k the Denemo Cursor will move to the

Denemo Obje
t that belongs to that feature.

On
e you have lo
ated the note you wish to edit you 
an press the keyboard short
ut (or play the MIDI key or any other

editing method) to 
hange the note � to add a sta

ato marking for example. The Print View will not instantly update, but

you 
an 
ontinue editing while it does so. If the Print View is not up-to-date the shift-
li
k may not lo
ate the 
orre
t note

as your edit may have displa
ed things; to minimize this it is best to 
orre
t faults on a page from the bottom upwards. You

are given a warning noise when the print view is not up to date, and a big warning noise if the lo
ating has 
ompletely failed.

The navigation using shift-
li
k in the Print View works for noteheads, slurs, ties and various marks � some other things

su
h as lyri
s 
an't be used to navigate � 
hoose the note that the lyri
s underlie to �nd the right pla
e in the Denemo Display.

You 
an a
tually edit your input musi
 using the mouse on the Print View window � something referred to as what-you-

see-is-what-you-get (WYSIWYG), whi
h is how the 
onventional musi
 editors work all the time. But in doing this it will

help if you keep in mind that the Denemo program does not know anything about what LilyPond has a
tually drawn in the

Print View window � Denemo is just displaying the PDF �le that LilyPond has 
reated. The PDF �le does 
ontain links �

the �hand� pointer � so it does �know� about where things are in the Denemo Display, but not the other way round. This

means that to use wysiwyg features you have to tell Denemo more about what you are doing than you would expe
t.

7.3.1 Editing Positions and Padding

Right 
li
king on some obje
ts in this pane allows you to edit them.Use this for the o

asions when LilyPond has positioned

things badly.

The editing pro
edures depend on whether the obje
t is atta
hed to a note or appears between the notes in the Denemo

Display. Depending on the obje
t you 
an drag it to a better position or 
hange whether it appears above or below the note

its atta
hed to.

You 
an also sele
t an amount of padding to apply to some obje
ts so that they keep their distan
e from other items in

the s
ore. Adjusting the padding is generally a better way of indi
ating that something is too 
lose to something else, sin
e

other obje
ts will move away from it as needed and if you later edit the s
ore it will behave more intelligently.

7.3.2 Re-shaping Slurs and Ties

Slurs, ties and beaming 
an also be altered here. When you right-
li
k on a slur or tie the Denemo Cursor moves to the

note where the slur starts and you are o�ered the 
han
e to edit the shape of the 
urve. Choose a large zoom fa
tor before

you begin, and turn on the 
ontrol points (red dots and 
rosses) as des
ribed Mouse Controlsabove. Then right 
li
k on the


urve and 
hoose Edit Shape. You have to 
li
k on the referen
e point �rst � this is on the 
enter-line of the sta� at the

horizontal position of the notehead where the 
urve starts � this is marked with a red dot. Then you 
li
k and drag on the

four �
ontrol-points� that de�ne the shape of the 
urve. On
e the shape looks good, right 
li
k in a blank area and 
li
k Apply.

With pra
ti
e you 
an skip the use of the red dots and 
rosses as you 
an guess where they would be.
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7.3.3 Adding Line or Page Breaks.

Page or line breaks added by right-
li
king on a note at a barline and 
hoosing from the menu. This works be
ause right-
li
k

positions the Denemo Cursor at the note and then the page or line break 
ommand is run just as if you were working dire
tly

in the Denemo Display.

8 The LilyPond View

In this view the musi
 is shown in the form it is sent to the LilyPond musi
 typesetter. The LilyPond typesetter uses a syntax

that 
an be read and written by human hand (the word 
� represents the note middle C for example) so this editor allows

editing and navigating the musi
.

The lines are all numbered, and the bars always start a new line, with every �fth bar numbered with a 
omment �%n�.

Dire
tly editable text appears in bold, and additional syntax 
an be inserted by right-
li
king with the mouse. (Equivalent

to 
hoosing the �Insert LilyPond� menu item).

The �rst se
tions are de�nitions of the musi
 for ea
h sta�/voi
e.

The last se
tion is the s
ore layout whi
h 
an be a 
ustom one or a default layout (or if 
ontinuous typesetting is on, a

temporary one). If you want to edit the s
ore layout dire
tly as text then you 
an 
li
k on the S
ore Layout button here and


onvert it to a 
ustom layout.

There is also a pane that shows any error messages that LilyPond may issue when typesetting your s
ore. When an error

o

urs the remainder of the text is marked in red. Using the arrow keys to move around this text, the Denemo 
ursor in the

Denemo Display will follow, using the little gray an
hors that appear before ea
h note, rest, 
hord or other musi
 obje
t.

9 The Playba
k View

9.1 Introdu
tion

This is a fully typeset view with (more) full-featured MIDI playba
k. The musi
 is typeset on one long page against a yellow

ba
kground and s
rolls up as it plays. As a bonus, a single part 
an be typeset in this view with the whole a

ompaniment

in
luded in the playba
k � you 
an play from the part while hearing the other instruments.

To start play from a note just 
li
k on the notehead, 
li
k again to stop playba
k. To play a short passage 
li
k on a

notehead and drag to where you want the playba
k to end. To loop-play hold the shift key down as you drag from the start

to the end of the passage to be looped over. To position the Denemo 
ursor at a note or rest shift-
li
k a the notehead.
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The Play/Stop button plays the whole pie
e with repeats, (that is the same as the Performan
e 
ommand in the playba
k

menu); if a performan
e is underway it stops it.

The All Parts button typesets the 
urrent movement for playba
k, generating the MIDI at the same time. The Current

Part button does the same but just for the part that holds the Denemo 
ursor in the Denemo Display � you are asked if you

want to keep the MIDI already generated � say yes if you wish to hear the other parts while following just the 
urrent part

as it plays ba
k.

Set S
rolling pops up a dialog to 
ontrol simple automati
 s
rolling. Clear S
roll Points 
lears the list of s
roll points if

present (see below).

9.2 MIDI Playba
k.

In the Playba
k View the MIDI is generated by LilyPond and has many more features than the simple MIDI generated by

Denemo. This playba
k 
an still be 
ontrolled by the same 
ommands in the Playba
k menu or the Playba
k Controls Panel

and left-
li
king on a notehead in the Print View, but in addition you 
an start play from any point in the musi
 just by

left-
li
king on a note in the Playba
k View. Furthermore, in the Playba
k View, to play a se
tion of the musi
 
li
k and drag

to the end note desired. For a looping play hold the shift key while dragging.

If you alter the musi
 then you need to re-typeset this view before you 
an play with Playba
k View.

9.3 S
rolling

You 
an either 
he
k the Set S
rolling 
he
k box to automati
ally s
roll as you listen, or you 
an set s
roll points to determine

exa
tly where the page will be when the point 
li
ked is playing.

9.3.1 Simple S
rolling Control

For simple s
rolling 
li
k the Simple S
rolling 
he
k box. The musi
 will start to s
roll after a while and 
ontinue at a steady

rate. If it has s
rolled too far you 
an s
roll it ba
k a bit while playing, it will 
arry on at the rate from where you leave it.

9.3.2 S
roll Points

For more sophisti
ated 
ontrol you 
an set s
roll points on the movement. This is what right 
li
king does in the Playba
k

view � when you right 
li
k on a note head or rest Denemo will ensure that the page has s
rolled while playing so that notehead

has arrived at where it was when you 
li
ked. With the musi
 in the right pla
e on the page for it to start, right 
li
k on the

�rst note of the se
ond system (so that the s
rolling does not start until after you have heard the �rst system play) and then

s
roll the page up (using the mouse s
roll wheel or the s
roll bars) and 
li
k on the �rst note of the last system on
e the page

is in the position desired for end-of-play. You hear a sound e�e
t when the s
roll point has been added to the list of s
roll

points for this movement and the pla
e is marked with a green blob.

If there are tempo 
hanges, s
roll the page to the desired position prior to the tempo 
hange and 
li
k on the last note/rest

before the tempo 
hange. (Instead of 
li
king you 
an drag notes to the position you wish them to be in instead � it's the

same thing). If you add a s
roll point wrongly, just 
li
k it again to remove it.

You may also need to set intermediate s
roll points if the musi
 has passages with a �urry of notes � just position the

musi
 for su
h passages and right 
li
k as with tempo 
hanges.

Note that if you set s
roll points on a movement these are remembered when you swit
h movements, and s
roll points

are saved with your s
ore. This means that on
e you have set up your s
ore for pra
ti
ing playing your part, Denemo will

remember how you like it to s
roll. Note also that you 
an do minor edits without unduly perturbing the s
rolling that you

set.

Use the Clear S
roll Points button to delete all the s
roll points that you have set if you wish to start over or right 
li
k

on an individual s
roll point to remove it.

Note: When not playing from the beginning of a pie
e the instruments will only be 
orre
t if the MIDI 
hannel assigned to

ea
h sta� has been left at the default value (
hannel 1 for sta� 1 et
 with 
hannel 10 skipped). If you have deleted/swapped

sta�s you may need to reset the MIDI 
hannel values.

Note: Tempo 
hanges must have a metronome mark to take e�e
t in the Playba
k View. Repeat them in the part if you

are just typesetting the part.

Note: That text is 
urrently generated with the wrong fonts in the Playba
k View (thought to be a LilyPond bug).

Note: LilyPond Version 2.19.x is needed for some MIDI features (e. g. sta

ato). Use the Preferen
es dialog, Externals tab

to 
hange whi
h version of LilyPond Denemo uses.

Note: When using the Playba
k View on a s
ore with several movements you must �rst typeset the movement in the Print

View before invoking the Playba
k View.
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10 The Obje
t Inspe
tor

The Obje
t Inspe
tor is shown by 
li
king View->Obje
t Inspe
tor, or just double-
li
king on an obje
t in the Denemo

Display. It gives 
omprehensive information about the obje
t at the 
ursor. This in
ludes dire
tives like ornaments, dynami


markings, �ngerings that may be atta
hed to the obje
t. For obje
ts like notes and rests whi
h start at a parti
ular musi
al

moment it also des
ribes at what moment in the measure the note begins and what its duration is.

The Obje
t Inspe
tor is sensitive to whi
h note of a 
hord the 
ursor is on, so that things like �ngerings (whi
h 
an vary

from note to note within a 
hord) are displayed individually as you move the 
ursor up and down a 
hord. You 
an step

through the notes of a 
hord using the button marked �Inspe
t the next note in 
hord� whi
h will work upwards through the

distin
t notes before wrapping round to start at the lowest note. Where a 
hord has two notes with the same note-name the
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button labelled �Alternate note at 
ursor� 
an be used to inspe
t the other one.

For many dire
tives full information about whi
h 
ommand 
reated the dire
tive and where it is to be found in the menu

system is given, and the des
ription of the 
ommand's behavior.

Some older 
ommands don't have full information but the tag asso
iated with the dire
tive will help in tra
king it down

via the Command Center sea
h fa
ility.

The Obje
t Inspe
tor automati
ally updates itself as you move the 
ursor around, so you 
an leave it open and 
li
k on

various obje
ts to �nd out what they are and whi
h 
ommand generated them (and so how to modify them).

The �Run the Obje
t Editor� button will laun
h the The Obje
t Editor on the 
urrent obje
t, whi
h allows you to modify

or delete the property you are interested in.

The �Create Button for Clone� button will let you 
reate a palette button that 
an thereafter be used to insert a dupli
ate

of the obje
t any desired position in the s
ore. This means that a 
omplex marking or a 
hord with its �ngerings, ornaments

et
 
an be 
reated on
e and then inserted elsewhere, even in other s
ores by invoking that button.

Use the window 
ontrols on the Obje
t Inspe
tor's title bar to dismiss the window.

11 The Obje
t Editor

The Obje
t Editor allows you to edit the 
urrent Denemo Obje
t and also to 
reate palette buttons for generating su
h

obje
ts.It 
an be laun
hed from the Edit Menu or from the The Obje
t Inspe
tor.

11.1 Editing Obje
ts and their properties.

This window is modal, that is you 
annot intera
t with Denemo outside of the editor until you have dismissed it. To warn

you of this the pointer turns to an X if you try to intera
t with the Denemo Input Display when the Obje
t Editor is still

open. Buttons are provided to move on to editing the next (or previous) obje
t.

As with the Obje
t Inspe
tor the Obje
t Editor is sensitive to the 
ursor height, with the same navigation 
ontrol (�Next

note in 
hord�) to move through the notes of a 
hord so as to allow editing the detail of ea
h note. Where a 
hord has two

notes with the same note-name the button labelled �Alternate note� 
an be used to edit the other one.

In the example the 
ursor is on a 
hord whi
h has a trill on it. Within the 
hord it is on the note C-natural whi
h has a

�ngering on it for �nger 3. These are the Denemo Dire
tives atta
hed to the 
hord and note � there 
an be even more.

For ea
h Denemo Dire
tive (either standalone or atta
hed to the 
hord or note) there is a button �Exe
ute 
ommand:

<name of 
ommand>�. This button will run the 
ommand in edit mode � if it has one � or simply run the 
ommand if it

doesn't.

Below this is a row of buttons � the �rst will delete the Denemo Dire
tive, while the last (Advan
ed) allows a low-level

edit. The rest of the buttons are des
ribed next

11.1.1 Seeking, Editing and Conditionals

The next three buttons allow you to seek and edit further o

urren
es of this parti
ular Denemo Dire
tive in the s
ore (�Next�)

to set 
onditional behavior on the Denemo Dire
tive (�Conditional�) or to get the des
ription of the 
ommand that originated

this dire
tive (�Help�).

The �Next->� button allows you to sear
h on from the 
ursor for further o

urren
es of the Denemo Dire
tive � other

�ngerings for button on the Fingering dire
tive, for example. When found they 
an be edited and the sear
h resumed (the

usual short
ut for resuming the sear
h is Ctrl-E,r). These sear
h 
ommands 
an be invoked from the Edit menu, but this

button provides a 
onvenient start point.

The �Conditional� button allows you to say if you want the dire
tive to be ignored for 
ertain s
ore layouts 15. For

example, a 
ue is usually only wanted when printing the part, not the full s
ore. So 
li
king on this allows you to spe
ify this.
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11.1.2 Making the Dire
tive Conditional

The 
onditional button allows make the dire
tive ina
tive for 
ertain Omission Criteria14 or S
ore Layouts15. You 
an name

omission 
riteria as meaning the dire
tive should be ignored on typesetting. Or you 
an designate 
ertain s
ore layouts (e. g.

typesetting just one part, or one movement) as ones for whi
h this dire
tive is a
tive or ones whi
h ignore the dire
tive. So

if the full s
ore is wanted without �ngerings then by 
li
king this button with the full s
ore as the 
urrently typeset layout

the �ngering dire
tive 
an be designated as ignored by that layout. Further examples 
an be sear
hed and similarly marked

in the dialog that follows.

11.1.3 Making a Copy of the Dire
tive

This button 
opies the dire
tive to the 
lipboard � it 
an then be pasted by moving the 
ursor elsewhere and invoking the

paste 
ommand.

11.1.4 Creating Palette Buttons for Obje
ts and Properties.

The Obje
t Editor also has buttons for 
reating Palette Buttons for the Denemo Dire
tive that it edits. There are two of

these: one button would run the 
ommand that 
reated the attribute/obje
t the other will instantiate a dupli
ate � a 
lone

� of the attribute/obje
t.

Create Button for Command

This 
reates a palette button to run the 
ommand that 
reated the Denemo Dire
tive you have Obje
t Editor open on. You

are asked whi
h palette you want to pla
e the button in, and 
an 
reate a new, 
ustom, palette at that stage.

For example, if you use this on the Arranger attribute of a s
ore you will get a button that runs the 
ommand Arranger

(whi
h is found in S
ore->Titles. . . ). That button would then ask you to �ll in the name of the arranger. Compare this with

the next button, where you will 
reate a button that will install a 
lone of Arranger attribute that you have on this s
ore �

the arranger will be already �lled in, saving you having to enter your own name ea
h time you 
reate a new s
ore.

Create Button for Clone

This 
reates a button whi
h when 
li
ked will insert a dupli
ate of the Denemo Dire
tive that the Obje
t Editor is looking at.

This means that for any spe
i�
 attribute you want to re-use you 
an 
reate a button that will install exa
tly that Denemo

Dire
tive at the 
ursor. So, even if you do not know how a parti
ular e�e
t was generated, you 
an 
reate a palette button to

use the e�e
t in your own s
ore. The Open->Open Example s
ores provide useful examples of things you may need. See the

se
tion on Palettes4 for more about palettes.

This button is parti
ularly useful for things like your 
opyright noti
e whi
h stays the same from s
ore to s
ore � you just

need a 
lone to install on a new s
ore.
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12 The S
ore and Movement Properties Editor

The s
ore and movement editors allow you to edit global properties of the s
ore or 
urrent movement. Use the S
ore

menu to laun
h the editor with the S
ore properties expanded fully and the Movement menu to laun
h it with the Movement

properties expanded � they are 
ombined in a single window to make it easy to swit
h between them. Drag the separator if

you need to swit
h between them. On the Movement Editor pane there are buttons to 
hange movement, so you 
an 
ontinue

editing without re-starting the editor.

The built-in sta� properties 
an be edited using the button at the top. For ea
h Denemo Dire
tive atta
hed to the sta� or

voi
e there is a button �Edit 
ommand: <name of 
ommand>� � the tooltip of this button gives the help text of the 
ommand

that 
reated it. This button will run the 
ommand in edit mode. There are also buttons to do a low-level edit or to delete

the dire
tive.

Some older 
ommands do not have edit fa
ilities.

As with the Obje
t Editor11, this editor is modal.

In addition to the buttons des
ribed for the Obje
t Editor11there is a button to 
reate a dupli
ate of the dire
tive. The pur-

pose of this is to have two versions of some setting (e. g. the indent for the �rst sta�) whi
h are used for di�erent s
ore layouts

� a full s
ore may require a larger indent than an individual part. If you make the dupli
ate 
onditional on one layout, then it

is good pra
ti
e to make the original 
onditionally ignored by the same layout, rather than relying on it overriding the earlier di-

re
tive.

Note that the 
ommand that 
reated the dire
tive you have dupli
ated will only edit the original dire
tive, not the dupli
ate.

So if you want to 
hange it you 
an either use the Advan
ed edit button or delete and re-
reate it with the di�erent value

desired. (And then return to the value desired for the original 
opy of the dire
tive).
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13 The Sta� and Voi
e Properties Editor

A �tools� i
on is drawn at the start of the sta�. Cli
king on this opens the Sta� and Voi
e Properties Editor. As with

the S
ore and Movement Properties editor these are 
ombined as two panes in one window � often you won't be sure if the

property is one set on the Sta� or the Voi
e belonging to the sta�, so this makes it easy to look at both. Drag the separator

if you need to make more spa
e for one of them.

You 
an also laun
h the Sta� Properties Editor from the Sta� menu, and you 
an navigate the sta�s while in the editor

using Sta� Above and Sta� below buttons.

The built-in sta� properties 
an be edited using the next button � this is a rather arbitrary 
olle
tion of things that are

not atta
hed as Denemo Dire
tives, 
overing MIDI output for the sta�, some typesetting 
ontrols and display 
ontrols.

There are also buttons to inspe
t/alter the initial 
lef, time signature and key signature.

For ea
h Denemo Dire
tive atta
hed to the sta� or voi
e there is a button �Edit 
ommand: <name of 
ommand>� � the

tooltip of this button gives the help text of the 
ommand that 
reated it. This button will run the 
ommand in edit mode.

There are also buttons to 
reate palette buttons, low-level edit or to delete the dire
tive as with the other editors.

If the sta� has properties atta
hed to the key signature or time signature then these are in
luded after those atta
hed to

the sta� itself. As before the 
ommand that generated them 
an be run in edit mode.

Some older 
ommands do not have edit fa
ilities.

Note that if there are additional voi
es on a sta� these are usually displayed on a separate sta� for ease of editing. Only

the voi
e properties should be set on su
h a �sta��, the sta� properties will be ignored (sin
e the voi
e will be typeset on

the sta� above).

As with the Obje
t Editor11, this editor is modal, and as with the S
ore/Movements and Sta�/Voi
es editors there are

fa
ilities to make dupli
ate dire
tives for 
onditional use in the various layouts you may need.

14 Omission Criteria

Omission Criteria are a sort of lightweight easy-to-use alternative to full-s
ale S
ore Layouts. So, for example, if you want to

generate s
ore and parts for both a transposed and an un-transposed version of your s
ore you 
an 
reate an omission 
riterion

(say, �untransposed�) and set it on the Denemo Dire
tive(s) that 
ontrol the transposition of the s
ore. Then you only have

to turn the omission 
riterion on or o� in the Print View and the typesetting swit
hes between versions. If the instrument

names should 
hange as well then you 
an dupli
ate the instrument name dire
tive in the Sta� Editor and set the omission


riterion on the se
ond of those so that it is not used when the s
ore is untransposed.

You 
reate omission 
riterion names in the Print View7using the button labelled �No Omission Criterion Set� and apply

them to dire
tives using the Conditional Dire
tive 
ommands. For standalone dire
tives the Conditional Dire
tive 
ommands

are in the Dire
tives menu and in the Obje
t Editor, for s
ore, movement, sta� et
 dire
tives you use Conditional button on

the Dire
tive in the respe
tive editor (S
ore Editor, Movement Editor, Sta� Editor et
).
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15 The S
ore Layouts Window

S
ore Layouts are ways of typesetting a s
ore for di�erent purposes. Even without ever looking at the s
ore layouts window

you may �nd that you have been using them all along. For example, if you print just one part from a 
hamber work, or the

vo
al part from a song with piano a

ompaniment a s
ore layout is 
reated for this. In fa
t, layouts are always 
reated when

you typeset musi
 � for example from the Print Window Typeset, Part or Movement buttons, or from the Print menu. These

are default s
ore layouts they are 
reated automati
ally, and you don't have to think about them.

You 
an also 
reate a layout using the Print->Sele
t Sta�s to Print menu item - by un-
he
king the �Do not Create Layout

for this sele
tion� 
he
k box you 
an 
reate a 
ustom layout that will print just the sta�s(voi
es) that you leave 
he
ked. In

addition other 
ommands in the Print menu generate 
ustom s
ore layouts � for example a layout for the a

ompanist to play

from, with the solo part printed on a smaller sta�.

For more extensive fa
ilities in 
hoosing how to lay out the elements of your s
ore when typeset you 
an open the S
ore

Layouts window.
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The s
ore layouts window is shown by 
he
king View->S
ore Layout.

You 
an 
reate 
ustom layouts to print the musi
 in di�erent ways. For example, one layout may have the s
ore transposed,

or be for just two parts printed together. You start from a default layout, setting the values you want, and then 
li
k the

Customize button.

You 
an 
ustomize any layout in this window � positioning lyri
s above the sta� rather than below for example, or setting

the sta� groupings. You 
an add any sta� to any movement in the layout using the �Append Current Sta�� button (pla
e

the 
ursor in the sta� you wish to append). The buttons marked X next to the sta�s delete. You 
an also append whole
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movements and re-arrange the order of the movements using the additional buttons that appear on
e you have made the

layout a 
ustomized layout.

As well as appending sta�s you 
an substitute the musi
 for any spe
i�
 voi
e by 
li
king on the �Substitute� button that

appears when you expand the voi
e details.

Although all s
ore layouts have a

ess to the same musi
 to arrange on the s
ore the musi
 
an 
ontain features that are

ex
lusive to a one layout or ex
lude one layout, by making Denemo Dire
tives 
onditional on the layout being typeset. See

the 
ommands under Dire
tives->Make a Dire
tive Conditional or Notes/Rests->Make a Dire
tive Conditional for this, or

use the Conditional button in the Obje
t Editor 11.

The s
ore layout 
an only be edited graphi
ally when �rst 
reated. On
e re-loaded from disk it is redu
ed to its LilyPond

text form and 
an then only be edited in the LilyPond view.

16 Preferen
es Dialog

Under the Edit menu is a 
ommand to invoke the preferen
es dialog.

This is arranged in tabs for the di�erent aspe
ts that you 
an set.

16.1 The View Tab

The values set via the View menu are mostly persistent and so don't need to be set here, they 
an be set via the View menu.

There is a setting in the mis
ellaneous tab for this persisten
e property.
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16.2 The Command Tab

Here are options for how 
ommands should be treated. The 
an apply to the note at the 
ursor or the whole sele
tion.

A note entered that does not �t in the bar 
an be split or not. Short
uts 
an be set just by highlighting the 
ommand and

pressing the key, or not. Menu navigation with arrow keys 
an be allowed (otherwise you would be setting the arrow keys as

short
uts). The Return key 
an be moved easily from 
ommand to 
ommand as a short
ut, or not. The �newbie� mode 
an

be turned on � useful if you start to use a se
tion of the program that is new to you. A window 
an be popped up to tell you

whi
h keypress you invoked. And �nally the timing of the tooltips as you hover and move from one menu to another 
an be


ontrolled.
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16.3 The Externals Tab

Here you 
an set the paths to external programs that you 
an use from Denemo. Binary pa
kages have these set already,

but if you wish to use a parti
ular version of LilyPond or some other program to browse the manual then you will need to

enter the name (preferably the full path) of the program 
on
erned.

You 
an also set the default lo
ation for saving your s
ores. The update 
ommand set feature is not available at present.
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16.4 The Auto-Typeset Tab

This tab 
ontrols the 
ontinuous typesetting feature of the Print View7. Most of these 
an be set via the Continuous/Manual

button in the Print View window, but here you 
an 
ontrol how qui
kly Denemo 
he
ks for the need for a new typeset.

37



16.5 The Mis
ellaneous Tab

The font used by Denemo for menus and dialogs tooltips et
 
an be set here: the default is a spe
ial font that makes it

easy to read the musi
al signs � most fonts 
reate 1/2 and 1/4 notes that are not easy to distinguish at a glan
e, the ones in

the Denemo font are 
artoon-like exagerations that make it easy to see what is meant. You 
an set the font size too � none of

this a�e
ts the typeset s
ore, naturally. Some menus that 
an be
ome very large 
an be limited (a �more� button appears).

The display animation 
ontrols are here � how qui
kly the display refreshes and how page turns are done in the Page

View3.1.1.

The ex
erpt resolution setting is to 
ontrol the quality of the image 
reated by the Print Ex
erpt 
ommand (printing little

bits of musi
 for in
lusion in do
uments).

Denemo 
an 
reate thumbnails from the a
tual typeset musi
 (done on 
losing the session or by a 
ommand) � these are

displayed by �le browsers (not on windows o/s though).

Denemo keeps a list of s
ores you have visited re
ently � how many is 
ontrolled here. Use Open->Open Re
ent to 
hoose

one from the main menu.

The user name is set for visiting the denemo 
hat room via the Help menu.

The Autosave options guard against a power failure while you are working � nowadays you 
an set the time very short

without noti
eably impa
ting your work.
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16.6 The Audio Tab

This tab a�e
ts the sounds you will hear via a 
onne
ted audio system. The �rst se
tion is for feedba
k when entering

musi
. If you are looking at a sour
e manus
ript while entering rhythms or notes you will not want to look a
ross at the input

display to 
he
k that you are still entering at the right part of the bar. The sound e�e
t that tells you a new bar is beginning

is set via the �rst �eld � it is one of the drum e�e
ts available in the default Denemo soundfont, number 72, 
hange this to 0

to turn it o�, or other values for a more dis
rete sound.

There are settings for 
ontrolling the pit
h spelling for MIDI in � augmented and diminished intervals swit
h to this


hannel; if you hear this on an interval that was not supposed to be augmented or diminished you are alerted that you have

the enharmoni
 range wrongly set for the pie
e. You 
an set this to the instrument in use to avoid the e�e
t.

The Dynami
 Compression a�e
ts the volume at whi
h notes are played ba
k as you enter them from a MIDI keyboard � by


ompressing 100% you avoid meaningless variations in volume � you are only entering notes, not giving a moving performan
e,

after all! Without this you will �nd some notes are too quiet to be noti
ed and will think the note wasn't registered. Note that

the value 99 for dynami
 
ompression is a �magi
� value, it gives a slight after-tou
h e�e
t, useful for per
ussive instruments

(disatrous for organs!) to avoid the 
lipped sound when the note terminates.

The Audio Ba
kend se
tion 
hanges where Denemo tries to send the output sounds to � it 
an be di�
ult to mat
h up

the options to the hardware (and o/s) settings you have. After 
he
king 
arefully that you have got speakers atta
hed and

that they are working (e. g. by running some other program) you should turn o� all other programs that may be hogging the

audio out and then start up Denemo and only resort to 
hanging the settings here if you don't hear anything. Be espe
ially


areful not to alter the Sample Rate and Period Size unless you are an audio expert.

The Maximum Re
ording Time is there to limit the amount of memory you gobble up if you turn on the Re
ord3.4 of the

audio out.
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16.7 The MIDI tab

Here are the 
ontrols for a 
onne
ted MIDI 
ontroller (usually a keyboard nowadays). With Rhythm Entry 
he
ked you


an type in unpit
hed rhythms and immediately �ll them in from the MIDI keyboard21.2. The MIDI ba
kend se
tion lets

you spe
ify the 
ontroller you are using � set this even if �default� works. The MIDI output devi
e is 
urrently not used in

Denemo.

The soundfont is the set of sounds you hear � Denemo is shipped with a smallish soundfont, but if you want something

spe
ial then you 
an browse to the .sf2 �le using the Choose Soundfont button.

The Pit
h Entry tab is for a
ousti
 entry of notes � this is largely repla
ed by MIDI keyboard entry now that MIDI

keyboards 
an be bought very 
heaply.

17 S
ore and Movement Button Bars

The View->Titles, Buttons et
 
he
kbox makes two horizontal button bars visible (if they have buttons on them). What the

buttons show are titles/
omposer et
 for the s
ore and for the 
urrent movement. The s
ore button bar holds the movement

indi
ator buttons for s
ores that have several movements � you 
an 
li
k on one of these to move qui
kly to a di�erent

movement. In addition other s
ore-wide settings 
reate buttons on the s
ore titles bar and movement wide settings on the

movement titles bar. The menu items that populate these are under S
ore->Titles et
., and Movement->Titles et
 and other

menus.

18 Style, Layout, Titling

This se
tion 
overs where to �nd 
ommands for titles, page numbering, table of 
ontents, 
riti
al 
ommentary, page size and

so on. The 
ommands for stylisti
 dire
tives are in the S
ore->Typesetter or Movements->Typesetter menus. Here you �nd


ommands to set the a

idental style (when should a

identals be repeated?) and bar numbering styles, Rehearsal Mark style,

page numbering 
onventions, the fonts to use for the various elements of the s
ore.

In this dire
tory there are 
ommands to 
ontrol the number of systems per page or bars per system � these would only be

needed in ex
eptional 
ir
umstan
es. There are also 
ommands to 
ontrol how systems are laid out on the page, and on the

last page (the Ragged * 
ommands), and to 
ontrol the margins.

40



Notehead style for the whole s
ore is here (see the Notes/Rests->Notehead menu for individual notes) and a 
ommand for


reating a 
ustom barline style whi
h 
an then be used in the s
ore.

The 
ommand to instru
t the typesetter to transpose the entire s
ore is here � two �avors, a qui
k text-based one or one

that allows you to spe
ify the transposition you require by setting the pit
hes of two notes (from and to pit
hes).

Titles menus are found in the S
ore and Movements menus. There are two styles of titles, Book Titles and Simple Titles

whi
h shouldn't be mixed.

18.1 Simple Titles

Simple titles allow you to pla
e �elds of text around the musi
. In this example the �elds have been named �xxx movement�

when they have been set from the movement titles otherwise they have been set in the s
ore titles menu.

Ea
h �eld 
an 
ontain any text you need, with the Copyright �eld at the bottom of the �rst page, the Tagline �eld at the

bottom of the last page and the Instrument �eld at the top of ea
h page.

When you �rst set a title you just get a text box to write the title in. If you invoke the title again (e. g. 
li
k on it in

the Print View) then you 
an extensively alter its appearan
e using the LilyPond markup language � buttons are provided so

that you do not need to know the markup syntax. See the se
tion 20.9.2 for the interfa
e provided.

If you have several movements without titles and then set a title for the s
ore, that title will be repeated for ea
h movement

until you set at least one title �eld on the movements.

When you preview the title with the preview button you see the title relative to the default settings for that title � in

parti
ular if that title is normally bold and you want to turn this o� you will need to use \normal-text before the text to

be un-boldened.

18.2 Book Titles

With Book Titles you get a title page with a border and then ea
h movement 
an have titles of its own.
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The musi
 that appears on the title page 
an be sele
ted from anywhere in the s
ore, or omitted.

The S
ore->Titles->Book Titles menu also in
ludes table of 
ontents and 
riti
al 
ommentary 
ontrol.

19 Lyri
s

Vo
al musi
 
an be typeset using the 
ommands in the Lyri
s menu.

19.0.1 Overview of Lyri
s

Lyri
s in Denemo are handled as verses of text, ea
h verse made up of syllables. The s
reenshot shows a pie
e with three lyri


verses.

For ea
h verse a tab appears in the lyri
 pane at the bottom of the main window. The tab is a simple text editor � a new

one appears ea
h time you exe
ute Add Lyri
 Verse (Ctrl-l, a). The syllables are not atta
hed to the notes, so you 
an edit

the notes freely without a�e
ting the lyri
s.

Note that the lyri
s for a sta� are only shown when the 
ursor is in the sta� 
on
erned.

This means that you will see the lyri
s for the 
urrent sta� disappear from the Display Window when you swit
h sta�s,

whi
h 
an be dis
on
erting, but saves spa
e in the display.

Lyri
s are entered as a syllables separated by spa
es or new lines (whi
h have no other meaning). While typing or pasting

the text in will be enough for simple pie
es, spe
ial syntax 
an be in
luded for more 
omplex tasks; in parti
ular spa
e, hyphen

(�-�), unders
ore (�_�), tilde (�~�) all have a spe
ial meaning as explained below. For words with more than one syllable, a

hyphen 
an be inserted by � -- � (spa
e hyphen hyphen spa
e) or via the menu (Lyri
s > Divide Syllables with Hyphen).

Extra spa
es and new lines 
an be used freely without a�e
ting how the syllables are pla
ed under the notes. The full possible

syntax is given in the LilyPond do
umentation, but the guidan
e below 
overs many needs. Denemo provides you with menu

items for inserting the most useful extras su
h as stanza numbers, font sele
tion and skips.
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Spe
ial syntax beginning with a ba
kslash �\� should be on a line by itself or at the end of a line, so that Denemo knows

not to display it under the notes of the display.

The Lyri
 pane shows only a few lines initially, but you 
an drag it upwards if you need to see more or use the s
roll bars

at the side.

You may �nd it tri
ky to 
at
h the �sweet spot� where the lyri
s pane 
an be dragged open, sometimes dragging the red

bar at the bottom of the Denemo Display upwards helps � it 
an be returned to the bottom afterwards.

You 
an swit
h to the lyri
s pane from the notes with Ctrl-l, Ctrl-l. The verse 
hanges ba
kground 
olor to show that

keystrokes will now edit the lyri
s. And you 
an swit
h ba
k from editing the lyri
s to editing the musi
 with the Ctrl-l (or

Es
 or Tab keys). You 
an 
hange verses with Ctrl-PgUpl/PgDn keys and 
hange sta�s with Ctrl-up/down, and save with

Ctrl-s.

While editing the notes the 
ommand �Edit Lyri
 at Cursor� (Ctrl-l, Ctrl-l) �nds the pla
e in the lyri
s 
orresponding

to the 
ursor position allowing you to immediately edit the syllable that underlies the 
urrent note.

19.0.2 Spe
ial Syntax for Lyri
 Verses

This se
tion explains the spe
ial syntax that the 
ommands in the Lyri
s menu insert into the verse to 
ontrol whi
h syllables

fall under whi
h notes and other spe
ial e�e
ts. When you have used the 
ommands in the Lyri
s menu on
e (to remind

yourself) you 
an simply type the spe
ial syntax when you need it again, saving time messing with the mouse.

In this se
tion we'll indi
ate the syntax inserted by putting it in �� � the double quotes not being part of the syntax.

Grouping several words under one note:

Lyri
s->DivideSyllables

Inserts � -- � into the Lyri
 pane, whi
h typesets as a hyphen halfway between the syllables ea
h aligned below adja
ent

notes.

Lyri
s->Lyri
s Tie

Inserts a single unders
ore �_� or �~� tilde, whi
h will typeset as spa
e or lyri
 tie �

ˇ
�, respe
tively.

An alternative to the unders
ore is to en
lose the words in double-quotes, e. g. "word1 word2 word3", where the double

quotes are literally typed in.

Extending a syllable over several notes (Melisma) 
an be indi
ated by pla
ing a slur over the notes (a phrasing slur does

not trigger melisma).

Beaming 
an also be used to indi
ate Melisma (e. g. in 
horal musi
). This 
an be done by turning o� automati
 beaming

and manually beaming those notes that have a single syllable. However, the Denemo Display will not display the 
orre
t

underlay of syllables and notes when doing this, instead refer to the Print View (use 
ontinuous typesetting).

Lyri
s->Melismata->During Word, with Slur

Inserts spa
ed double hyphen, � -- �, into the Lyri
 pane, typesetting hyphen(s) if needed to the end of the slur

Lyri
s->Melismata->Word End, with Slur

Inserts spa
ed double unders
ore, � __ �, into the Lyri
 pane, typesetting a lyri
 extender to the end of the slur.

Lyri
s->Melismata-> During Word, no Slur

Inserts � -- _ � into the Lyri
 pane, spreads the syllable over two notes inserting hyphen(s) if needed.

Lyri
s->Melismata->Word End, no Slur

Inserts � __ _ � into the Lyri
 pane, whi
h spreads the syllable over two notes typesetting a lyri
 extender.

Lyri
s->Melismata->ExtendMelisma,

Inserts � _ � into the Lyri
 pane, extending the Melisma by one note or group of notes.

Skip Syllables in Sele
tion

Inserts spe
ial syntax e. g. �\repeat unfold 4 \skip 1� for skipping 4 notes. This is an alternative to typing in a series

of pairs of double-quotes, one for ea
h skipped note. On
e the syntax is inserted in the verse, it may be easily edited, if you

have 
hanged the length of the introdu
tion.

Notes Without Words, i. e. gaps in the text, may be produ
ed with a spa
ed symbol (if one is required) or by a spa
ed

unders
ore or a pair of double-quotes (�""�) for ea
h wordless note.

LilyPond's markup syntax 
an be used in lyri
 verses as well � pre�x with \markup. For example

\markup\box

"boxed words"

will surround the words with a box � as you see a new line (before the a
tual words to appear under the note) is needed for

the Denemo Display to underlay 
orre
tly.

20 Musi
al Elements � everything on and around the notes.

In this se
tion the 
ommands available for the various musi
al elements are des
ribed and their arrangement in the menu

system is des
ribed.
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20.1 Beaming

Commands to 
ontrol beaming are available for individual notes, whole passages of notes and entire s
ores. Mostly the default

beaming will be what you want. An ex
eption is the beaming in 3/4 time whi
h 
an look like 6/8 when beamed in the

traditional manner. Use Obje
t Menu->Time Signature->Beam at Half Measure to alter the default.

Individual beam 
ontrol 
ommands are lo
ated in Notes/Rests->Beaming. The start/stop beam short
uts are usually [

and ℄. Other 
ommands in
lude providing partial breaks in the beaming and stopping beaming on a note.

Setting beaming for the whole s
ore 
an be done using Obje
tMenu->S
ore->Typesetter->Set Beaming Rules. Either the

general rule 
an be given, or Beam Ex
eptions 
an be set from the sele
tion. To use the latter, set up a measure or measures

with the beaming manually set using the Individual beam 
ontrols and then sele
t the passage and invoke Set Beaming Rules.

Setting beaming for a passage 
an be done with Obje
tMenu->Time Signatures->Set Beaming Rule. In addition, at a

time signature 
hange a beaming rule 
an be set using Obje
tMenu->Time Signatures->Time Signature with Beaming Rule.

After automati
 beaming has been turned o� use Obje
tMenu->Dire
tives->Typesetter->Start Beaming to insert a di-

re
tive re-starting automati
 beaming at the 
ursor. The Cadenza On/O� 
ommands turn on/o� automati
 beaming (as well

as the timing 
ontrol).

20.2 Barlines

The important thing to know about barlines in Denemo is that they are not just graphi
al marks on paper � e. g. you 
annot

put a repeat end barline followed by a repeat start barline and expe
t both to print � instead you must use a repeat-end-start

barline. This is be
ause you are telling Denemo about the musi
, not about how to draw it � the repeat-end-start barline is

drawn 
ompletely di�erently if it o

urs at the end of a line, for instan
e.

Another useful thing to understand is that the �barlines� that appear in the Denemo display are not really barlines at all,

just a 
onvenient breaking up of the musi
 into �
hunks�. Normally, of 
ourse, you will use one 
hunk per measure so they

will 
orrespond with the typeset barlines.

There is a relationship between line/page breaks and barlines: you 
annot have line/page breaks at any point in the musi
,

there must be a barline there. However this 
an be a �hidden� barline, so that option is in the menu too.

One 
urious 
onsequen
e of this is what happens if you 
ontrive to input notes that are timed so that a note is always

playing at every barline; normally you use tied notes for this, but if (by mistake) you leave one bar short in duration you 
an

�nd that none of the following typeset bars start with a note, and the result is that the line 
annot be broken � it extends o�

the right hand side of the page.

20.3 Ties and Slurs

. . . and phrasing slurs. It is important to distinguish ties from slurs sin
e they often look the same in the typeset musi
, but

in some 
ir
umstan
es they are typeset di�erently � so you may think the musi
 looks ok, and later after some editing, it looks

wrong � you have hit a situation where the typesetting distinguishes the two. To help with this Denemo shows distinguishes

slurs with little green and red markers for the start/end, while the ties are heavier horizontal 
urves. If you import musi


from other notation programs they often 
onfuse slurs and ties, so a 
ommand to �x these is in the Notes/Rests->Tied Notes

menu. (In the unusual 
ase of slurred notes of the same pit
h � e. g. open string/stopped note on a violin � you would have

to 
orre
t the error by hand).

Also in this menu are 
ommands to tie individual notes in 
hords, to 
ontrol the dire
tion (up/down) of ties and to adjust

the shape of ties whi
h 
an be very tri
ky to position ni
ely in tight situations. Ties at repeats, where the tie goes to/
omes

from �nothing�, are here too;they are 
alled Laissez Vibrer and Repeat Tie. (Laissez Vibrer has two uses, of 
ourse, but it is

the same symbol).

The 
ommands for slurs are in the Notes/Rests->Slurs menu. The most useful have the short
uts 7,8,9 to slur from the


urrent note to the next note, to extend the slur and to redu
e it. There are also 
ommands to turn on/o� a slur start or slur

end, and these are also in the right-
li
k menu on the notes in the Denemo Display.

When entering rhythms with the numeri
 keypad the slurs 
an be added without breaking rhythm by using the 
ontrol key

with the rhythm. So, for example, Ctrl-3 enters a 1/8 duration slurring from the previous note, or extending the slur. And

Control keypad 9 (Ctrl-KP_9) 
reates a slurred dotted rhythm (
orresponding to keypad 9 whi
h 
reates a dotted rhythm

based on the last entered duration) and similarly Ctrl-KP_7,Ctrl-KP_7 for entering a slurred triplet based on the 
urrent

duration.

Phrasing slurs are slurs over the top of ordinary slurs, used in Romanti
 musi
 and later. The display just shows where

they start and end, the typesetter allows only one level of nesting slurs as that is all that is used in musi
. More would require

a non-printing voi
e 
arrying the extra layers of slurs.

20.4 Triplets and Friends

Colle
tively 
alled �tuplets� these are handled in Denemo by two markers, one beginning the tuplet whi
h holds the timing


hange and the other a simple end tuplet marker. The Denemo Display only knows how to display tuplets that start and end

in the same bar, but the typesetter is not restri
ted in that way. You 
an stop and re-start the tuplets at measure breaks so

that the Denemo Display understands what you mean, and 
ontrol the pla
ement of tuplet numbering and tuplet bra
kets

using the Tuplet Bra
kets and Tuplet Numbering 
ommands in the same menu. The typeset 
an also 
ope with nested tuplets

perfe
tly well, though the Denemo Display will be strange.
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There are spe
i�
 
ommands for the more 
ommon tuplets, and arbitrary tuplets 
an be started using the Arbitrary Tuplet


ommand � you give the numbers to denote the fra
tion that the timing is 
hanging by (e. g. triplets are 2/3 of the duration

written so you give 2,3). If you wanted 7 notes in the time of 4 you would give 4, 7 so that the durations 
hanged by 4/7,

after seven 1/8-notes you would have the equivalent of 4 1/8-notes duration.

20.5 Gra
e Notes

Both appogiature and a

ia
ature are supported, as well as inserting pairs of beamed gra
e notes (other amounts of gra
e

notes should be manually beamed see the se
tion on beaming20.1 ). Gra
e notes are ignored in the simple playba
k, use the

playba
k view to hear them.

Gra
e Notes present a pe
uliar problem to the LilyPond typesetter that Denemo uses. As they do not have any duration

it gets into di�
ulties if there are other things (su
h as time signatures, double bars et
) going on at the same time. The

problem arises when other parts are also sounding and they don't have the same gra
e notes. There is a 
ommand in

Denemo to work around this by installing �gra
e note hints� � these are dummy non-printing gra
e notes in the other

parts. This is done automati
ally by the Che
k S
ore routine, so normally you don't have to run it yourself, but it is in

the Notes/Rests->Gra
e Notes menu. It is good to be aware of this however, as you will see these pale yellow rests that

de
lare themselves to be gra
e notes in the input musi
 display sometimes.

20.6 Ornaments

Notes/Rests->Markings->Ornaments for ornaments atta
hed to notes/
hords. Dire
tives->Markings->Ornaments for 
us-

tomized ornaments whi
h appear in the Denemo Display as separate obje
ts before the note they de
orate. Besides all the

standard ornaments, there are 
ommands to sta
k a

idental signs above/below ornaments and to 
reate 
ustomized orna-

ments, drawn using an external ve
tor graphi
s editor. One set of 
ustom-built ornaments for Fren
h harpsi
hord ornaments

is provided.

20.7 Dynami
s

Notes/Rests->Markings->Dynami
s for dynami
 spanners (
res
. dim. et
, both hairpins and textual). Dire
tives->Markings-

>Dynami
s (short
ut Ctrl-d) for dynami
 marks (p, sfz et
) they appear as obje
ts in the Denemo Display just before the

note they relate to. These dynami
s a�e
t both typeset and playba
k.

In some 
ir
umstan
es it is desirable to pla
e dynami
s in a separate Dynami
s Line (or Sta�). This is often the 
ase for

the dynami
s 
entered between piano sta�s; it ensure that hairpins align with ea
h other and that other dynami
 markings

are pla
ed 
onsistently. It also allows for positioning of dynami
s markings other than dire
tly on notes � they 
an be pla
ed

at slightly later or earlier times. To do this notes of shorter duration are put in the dynami
s sta� and the dynami
 markings

are atta
hed to them. The notes are just dummy notes to indi
ate the timing of the onset of the dynami
 atta
hed.

Sometimes, all parts have the same dynami
s. In this 
ase a single Dynami
s Line 
an be pla
ed at the bottom of the

system and given a blank part-name. Sta�s with blank part-names are printed with every part, so this line of dynami


markings will appear under every part printed with the Print Part 
ommand (or the Part button in the Print View).

20.8 Tempo Markings

Dire
tives->Markings->Tempi and Metronome Marks allows insertion of a tempo 
hange (both typeset and playba
k). Change

of beat is also in this menu.

20.9 Text

20.9.1 Simple Text

For simple use Dire
tives->Markings->Textual Annotation 
ommand may su�
e. This allows you to pla
e some text posi-

tioned above or below automati
ally or as you de
ide.
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20.9.2 Multi-line Text and Musi


The most general 
ommand is Dire
tives->Markings->Multi-line Text and Musi
. As the name implies, this is used to


reate markings that 
an in
lude new lines, as well as musi
 snippets6, 
hord symbols, musi
al signs et
.

The Preview Pane at the top shows the �nal e�e
t � it is updated as you type and a Preview button is provided if it fails

to update.

The new lines 
an be simply introdu
ed by using the ¶ mark, whi
h is inserted when you press Enter. For more 
ontrol

over new lines and 
olumns you should delete these and use the 
ommands in the Sele
tion menu.

You 
an not only insert simple text but also 
ontrol the itali
, bold, supers
ript, font-size et
, as well as inserting a
tual

notated musi
, fret-diagrams in the senten
es. These work by inserting �markup�, that is the text is interspersed with markup


ommands � \bold, \itali
 et
 � to indi
ate what appearan
e is desired. The Insert button gives a menu of things to insert

at the text 
ursor position, while the Sele
tion button gives a menu of 
ommands to alter the text sele
ted. If any parti
ular

markup is not in the menu then you 
an type it in � the markup �\dynami
 f� will insert a forte sign by a

essing the spe
ial

font used for dynami
s. For other markup 
ommands are available, do
umented in the LilyPond manual.

Note that the markup 
ommands are generated automati
ally in a distin
tive font, monospa
ed and bold. This is not

essential, but helps to remind you that it is a spe
ial syntax, you 
an just type in the syntax yourself. Take 
are when editing

as errors 
an make trouble when typesetting: it is essential that the bra
es {} form pairs, for example.

By right-
li
king in the Denemo Display on standalone markup obje
ts you 
an edit the text and many other aspe
ts of

the obje
t, su
h as how it displays itself in the Denemo Display.

Use Insert->Insert (with value)->Paste Note Name for the insertion of automati
ally-transposing note names (so that

things like B-minor in a title will transpose when the s
ore is transposed) . The Insert menu also allows to insert fret diagrams

et
.

As a �nal 
he
k, 
li
k Preview before you �nish � if it does not typeset 
orre
tly edit it again to remove the error or delete

it � don't leave it as you s
ore will not typeset with bad markup in it.

The text when it appears in the �nal typeset s
ore 
an be edited via right-
li
k for the position or 
ontent. This same

interfa
e is also used if you edit the text of titles or the text to show between/after movements (e. g. on a page intentionally

left blank), but in these 
ases the text will be on a single line (unless the Sele
tion->Column and Sele
tion->Line are used to


reate multi-
olumn/line text expli
itly).
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20.9.3 Text Spanning

In the Dire
tives->Markings->Spanning Dire
tives->Typesetter>Spanning menus are 
ommands that 
ause markings that

span a passage of musi
, su
h as Cadenza and Piano Sustain pedal marks, ottava markings, and extended trill marks. Here

also are 1st and 2nd (and nth) time bars, with short
uts r,1 for starting a �rst time bar, r,2 starting a se
ond time bar and

r,e for ending either. The Nth time bar 
an be used to hold any text needed (i. e. use this for a �rst time bar if the indi
ation

should be other that 1.). The bar numbering 
an be adjusted at se
ond (nth) time bars, espe
ially important if you have


onditional se
ond time bars (ones that are not printed when typesetting a part in whi
h the �rst and se
ond time bars would

be identi
al). There is a 
ommand for inserting 
onditional se
ond time bars.

20.9.4 Rehearsal Marks

The Dire
tives->Markings subdire
tory also holds the Rehearsal Marks 
ommands. Marks have a spe
ial property that they

only appear on
e at the top of the system, even though they 
an be pla
ed in ea
h part. Theu 
an be 
ustom text or default,

and 
an be used as bookmarks for navigation. The 
ustom text marks 
an be edited using the full Multi-Line Text and Musi


interfa
e.

20.10

21 A Survey of the Input Methods

21.1 Introdu
tion

Denemo allows you to enter notes via PC keyboard, MIDI keyboard, Virtual on-s
reen piano keyboard or mi
rophone input.

With Denemo you 
an tailor Denemo to allow you to use your preferred method of entering notes via keyboard. You 
an

set the keyboard short
ut for a 
ommand just by pressing the desired key while the menu item is sele
ted. You 
an right 
li
k

on the menu item and 
hoose Open Command Center to set a two-key keyboard short
ut.

By default, Denemo o�ers several ways of entering musi
: typing at the keyboard, playing in via a MIDI keyboard

(
ontroller), playing in a
ousti
ally using a mi
rophone or 
hoosing items from the menu system.

Typing at the keyboard 
an be very fast, if you forget whi
h keypress you need you 
an 
onsult the menu system to �nd

out. This method is good for tou
h typists.

For entering a lot of already written-out musi
, playing the musi
 in via a MIDI keyboard or mi
rophone 
an o�er the

fastest and most musi
al method.

With all methods of note entry a measure start sound will be heard when your note entry has moved to a new measure,

whi
h means you do not have to look up to know that you have started a new measure as expe
ted. This measure start sound


an be set to 0 in the preferen
es if unwanted.

21.2 Playing Notes into Denemo � MIDI

Denemo 
an take pit
hes dire
tly from MIDI input. Sele
t Input->Midi Input. The 
ontrol panel allows you to 
hoose the

enharmoni
 range, the default 
enters around the initial key signature (e. g. E-�at to G-sharp for C-major). If you enter

a diminished or augmented interval the note will be played in a separate MIDI 
hannel whi
h 
an be used to alert you to

pit
h-spelling mistakes (e. g. entering A-�at when G-sharp was meant, you will get a lot more augmented and dimished

intervals if you have the enharmoni
 range set wrongly for your pie
e).

The best way to use the MIDI keyboard is enter the musi
 �rstly as pure rhythms using the p
-keyboard, ignoring the

note names. The durations show as yellow/brown notes. Ea
h duration makes a distin
tive sound as you enter the durations.

As you start ea
h measure a sound is made so that you 
an keep your eyes on the s
ore you are 
opying from, without needing

to look up and 
he
k that you haven't miss-typed. If you are a reading musi
ian you will �nd that you tap in the rhythm

rhythmi
ally whi
h helps to keep your pla
e in the pie
e you are entering.

On
e you have entered the rhythms for one or more measures you 
an play the notes via MIDI � the 
ursor automati
ally

goes to the start of the rhythms you have entered. As you play notes in via MIDI they give their pit
hes to the rhythm you

have notated. By this means you 
an enter a pie
e of musi
 in the time taken to play it twi
e � on
e to give the rhythm and

on
e to give the pit
hes. If the pie
e modulates strongly you may need to shift the set of a

identals used to mat
h the s
ore,

the pit
h spelling fa
ility will alert you to this. (If entering pit
hes via a mi
 you need to navigate to the start point, but this

isn't needed for MIDI in).

Under Input->MIDI are various "MIDI �lters" that allow you to 
ontrol how the MIDI input is used: with none a
tive

the behavior is as if you had entered the notes using the p
-keyboard, but with the following advantages

� The o
tave, a

idental and note name are all entered in one press of the MIDI key. The 
ursor automati
ally advan
es

so you 
an 
ontinue to play in notes.

� The duration keys enter the yellow/brown duration-only notes, when you play a MIDI key the 
ursor automati
ally

moves to the �rst of these.

� Holding down the Alt key (or sustain pedal) lets you enter 
hords.
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� Holding down the Ctrl key lets you 
he
k the pit
hes of a pie
e already entered. The 
ursor only advan
es if the note

played is the one at the 
ursor.

� Holding down the Shift key lets you listen to the MIDI keyboard without a�e
ting the s
ore.

� The problem of entering the wrong enharmoni
 is largely avoided by Denemo's simple pit
h-spelling strategy. The more

extreme intervals are played in a separate MIDI 
hannel so that if, for example you enter F - A-sharp it sounds quite

distin
t from F - B-�at.

21.2.1 The Numeri
 Keypad

The set of keys for entering numeri
al data that appear on full-sized keyboards make a very useful tool for entering rhythms.

Even if you use a laptop without su
h a numeri
 keypad it is worth the 5 or 6 dollars/euros/pounds that a separate USB

keyboard 
osts nowadays � it 
an be blu-ta
ked to your MIDI 
ontroller for easy a

ess.

The default key short
uts for the numeri
 keypad are illustrated here:

Here I have a
tually stu
k labels with the most used durations and over-drawn an indi
ation of the others. (Keys 5 and

6 do the1/32 and 1/64th notes). The keypad 7 does triplets with a double press (so that it makes three presses for a triplet,

e. g. Key 4, Key 7, Key 7 for a triplet of 1/16th notes). The dotted rhythm �dotti�es� the 
urrent note whatever its duration

is. Likewise the gra
e note key turns the 
urrent note into a gra
e note and the tie key turns tied status o�/on for the 
urrent

note. Keypad 8 �lls the rest of the bar with the 
urrent note or rest, while Enter dupli
ates the 
urrent bar. The enharmoni


shifts 
an be pressed repeatedly to shift the set of a

identals to be used sharp-wise of �at-wise, subsequent notes played in

will be taken from the new set, whi
h is indi
ated on the status bar. The duration keys, triplet key and dottify key 
an all be

used with the Control modi�er to slur from the previous note.

With this arrangement you 
an play in the rhythm of a pie
e in musi
al time and then play on
e more with the MIDI

keyboard to add the notes (
hords require the Alt key or foot pedal). Before you are pra
ti
ed in this use of the numeri


keypad it is a good idea to do just a bar or two, or a line or two at a time, so as not to lose your pla
e.
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Some 
omputers don't respe
t the numeri
 keypad's keys � 
onfusing the Enter with the Return key for example, or treating

Shift-2 as arrow-down. Try the numlo
k key to see if you 
an persuade it to take you seriously, or look into any key-mapping

fa
ility there may be with the ma
hine. And, beware! a separate standalone numeri
 keypad might seem like a good idea

but in fa
t they are a nuisan
e, besides being more expensive, as they have things like a 000 key whi
h emits three keypresses

at your peril!

21.3 Using an On-s
reen Piano Keyboard

The Input menu o�ers you a Virtual Piano Keyboard. This behaves like an atta
hed MIDI keyboard but you 
li
k with the

mouse or tap on your tou
hs
reen instead of pressing the keys. The PC keyboard 
ontinues to work while using the on-s
reen

keyboard, so you 
an delete/alter add ornaments freely while using this �keyboard�. Chords 
an be entered with a left-
li
k,

and as with a real MIDI keyboard you 
an enter as mu
h of the rhythm before adding pit
hes (see 21.2).

The default keyboard is eight o
taves around middle C whi
h is highlighted by the letter C engraved on its keyhead. The

Virtual Keyboard window 
an be s
rolled to a

ess other parts of the keyboard and made as wide as needed.
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21.4 Using the Denemo From the PC keyboard

21.4.1 Note Entry

The default keyboard short
uts appends a note when you type a number key 0 to 6 with the pit
h taken from the 
ursor

height and inserts a note when pressing a letter key a to g. This provides one way of entering notes � move the 
ursor up or

down to the note position and press a number key for the duration. If the note is to be out-of-key then the equal or minus

key 
an be used to sharpen/double-sharpen/�atten/double-�atten the next note. This method of note entry is probably not

the most e�
ient however: in the Input->PC Keyboard menu you 
an 
hoose to make the number keys 
hange the prevailing

duration without entering a note. With that setting you 
an use the note names to append notes to the bar only pressing the

number keys if the duration 
hanges. The duration 
an be dotted/double dotted with the period key, and the o
tave adjusted

with 
omma (for down) or apostrophe (for up).

Mixed mouse and keyboard strategies are possible too. For example with one hand 
hanging the prevailing duration via

the keyboard the other 
an 
li
k on the Insert Note buttons in the Note Insertion palette.

21.4.2 Chord Entry

The standard keybinding for entering a note in a 
hord is the Insert key, Ctrl-Insert or Del,Del deletes. The is inserted at

the 
ursor height, use - and + to �atten/sharpen the note before you enter it (avoiding hearing both notes if you �atten/sharpen

afterwards). There are also 
ommands to enter a named note Alt-a, Alt-b . . . are the standard short
uts for this. When

a 
hord should have two notes on the same line or spa
e the same keypress 
an be used to enter it, however sele
ting whi
h

note to edit 
an be tri
ky. The easy way is to use the Obje
t Inspe
tor's �Alternate note at 
ursor� button to make the note

you want a

essible for editing.

21.4.3 Editing Musi


When not appending musi
, the letter keys 
hange the note at the 
ursor to that named note. You need to use the shift key

to insert a new note. So Shift-a,Shift-a inserts the note A et
. Plain a edits the note at the 
ursor to be an A. Likewise

with the numeri
 keypad the Shift key 
an be used to edit a note duration, while the plain number keys insert the duration of

the note at the 
ursor. (If you do not have a numeri
 keypad, you have to use the number keys � best to plug in an additional

USB keyboard with numeri
 keypad, they are very 
heap nowadays).

Rests are entered with Alt-0 Alt-1 ...

Spa
er rests (that is non-printing rests as seen in keyboard polyphony) have short
uts too Mod4-0 et
, where Mod4 is the

key with a �ag on it. However, on Windows ma
hines you will need to re
laim the Windows Mod-4 key from Mi
rosoft or

re-de�ne the short
uts, e. g. to Shift-Alt-0 et
 or Ctrl-Alt-0.

The Caps Lo
k 
an be a nuisan
e � you will sometimes have it turned on a

identally and wonder why keypress are not

working. You 
an use it to a
hieve Shift-A, Shift-B . . . but it is probably best left alone.

21.5 Playing Notes into Denemo � Audio (Sound
ard Mi
 Input)

Denemo 
an listen for, and dete
t the pit
h of notes on the mi
 input of the 
omputer; it doesn't attempt to guess the rhythm

� su
h systems do not work well � but you will �nd that playing the notes in time will help you to play them in, as well as

make playing them in a musi
al experien
e rather than a 
hore.

Playing the notes in 
an be mu
h qui
ker than using the keyboard sin
e the note o
tave and a

idental are all given just

by playing the note. If you are able to play a musi
al instrument then this will probably be mu
h faster for you than typing

note names, o
tave shifts and a

identals at the 
omputer keyboard. Using the headphones-out of an ele
troni
 keyboard

avoids "noises-o�" interfering with the pit
h dete
tion. Many mi
rophones and pi
kups bene�t from some pre-ampli�
ation

� it is worth getting the level right before you begin.

When you sele
t the Input->Audio on the Main Menu the Pit
h Re
ognition window pops up. While the mouse pointer

is inside the s
ore drawing area the s
ore is sensitive to pit
hes heard via the mi
rophone input. The ba
kground 
olour of

the s
ore 
hanges to show that the notes will be entered into the s
ore.

There are two ways of using the pit
h entry � Overlay mode (default) and Insert mode. The button marked Insert 
auses

notes to be entered into the 
urrent measure in the prevailing rhythm � the mode is set to Insert for this. The button marked

Overlays overlays the notes already present with the pit
hes you sound. There is a third button, marked Tuning, whi
h is a

state-of-the art musi
al instrument tuner.

Musi
 is entered into the measure whi
h holds the 
ursor. If you are overlaying a rhythm already entered, then the �rst

un-overlayed note in the measure is overlayed by the note dete
ted. You 
an delete the overlay using the regular delete keys,

or 
lear them altogether if you want to start over in a measure. If you are in Insert mode then the notes dete
ted will be

inserted at the 
ursor position.

Use the enharmoni
 shift to sele
t whether Bb or A# should be entered when you enter the given pit
h � you 
an usefully

go as far as B# and Fb.

Use the transpose 
ontrol to shift up or down by o
taves.

Most of the other settings would require study of the Aubio do
umentation to understand, but the one marked threshold

may be useful to make the dete
tion less sensitive to ambient noises if using a mi
rophone with an a
ousti
 instrument.
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The best set-up is to plug the headphones-out so
ket of an ele
troni
 keyboard into the mi
 input, and 
hoose a piano

setting on the ele
troni
 keyboard.

If you don't have any musi
al instrument that you 
an plug dire
tly into the mi
 in, then you 
an use an a
ousti
 instrument

with a mi
rophone, in whi
h 
ase move your mi
rophone 
loser or further from your instrument to get reliable dete
tion. Too


lose and you get double dete
tions, too far and you get missed ones. To 
he
k for good dete
tion open a pie
e of musi
, set

Overlay mode and put the 
ursor in the �rst measure and play the pie
e in � the notes should all turn blue if you have perfe
t

dete
tion. It is worth while getting perfe
t dete
tion � more than one or two miss-dete
ts per pie
e of musi
 and you may

want to use the Insert rather than the Overlay method.

The Audio Input button introdu
es a spe
ial entry mode where the pit
hes you play in will overlay the rhythm, appearing

as blue notes. You 
an delete any wrong pit
hes using the usual delete keys, without deleting the rhythm. In fa
t if you have

an "interloper" (an extra spurious note) you 
an delete it and the other pit
hes will all move along to their 
orre
t pla
es.

Another method of playing musi
 in a
ousti
ally doesn't involve entering the rhythm separately. For this sele
t Input-

>Audio and then 
hoose Insert instead of Overlays on the Pit
h Re
ognition Panel that pops up. With Insert the sounded

notes are entered as in the prevailing rhythm. The same applies if you have MIDI � by 
hoosing a rhythm (e. g. half-note,

quarter-note, or a 
ustom rhythm pattern) and playing in the pit
hes you 
an enter the musi
 into a blank s
ore.

22 Trans
ribing from Fa
simile or Hand-written S
ore

If you have a PDF of musi
 you wish to trans
ribe with Denemo you 
an display it within Denemo and 
reate links between

the sour
e material and your trans
rition. This means that when you later review your work you 
an qui
kly lo
ate whi
h

point in the original manus
ript belongs to whi
h point in your trans
ription. In the s
reenshot the Print View window is

shown on the left with the fa
simile on the right. The Print View is a Custom Layout showing the 
hords both as notation

and as 
hord symbols (as well as the original �gures). The blue marker shows the position of the link that was 
li
ked on to

open the fa
simile at the right pla
e. Note that the pie
e is also being typeset in a di�erent key � that is just another aspe
t

of this 
ustom layout. Everything � in
luding the 
hord symbols are automati
ally adjusted.

Sele
t the File->Open menu and the item Open a Sour
e for Trans
ribing. Sele
t the PDF 
ontaining the musi
 to be

trans
ribed from. The PDF is opened in a Sour
e View window. Right-
li
k in this window at the point that your trans
ription

will start. This will 
reate a link � a Denemo Dire
tive Obje
t � in your s
ore at the Denemo 
ursor position, shown as arrow

i
on. If you later use a right-
li
k on this Denemo Dire
tive the sour
e �le will be re-opened with the blue highlight marker

on that point in the s
ore. (Depending on the position of the top of the page you may need to s
roll the Sour
e View window

up or down to bring it into view).

When you re-open the s
ore to 
he
k or edit at some point you 
an 
li
k on a nearby link and the sour
e �le will be opened

and the position highlighted on
e again. If you pla
e a link as the very �rst item on the very �rst sta� of a movement then

the link will be automati
ally opened when the s
ore is opened on that movement.
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Note that when Denemo lo
ates a position in the sour
e PDF it always puts the start of the page

that holds the lo
ation at the top of the window. Use the Previous/Next button to ensure you have

the page start at the top before using it to insert links. Note also that the links refer to the page

with the zoom value that obtains when you 
reate the link. It will re-open with this same zoom

fa
tor. The link will 
ontinue to position itself as you zoom, but if you zoom out so far that the spa
e

outside the page be
omes visible the links will not mat
h until you zoom ba
k.

You 
an also �mask out� areas of the sour
e view that you don't want to see while you are trans
ribing. This is parti
ularly

useful if you are trans
ribing just one part on a multi-part system. You mask out the sta�s up to the one you want to follow

and the ones from after that up to the same part in the next system and so on. To do this you drag down over the material

you want to ex
lude � it turns gray leaving the part you are interested in easy to see at a glan
e. You 
an remove any one of

these grayed-out areas � or all of them � by 
li
king inside them whereon you get a menu of 
hoi
es.

23 Comparing S
ores

In the File menu is a 
ommand that lets you 
ompare two Denemo s
ores for di�eren
es. You are given a dialog to 
hoose ea
h

Denemo s
ore and then these are loaded into two tabs and Denemo then s
ans for di�eren
es. It �rst �ags up any di�eren
es

in the S
ore, Movement and Sta�/Voi
e information and then starts going through the s
ores note-by-note. You 
an stop the


he
king at any parti
ular note or other musi
 obje
t where there is a di�eren
e and the 
ursor is left on that note in ea
h

s
ore.

24 Creating an Index

In the File menu there is a sub-menu Indexing that allows you to 
reate an index for all the Denemo s
ores you have in all

the sub-dire
tories starting from some 
hosen dire
tory (�folder�).

With the Create Index 
ommand you 
hoose the starting dire
tory for the s
ores you want to index and Denemo then

s
ans all the s
ores below that 
reating a new s
ore that typesets as an index to your s
ores. For ea
h s
ore the 
omposer,

title, instrumentation and the musi
 for the in
ipit of the pie
e is typeset, together with the S
ore Comment if there is one.

This index 
an be further re�ned by the Sort and Filter 
ommands in the same menu.

You 
an 
reate your own sele
tion of s
ores indexed using the Filter by S
heme Condition29. For this you write a valid

S
heme expression that is true for the �les you want. You write this S
heme expression in the S
heme S
ript window (show this

via the View menu). The expression 
an involve the symbols 
alled 
omposer, title, 
omment, �lename and instruments. These

are all strings ex
ept for �instruments� whi
h is a list of strings [for example the S
heme 
ondition (= 2 (length instruments))

will sele
t all s
ores that have two sta�s℄. This �ltering of an already 
reated index is very qui
k as the �les do not have to

be found again, however the sele
tion is limited to just those properties of the s
ore.

With Create Conditional Index you 
an 
reate more 
omplex 
onditions to determine whi
h s
ores should be in
luded in

the index, and in addition you 
an 
reate a 
omment for the index entry based on the s
ore's 
ontent. A 
onvenien
e fun
tion

DenemoIndexCommentDisplay is provided to set the 
omment you wish to in
lude in the index entry for a given s
ore. Here

is an example whi
h 
omputes the durations of all the movements in the s
ore and prints that as the 
omment:

(define total (ForAllMovementsExe
ute* (lambda ()

(let ((tot '()))

(define (off)

(define time (d-GetMidiOffTime))

(if time time 0))

(d-Re
reateTimebase)

(d-MoveToEnd)

(off)))))

(set! total (round (apply + total)))

(DenemoIndexCommentDisplay (string-append " Duration is: "

(number->string (inexa
t->exa
t (floor-quotient total 60))) " m. "

(number->string (inexa
t->exa
t (floor-remainder total 60))) " s."))

#t

This example ends with the symbol #t to make it 
lear that all the s
ores are to be in
luded in the index. If the last expression

was something like (= (d-GetSta�sInMovement) 2) then it would only in
lude s
ores with two sta�s in the index.

The Print View shows the index and looking down it you 
an identify a s
ore by the �rst few bars shown - then you 
an


li
k on the �lename to open the s
ore.

You 
an save the index s
ore just as any other Denemo s
ore, just remember to re-run Create Index if you add �les to the

dire
tory and want those in
luded.
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25 Using a Proof-Read PDF

If you send the PDF output of your s
ore to someone to proof-read they 
an make PDF annotations to it. In the File->Open

menu 
hoose Open Proof Read PDF to open a proof-read PDF. It will open at the �rst annotation, and, by 
li
king on the

note the annotation applies to, the annotation is transferred as a 
omment into the s
ore before the note 
hosen. When you

have done all the annotations on the �rst page advan
e to the next page with annotations using the button "Next".

There are limitations � the PDF must be 
reated from your s
ore with point-and-
li
k (the default) and you must not

alter the s
ore in a way that would invalidate the point-and-
li
k. (Basi
ally, don't edit again until the proof-reading is done,

always good pra
ti
e!) Also, enter the annotations in order from the start and don't edit before you have entered all the

annotations, as this 
ould invalidate the point-and-
li
k.

26 S
ore Setup

Denemo provides di�erent ways to set up s
ores:

� Create template with the spe
ial name "default.denemo". If this is pla
ed at the top level of your templates dire
tory

(that is ~/.denemo/templates/default.denemo), then it will be opened ea
h time you start a new s
ore.

� Use a Template or Custom Template (See File->Open menu)

� Create template and save it with the spe
ial name "default.denemo" using File->Save->Save Template. This will

pla
ed at the top level of your templates dire
tory (that is ~/.denemo/templates/default.denemo), then it will be

opened with Ctrl-n the �Open Default Template� 
ommand.

� Use short
ut keys to add staves and set attributes.

� Use Menus.

� Create an init.denemo s
ore with everything you want to start up with, and any a
tions you want to be taken before

you begin. This will be opened when you �rst start Denemo (that is on
e per Denemo session). See 29.13 on page 75

for details on what a
tions you 
an have Denemo perform before you start.

26.1 Using Templates to Setup S
ores

Denemo 
omes with a few preinstalled templates. You 
an also 
reate your own templates as well, in fa
t you 
an use any

Denemo �le as a template, just open it using File->Open->Open Custom Template. (The only di�eren
e is that, opened this

way, the s
ore is a new i. e. untitled s
ore)

1. Navigate to File, Open Template. The Open dialog box appears.

2. Double 
li
k on a template name from the list of templates. The dialog box 
loses and the template appears.

3. Adjust the 
lef, key and time signatures as needed.

27 More Features

27.1 Transposition

Denemo has mu
h better transposition fa
ilities than the 
ommon musi
 notation programs su
h as Sibelius, Finale and

Muses
ore. If you have used those programs you are probably thinking �I need to transpose this musi
�, meaning you are

going to 
hange all the notes and 
hords you have entered along with the key signatures. You 
an do this in Denemo (see

Physi
al Transposition27.1.1) but usually it is far better just to say that you want s
ore to be typeset in the new key. This

takes 
are of everything in one go � even footnotes that refer to the pit
hes of notes in the musi
 will transpose (unless you

have entered them as �xed values). And your input musi
 stays looking just as you entered it � essential if you have to look

ba
k and 
ompare with a sour
e for instan
e.

The 
ommands to transpose a s
ore are in the S
ore->Typesetter menu. �Transpose on Print� is a graphi
al user interfa
e

� you get presented with a new tab 
ontaining two notes � 
li
king the Transpose button will transpose so that the �rst pit
h

will be typeset as the se
ond one. The initial values a C and E♭ (up a minor third) so by typing G this would be
ome up a

�fth. The �rst note 
ould be 
hanged as well, if you know that D should be
ome F♯, for example, then you 
an make those

the two notes.

The other 
ommand is qui
ker but more te
hni
al � (Print) Transposed lets you type in the names of the two notes. The

te
hni
al bit is how you spe
ify sharp and �at and whi
h o
tave. To spe
ify sharp the note is followed by �is�, for �at �es�

(these are a
tually the Dut
h names!). O
taves are indi
ated by ' for up and , for down, so for example 
 
� would mean

transpose two o
taves down.
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27.1.1 Physi
al Transposition

In the 
ase where you have 
hanged your mind and want the a
tual notes you have entered to be altered the 
ommands to

do this are in the Notes/Rests->Transpose menu. The most general of the 
ommands are Arbitrary Transpose Down and

Arbitrary Transpose Up. These allow you to des
ribe the interval you want to transpose the musi
 by e. g. m7 for a minor

seventh, d5 for diminished 5th. Alternatively you 
an use two pit
hes to des
ribe the interval as in the previous se
tion. Note

that these 
ommands work on the note/
hord at the 
ursor or the sele
tion; any key signatures will need 
hanging separately

if needed.

27.2 Sear
h and �Repla
e�

There are two 
ategories of sear
h available in Denemo. The �rst is in Navigation->Seek menu and the other is in the Edit

menu.

In Navigation->Seek is the 
ommand to �nd a sele
ted rhythmi
 pattern (Ctrl-f, Ctrl-f) � that is to �nd a sequen
e of

notes with the same rhythms as those of the sele
tion. On
e found the pattern 
an be edited, either manually or by exe
uting

a series of steps re
orded in the S
heme window (see se
tion 28.2.1). There is also a 
ommand to �nd to �nd a sequen
e of

sele
ted notes. In both these 
ases the sear
h 
an be resumed by exe
uting the 
ommand with no sele
tion.

The se
ond sort of sear
h is in the Edit menu (and also available from the Obje
t Editor). Ctrl-e,e starts a sear
h for

obje
ts of the type that the 
ursor is on, while Ctrl-e, Ctrl-e o�ers all the types of obje
t in the movement and allows you to

sele
t whi
h to sear
h for. Ctrl-e,r resumes the sear
h. When found the obje
t 
an be manually edited, deleted or modi�ed

using re
orded 
ommands as des
ribed above. The sear
h order is 
olumn-wise, that is everything at the same musi
al moment

is sear
hed and then the next musi
al moment is sear
hed from the top sta� downwards. When the end of movement is rea
hed

you 
an wrap to the start of the movement or move to the next movement or wrap round to the �rst movement.

27.3 Rapidly Marking Passages

Frequently passages in a s
ore need marking in some way - they need to be played up an o
tave, or they have a 
ontinuous

trill sign above them et
. This is 
alled Spanning and the indi
ators for where the passage starts or ends is frequently marked

by a pair of Denemo Dire
tives or other pair of obje
ts. Examples are in the Dire
tives->Markings->Spanning menu. Other

examples are tuplets, and passages in a di�erent 
lef. Where a lot of passages need to be marked like this there is 
ommand

in the Edit->Sele
t menu whi
h allows you to sele
t passages to be spanned by a parti
ular pair of obje
ts at a single key

press. This 
ommand is labelled �Span Sele
tion with Pair of Obje
ts� and it works by 
opying the pair to be inserted around

sele
ted passages onto the 
lipboard when the 
ommand is �rst invoked and then subsequent invo
ations pla
e the spanning

obje
ts before/after the passage you have sele
ted. In this way you 
an work your way through a s
ore sele
ting passages to

be altered and applying the alteration at the tou
h of a key.

27.4 Piano Sta�s, Or
hestral S
ores et


A piano sta� 
an be added using the Sta�->Add Sta� menu (or by adding the Piano instrument from the Sta�->Add Sta�-

>Add Sta� for Instrument 
ommand). In addition, piano sta�s, and sta� groups su
h as 
hoir sta� 
an be 
reated using

the Sta� Groupings menu under the sta� menu. You 
an set a piano sta� within a sta� group by setting su

essively the

StartPiano and StartGroup 
ontexts on a single sta�, or more generally setting StartPiano, EndPiano on adja
ent sta�s within

a sta� group.

27.5 Single Sta� Polyphony

Use the Sta�s/Voi
es->Voi
es menu for pla
ing more than one voi
e on a sta�. You 
an set the initial voi
e number from this

menu (voi
es 1 and 3 are stem up with slurs and ties et
 adjusting to suit, voi
es 2 and 4 are stem down). Dire
tives 
an be

pla
ed in the musi
 to 
hange voi
e, see Dire
tives->Typesetter->Voi
es menu.

You will also need spa
er rests for voi
es that are silent, and 
ommands to displa
e rests verti
ally and horizontally (see

Notes/Rests->Rest Insertion menu), and 
ommands from the Voi
es menu under the Sta�s/Voi
es and Dire
tives->Typesetter

menus.

27.6 Entering Figured Bass

To enter �gures 
hoose Notes/Rests->Markings->Figured Bass. There are some short
uts that enable all the work to be

done with the numeri
 keypad. A brief summary is given by right 
li
king the option. The 
onventions are des
ribed in the

LilyPond do
s.

There is also a MIDI �lter for entering �gured bass in the Input->MIDI menu. With this you play the bass note at the


ursor and then the notes that the �gures are indi
ating; on releasing the bass note the �gures are entered for that bass note.

The footpedal allows a sequen
e of �gures to be entered on one note and also to enter extenders.
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27.7 Fret Diagrams

Fret Diagrams 
an be pla
ed on the s
ore using the 
ommand Fret Diagram in the Obje
tMenu->Dire
tives->Markings menu

In addition by assigning a Denemo sta� to display as fret diagrams, 
hords 
an be entered in standard notation whi
h will

then be dislayed as fret diagrams. See Obje
tMenu->Sta�Menu->Sta�PropertiesMenu->FretDiagrams for this.

27.8 Tablature

Musi
 
an be displayed in tablature � the default is for standard guitar tuning but others 
an be set. The menus to explore

are:

Obje
tMenu->Sta�Menu->Sta�PropertiesMenu->Tablature

Obje
tMenu->Dire
tives->Typesetter->Tablature

It is possible to display the same musi
 as both notation and tablature, and example of how to do this will be found under

File->Open->Open Example.

27.9 Entering Chord Symbols

There are two quite di�erent ways to enter 
hord symbols (also known as Chord Names, Fake Chords). If the 
hord 
hanges

do not happen mid-way through notes then you 
an use Notes/Rests->Markings->Chord Symbols to atta
h 
hord symbols to

the notes themselves. A brief summary is given by right 
li
king the option. The 
onventions are des
ribed in the LilyPond

do
umentation.

An alternative is to set a sta� to display not the 
hords in regular notation but the 
hord symbol that represents the


hord. Create a sta� and use Sta�->Sta� Properties->Chord Symbols. Then this 
ase you enter a
tual 
hords whi
h will be

displayed as Chord Symbols. The duration of the 
hords will determine the positioning, enabling 
hord 
hanges mid-note.

The 
hord symbols 
an then be arranged above or below the melody or other representation of the pie
e using Sta�s->Swap

Sta�s or 
reating a 
ustom layout in the S
ore Layout window.

A palette is available4.5 for inserting 
hords, with this palette sele
ted the key sequen
e pm7<Enter>, for instan
e, will

insert/append a 
, e-�at, g, b-�at 
hord if the 
ursor height is on a C, (or 
-sharp, e, g-sharp, b if there is a pending sharp).

Chord Charts 
an also be 
reated � there is a Chord Charts palette for these. Compa
t 
hord 
harts require a pat
h to

LilyPond � enquire on the mailing list for this.

Part III

Advan
ed Topi
s

28 Customizing Denemo

28.1 Adding and Editing Key/Mouse Short
uts

Denemo allows you to 
hoose whi
h keys a
tivate whi
h 
ommands (short
uts). It also allows you to 
hoose Mouse press/release

gestures (in 
ombination with keys su
h as Shift, NumLo
k, CapsLo
k et
).

See The Command Center for setting short
uts. The following qui
ker method 
an also be used for one-key short
uts. To


hoose a short
ut for a menu item, sele
t the item (it be
omes highlighted) and press the key that you want to be
ome the

short
ut. If your 
hoi
e of keyboard short
ut already belongs to another 
ommand, you are warned about this, and given the


han
e to 
hange your mind or steal the short
ut. Also, you 
an 
hoose whether to distinguish between keypresses with, say

the NumLo
k down and those without or to ignore it. If the NumLo
k is set but no 
ommand for that key spe
i�
ally requires

it then the setting of NumLo
k is ignored and the keypress is treated as if the NumLo
k was o�.

The menu item that a
tivates the 
ommand shows the short
uts that exist in bright blue lettering. PrsL-CapsLo
, for

example, is the Press a
tion on the Left mouse key while the CapsLo
k light is on. In the default 
ommand set this is linked

to the BeginSlur 
ommand, so that together with the RlsL-CapsLo
 for the release of the left mouse button, you 
an "draw"

slurs by using the mouse. Similarly, Shift with left mouse button (MveL-Shift) is set to allow you to drag notes up and

down the sta�. (This is using Command MoveNoteToCursor).

For mouse short
uts invoke the Command Center with the right 
li
k on the menu item. The Set Mouse Short
ut Dialog

requires you to set whi
h button and a
tion you want to use and then to hold/lo
k the keyboard modi�er while 
li
king on

the big button. The setting you have 
hosen is shown, and you 
li
k ok to a

ept it.

Mouse Short
uts are tri
ky to set � you are able to 
ontrol what happens on mouse button press and release,

whi
h 
an be used to do things like drag notes up and down. But they are tri
ky to set up!
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28.2 More Commands

Adding More Features

It is possible to add more 
ommands to the set that Denemo ships with. Some of these are shipped with Denemo, but not

added automati
ally so as to keep the menu sizes manageable. Generally, you right-
li
k to �nd more menu items to add;

on
e added you 
an set a keyboard/mouse short
ut and keep the 
ommand in your default setup. S
heme to be exe
uted at

startup 
an be pla
ed in the denemo.s
m �le.

An example � qui
ker dynami
s sele
tion It 
an be slow to 
hoose dynami
s (Ctrl-D) be
ause the list is quite long

to move down (or move to the mouse). You 
an de�ne a list of the dynami
s you a
tually want to be readily available as for

example: (de�ne DenemoDynami
List '(("f" "127" "Forte") ("p" "127" "Piano"))) This makes forte available just by pressing

Return and piano available by pressing down arrow Return. (The others via More of 
ourse). If you pla
e this in (home

dire
tory)/.denemo-x.x.x/a
tions/denemo.s
m then it will be de�ned when you start Denemo.

28.2.1 Re
ording a Denemo Ma
ro

You 
an re
ord a frequently used sequen
e of a
tions into the S
heme window. These 
an be used in sear
h and repla
e

operations or they 
an be installed as a 
ommand in the menu system and given a keyboard short
ut or pla
ed in a palette.

To do this 
hoose View->S
heme S
ript. (You do not have to understand what a S
heme S
ript is to use this!) In the

window that pops up 
he
k Re
ord S
heme S
ript and then do the set of steps you wish Denemo to re
ord. As you exe
ute

ea
h 
ommand the S
heme window gets that 
ommand added to it.

For example, suppose you wanted to pla
e a trill on a parti
ular note in a 
ertain rhythmi
 pattern that o

urs frequently

in a pie
e. You would re
ord the 
ursor moves and the Trill 
ommand needed to edit the pattern 
on
erned and then use

the Sear
h and �Repla
e� fa
ility to seek the pattern you needed sele
ting �Continue� or �Exe
ute S
heme� as ea
h pattern is

found.

Or, suppose you wanted a 
ommand to delete the next note (there are 
ommands to delete the previous note and the


urrent note, so why not?). You would enter some notes, put on Re
ord S
heme S
ript and then move the 
ursor right two

steps and delete the previous note (with Ba
kspa
e if that is your short
ut). (Ea
h time you use a 
ommand you will see

the S
heme syntax for that 
ommand entered into the S
heme window). Now turn o� Re
ord S
heme S
ript and you 
an

experiment with your new 
ommand by pressing Exe
ute in the S
heme S
ript window. To save this new 
ommand for future

use, you right 
li
k on a menu item (in the menu where you would like the 
ommand to appear) and 
hoose "Save S
ript as

New Menu Item", this will ask you to make up a name for your new 
ommand as well as a label for the menu item et
.

You 
an save the 
ommand in your default sequen
e of 
ommands (via Edit->Customize Commands. . . ->Manage Com-

mand Set->Save as Default Command Set). If not you will be asked if you want to save your new 
ommands when you exit.

Otherwise you 
an re-load via the More->My Commands menu item.

Turn o� the Re
ord before starting the sear
h and repla
e, otherwise the sear
h and repla
e 
ommand itself will

be re
orded. Delete the re
orded 
ommands before saving your s
ore, unless you want it to be exe
uted ea
h time

you open the s
ore. (See the se
tion Musi
al S
ores that do things!

28.2.2 Editing a LilyPond Tweak

There is another way of adding your own favorite LilyPond tweaks, whi
h is by modifying a tweak that has already been done.

This 
an be done by using the text-edit dialog on an existing Denemo Dire
tive (usually found under the Advan
ed button

provided in the Obje
t Editor11). Here you 
an see the a
tual LilyPond text that will be inserted, and there is a button to


reate a s
ript to generate whatever you 
hoose to enter. You 
an also enter the name of graphi
 images (.png �les) that are

to be used to represent your item in the display, and say where it should be positioned.

On
e you have 
reated the s
ript, it 
an be saved in the menu system by right 
li
king on an item in the menu where you

want to pla
e the 
ommand, and 
hoosing "Save S
ript as New Menu Item" as above. An alternative to 
reating a 
ommand

in the menu system is to 
reate a palette button (see the Obje
t Editor11).
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29 Writing S
heme S
ripts

If you are a programmer you will have guessed that you 
an edit the S
heme S
ript window to 
reate any 
ommand you

want. Even if you are not familiar with S
heme you may �nd that you 
an adapt other s
ripts to do what you want.

A good example of this is a s
ript to insert a parti
ular LilyPond dire
tive into the s
ore. This is all that many s
ripts do:

it is easy to see the pie
e of LilyPond in the S
heme S
ript window, and by 
hanging it you 
an 
reate a new 
ommand.

For example, from the More menu sele
t the 
ommand /menus/Obje
tMenu/Instruments/Or
hestral/RehearsalMark (the

�les are laid out in folders/dire
tories in the same way as the menu system itself). Then 
hoose Get S
ript into S
heme

Window from the right 
li
k menu. With this 
ommand its s
ript is appended to the S
heme S
ript window. Here you 
an

see the part that says

(d-Dire
tivePut-standalone-postfix "RehearsalMark" " \\mark \\default" )

whi
h is inserting the LilyPond dire
tive "\mark \default" whi
h inserts the default rehearsal mark. (The extra ba
kslashes

are needed to tell S
heme that you literally mean a \ sign). You 
an 
hange this to insert any other LilyPond that you need

� always doubling the \ signs. Then you 
an save as a new menu item, a palette button, or use Save S
ript from S
heme

Window to 
ustomize the 
ommand you started with.

More ambitious programmers will need to know all the 
ommands available. Besides the 
omplete Denemo 
ommand

set (the list is given in the Command Center window) there are the following additional S
heme pro
edures de�ned (see the

�les a
tions/denemo.s
m and a
tions/denemo-modules/*.s
m for more). A brief summary of any S
heme pro
edure 
an be

obtained by typing its name into the S
heme Window in the 
ommand line interfa
e (CLI) and pressing Enter. The help text

atta
hed to built-in 
ommands is available in a S
heme variable 
onstru
ted by pre�xing the 
ommand name with �Help-�,

however there are older, hardwired 
ommands for whi
h this doesn't work at present.

29.1 Commands Getting User Input

All these 
ommands are invoked from s
heme as (d-Command args. . . )

� GetChar returns a string 
ontaining a single 
hara
ter from the user (blo
ks waiting for a keypress)

� GetKeypress returns a string representing a keypress from the user (blo
ks waiting for a keypress) (e. g. Up for the up

arrow key et
.)
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� GetCommand returns a string 
ontaining the 
ommand name for the user's keypress (blo
ks waiting for a keypress)

� GetCommandFromUser

� RadioBoxMenu takes an arbitrary number of arguments, ea
h argument is a pair, presents a menu of the �rst items in

the pairs and returns the se
ond item as 
hosen.

� RadioBoxMenuList like RadioBoxMenu but takes a list

� GetUserInput takes three arguments (title, prompt, suggested value) and returns the string typed by the user in the

pop-up dialog or #f if Can
elled.

29.2 Commands Getting Information about Obje
t at Cursor

All these 
ommands are invoked from s
heme as (d-Command)

� GetType returns a s
heme string indi
ating the type of the 
urrent obje
t

� GetNoteName returns a s
heme string, giving the note name a to g of the 
urrent note

� GetNote returns a s
heme string, the note name, a

idental and o
tave of the 
urrent note (in LilyPond notation)

� GetNotes returns a s
heme string, the notes of a 
hord separated by spa
es (in LilyPond notation)

29.3 Predi
ates

Testing what is true at the 
ursor position

� Musi
?

� Note?

� Rest?

� Chord?

� Singlenote?

� Dire
tive?

� Timesignature?

� Keysignature?

� Clef?

� Tupletmarker?

� TupletOpen?

� TupletClose?

� StemDire
tive?

� None?

� MovementEmpty?

� MeasureEnd?

� MeasureBeginning?

� LastMovement?

� FirstMovement?

� EmptyMeasure?

� UnderfullMeasure?

� FullDurationMeasure?

� OverfullMeasure?

� MeasureComplete?
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29.4 Iterators

The parameters are either a string (s
ript) whi
h will be evaluated after moving the 
ursor to step of the iteration or a s
heme

pro
edure (a thunk).

� (ForAllMovements s
ript)

� (ForAllSta�s s
ript)

� (ForAllMovementsExe
ute pro
)

� (ForAllSta�sExe
ute pro
)

� (ForAllObje
tsInSta�Exe
ute pro
)

� (ForAllObje
tsInS
oreExe
ute pro
)

� (ForAllNotesInChordExe
ute pro
)

29.5 Dire
tives

� (EditStandaloneDire
tive tag display)

� (EditLilyPond)

� (Atta
hDire
tive type �eld tag 
ontent . overrides)

� (EditSta�Dire
tive tag)

� (ToggleDire
tive type �eld tag 
ontent . overrides) ; four strings and an arbitrary number of �ags (numbers) for override

�eld.

� (d-Dire
tivePut-standalone tag)

� (d-Dire
tive-standalone tag)

� (d-Dire
tiveGetTag-standalone)

� (d-Dire
tivePut-s
ore tag)

� (d-Dire
tive-s
ore tag)

� (d-Dire
tiveGetTag-
hord)

� (d-Dire
tiveGetTag-note)

� (d-Dire
tiveGetTag-s
ore)

� (d-Dire
tiveGetTag-s
oreheader)

� (d-Dire
tiveGetTag-movement
ontrol)

� (d-Dire
tiveGetTag-header)

� (d-Dire
tiveGetTag-paper)

� (d-Dire
tiveGetTag-layout)

� (d-Dire
tiveGetTag-sta�)

� (d-Dire
tiveGetTag-voi
e)

� (d-Dire
tiveGetTag-
lef)

� (d-Dire
tiveGetTag-keysig)

� (d-Dire
tiveGetTag-timesig)

� (d-Dire
tiveGetTag-stemdire
tive)

� (d-Dire
tiveDelete-standalone Tag)

� (SetDire
tiveConditional)

� (ToggleHidden type tag) ;;; eg (ToggleHidden "note" "Fingering")
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� (ManageSystemDire
tive params present? put-pro
 get-pro
 del-pro
 tag title prompt value test deletion-info)

� (EditForStandaloneToggle tag) provides the editing options for a standalone dire
tive that 
an only be toggled o�/on.

� (StandAloneSelfEditDire
tive pair #:optional (step? #t) (graphi
 #f) (displaytext #f) (minpixels #f) the pair is a tag

and the LilyPond syntax to insert e. g. (
ons "BreathMark" "\\breathe") with optional parameters: boolean to step/not

step right after insertion, graphi
, display text, and width to o

upy in the Denemo Display (minpixels). Any override

needs to be set separately.

29.6 Message Bar

These 
ommands put a message on the status bar to the right hand side. They are de�ned in a
tions/denemo-modules/helpsystem.s
m.

Help messages are pushed paired with a symbol (e. g. (
ons ('mytag �mymessage�))) and 
an simply be Popped or removed

using the tag.

� (Help::Push pair)

� (Help::Pop)

� (Help::RemoveTag tag) ; Remove all messages with this 'tag symbol

� (Help::ClearQueue) ; Clear the entire queue

� (Help::UpdateWriteStatus)

29.7 Move and Sear
h

� (FindNextObje
tAllSta�s test?)

� (PrevDire
tiveOfTag tag)

� (NextDire
tiveOfTag tag)

� (NextDire
tiveOfTagInMeasure tag)

� (PrevDire
tiveOfTagInMeasure tag)

� (GoToMeasureEnd)

� (GoToMeasureBeginning)

� (MoveToColumnStart)

� (MoveToColumnEnd)

� GetPosition ;use result with (apply d-GoToPosition position)) to go to the position gotten

� (PositionEqual? position1 position2)

� (Probe test moveinstru
tion)

� (ProbePosition test movement sta� measure horizontalposition)

� (ProbePreviousMeasure test)

� (ProbeNextMeasure test)

� (ProbeNextObje
t test)

� (ProbePreviousObje
t test)

� (ProbeNextNote test)

� (ProbePreviousNote test)

� (MoveDownSta�OrVoi
e)

� (MoveUpSta�OrVoi
e)
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29.8 More . . .

This is a fairly 
omprehensive listing of S
heme 
ommands that are built-in but not in
luding those in the menus. Call these

via (d-<
ommand> params . . . ), e. g. (d-GetNote 2) gets the se
ond note from the bottom in a 
hord.

� GetStartTi
k

� HideMenus. Hides all the menus or shows them if passed #f

� HideButtons. Hides S
ore buttons or shows them if passed #f

� DestroyButtons. Removes S
ore buttons

� HideWindow. Hides the Denemo.proje
t or shows it if passed #f

� S
riptCallba
k. Takes the the name of a s
ripted 
ommand. Runs the s
ript stored for that 
ommand. S
ripts whi
h

invoke other s
ripted 
ommands use this (impli
itly?)

� GetOption. 
reate a dialog with the options & return the one 
hosen, of #f if the user 
an
els

� GetTextSele
tion. Returns the text on the 
lipboard

� GetPadding. Returns the padding that has been set by dragging in the Print view window

� GetRelativeFontSize. Depre
ated � gets an integer from the user via a dialog

� InitializeS
ript. Takes a 
ommand name. 
alled by a s
ript if it requires initialization the initialization s
ript is expe
ted

to be in init.s
m in the menupath of the 
ommand passed in.

� LoadCommand. pass in a path (from below menus) to a 
ommand s
ript. Loads the 
ommand from .denemo or system if

it 
an be found. It is used at startup in .denemo �les like ReadingNoteNames.denemo whi
h exe
utes (d-LoadCommand

\"MainMenu/Edu
ational/ReadingNoteNames\") to ensure that the 
ommand it needs is in the 
ommand set.

� A
tivateMenuItem. Takes a string, a menu path (from below menus). It exe
utes the 
ommand for that menu item.

Returns #f for no menu item.

� Lo
ateDotDenemo. Returns the dire
tory holding the user's preferen
es

� GetType. Returns the name of the type of obje
t at the 
ursor

� GetLilyPond. Returns the lilypond typesetting text for obje
t at the 
ursor or #f if the obje
t has not yet been typeset

� GetTuplet. Returns a string numerator/denominator for a tuplet open obje
t or #f if 
ursor not on a tuplet open

� SetTuplet. Set passed string as numerator/denominator for a tuplet open at 
ursor

� SetBa
kground. Set passed 24 bit number as RGB 
olor of ba
kground.

� GetClipObjType. Takes a sta� number m and a obje
t number n. Returns the type of obje
t at the (m, n)th position

on the Denemo Clipboard or #f if none.

� GetClipObje
ts. Takes a sta� number m, Returns the number of obje
ts in the mth sta� on the Denemo Clipboard or

#f if none.

� PutClipObj. Takes a sta� number m and a obje
t number n. Inserts the (m, n)th Denemo Obje
t from Denemo

Clipboard into the sta� at the 
ursor position

� ClearClipboard. Clears the Denemo Musi
 Clipboard

� GetSta�sInClipboard. Gives the number of sta�s in the Denemo Musi
 Clipboard

� GetMeasuresInSta�. Gives the number of measures in the 
urrent sta�

� GetSta�sInMovement. Gives the number of sta�s in the 
urrent movement

� Sta�ToVoi
e. Makes the 
urrent sta� a voi
e belonging to the sta� above

� Voi
eToSta�. Makes the 
urrent voi
e a independent sta�

� IsVoi
e. Returns #f if the 
urrent sta� is not a voi
e else true

� AdjustXes. Adjusts the horizontal (x-) positioning of notes et
 after paste

� HighlightCursor. Turn highlighting of 
ursor o�/on returning #t, or given a boolean parameter sets the highlighting

returning the previous value
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� GetNonprinting. Returns #t if there is an obje
t at the 
ursor whi
h has any printing behavior it may have overridden

� SetNonprinting. Sets the Non Printing attribute of a 
hord (or note/rest) at the 
ursor. For a rest this makes a non

printing rest, for a note it makes it ia pure rhythm (whi
h will not print, but 
an be assigned pit
h, e. g. via a MIDI

keyboard. Pass in #f to unset the attribute

� IsGra
e. Returns #t if there is a gra
e note/
hord at 
ursor, else #f

� IsTied. Returns #t if there is a tied note/
hord at 
ursor, else #f

� IsSlurStart. Returns #t if there is a 
hord with slur starting at 
ursor, else #f

� IsSlurEnd. Returns #t if there is a 
hord with slur ending at 
ursor, else #f

� IsCres
Start. Returns #t if there is a 
hord with 
res
endo starting at 
ursor, else #f

� IsCres
End. Returns #t if there is a 
hord with 
res
endo ending at 
ursor, else #f

� IsDimStart. Returns #t if there is a 
hord with diminuendo starting at 
ursor, else #f

� IsDimEnd. Returns #t if there is a 
hord with diminuendo ending at 
ursor, else #f

� IsInSele
tion. Returns #t if the 
ursor is in the sele
tion area, else #f

� HasSele
tion. Returns #t if there is a sele
tion, else #f

� IsAppending. Returns #t if the 
ursor is in the appending position, else #f

� ShiftCursor. Shifts the 
ursor up or down by the integer amount passed in

� GetMovement. Returns the movement number 
ounting from 1

� GetVoi
eIdenti�er. Returns the LilyPond identi�er for the 
urrent voi
e

� GetSta�. Returns the sta�/voi
e number 
ounting from 1

� Sta�Hidden. With parameter #t or #f makes the sta� hidden/visible in the display, returns the hidden status. Type-

setting is una�e
ted

� GetMeasure. Returns the measure number 
ounting from 1

� SetObje
tDisplayWidth. Sets the display width of the obje
t at the 
ursor to the value passed (in pixels)

� GetHorizontalPosition. Returns the 
ursor horizontal position in 
urrent measure.\n 1 = �rst position in measure, n+1

is appending position where n is the number of obje
ts in 
urrent measure

� GetCursorNote. Returns the note name for the line or spa
e where the 
ursor is

� GetCursorNoteWithO
tave. Returns the note name and o
tave in LilyPond notation for the line or spa
e where the


ursor is

� DebugObje
t. Prints out information about the obje
t at the 
ursor

� DisplayObje
t. Displays information about the obje
t at the 
ursor position.

� GetEditingTime. Prints out the 
umulative time spent editing this s
ore.\nThe time 
ounts any period between starting

to edit and saving to disk\nThe time is a

umulated over di�erent editing sessions.

� DestroyS
hemeInit. Remove the user's 
ustomized buttons and other s
heme startup stu� 
reated by the user in

a
tions/denemo.s
m

� GetNoteName. Returns the name of the (highest) note in any 
hord at the 
ursor position, or #f if none

� InsertRest. Insert a rest at the 
ursor in the prevailing duration, or if given a integer, in that duration, setting the

prevailing duration. If MIDI in is a
tive, the 
ursor stays on the rest after inserting it, else it moves right.

� PutWholeMeasureRests. Insert rests at the 
ursor to the value of the one whole measure in the key signature and return

the number of rests inserted

� GetNote. Takes optional integer parameter n = 1 . . . , returns LilyPond representation of the nth note of the 
hord at

the 
ursor 
ounting from the lowest, or #f if none

� GetNoteFromTop. Takes optional integer parameter n = 1 . . . , returns LilyPond representation of the nth note of the


hord at the 
ursor 
ounting from the highest, or #f if none
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� GetNoteFromTopAsMidi. Takes optional integer parameter n = 1 . . . , returns MIDI key for the nth note of the 
hord

at the 
ursor 
ounting from the highest, or #f if none

� GetNotes. Returns a spa
e separated string of LilyPond notes for the 
hord at the 
ursor position or #f if none

� GetNoteAtCursor. Returns LilyPond note at the 
ursor position or #f if none

� GetDots. Returns the number of dots on the note at the 
ursor, or #f if no note

� GetNoteBaseDuration. Returns the base duration of the note at the 
ursor number=0, 1, 2 for whole half quarter note

et
, or #f if none

� GetNoteDuration. Returns the duration in LilyPond syntax of the note at the 
ursor, or #f if none

� GetOnsetTime. Returns start time for the obje
t at the 
ursor, or #f if it has not been 
al
ulated

� SetDurationInTi
ks. Takes an integer, Sets the number of ti
ks (PPQN) for the obje
t at the 
ursor, returns #f if none;

if the obje
t is a 
hord it is set undotted

� GetRe
ordedMidiTempo. Takes an index, returns the time in se
onds, time signature and tempo in se
onds per quarter

note of the index'th MIDI tempo event in the re
orded MIDI stream.

� GetImportedMidiTra
k. Takes an tra
k number 1,2 . . . , makes that MIDI tra
k of the loaded MIDI stream the 
urrent

re
orded tra
k.

� DeleteImportedMidi. Delete the 
urrent imported/re
orded MIDI tra
k fails if playing, returning #f.

� GetCurrentMidiTra
k. Returns the MIDI tra
k number of the 
urrent imported tra
k.

� GetImportedMidiTra
ks. Returns the number of MIDI tra
ks of the loaded/re
orded MIDI.

� GetRe
ordedMidiDuration. Returns the duration in se
onds of the re
orded MIDI tra
k or #f if none

� GetDurationInTi
ks. Returns the number of ti
ks (PPQN) for the obje
t at the 
ursor, or #f if none

� GetBaseDurationInTi
ks. Returns the number of ti
ks (PPQN) for the 
hord without dots or tuplet e�e
ts at the 
ursor,

or #f if not a 
hord. The value is -ve for spe
ial durations (i. e. non-standard notes)

� GetEndTi
k. Returns the ti
k 
ount (PPQN) for the end of the obje
t at the 
ursor, or #f if none

� GetStartTi
k. Returns the ti
k 
ount (PPQN) for the start of the obje
t at the 
ursor, or #f if none

� GetMeasureNumber. Returns the measure number at 
ursor position.

� CursorToNote. Takes LilyPond note name string. Moves the 
ursor to the line or spa
e

� CursorToNthNoteHeight. Takes a number 1 . . . n. Moves the 
ursor to the nth note from the bottom of the 
hord at

the 
ursor, returning #f if it fails.

� CursorToNextNoteHeight. Moves the 
ursor up to the next higher note of the 
hord at the 
ursor, returning #f if it

fails.

� GetPrevailingKeysig. Returns the prevailing key signature at the 
ursor

� GetPrevailingTimesig. Returns the prevailing time signature at the 
ursor

� GetPrevailingClef. Returns the prevailing 
lef at the 
ursor. Note that non-builtin 
lefs like drum are not handled yet.

� GetPrevailingClefAsLilyPond. Returns the LilyPond typesetting syntax for prevailing 
lef at the 
ursor.

� GetPrevailingKeysigAsLilyPond. Returns the LilyPond typesetting syntax for prevailing key signature at the 
ursor.

� GetPrevailingTimesigAsLilyPond. Returns the LilyPond typesetting syntax for prevailing time signature at the 
ursor.

� GetPrevailingDuration. Returns the prevailing duration, ie duration whi
h will be used for the next inserted note, with

a parameter 0 . . . 8 sets the prevailing duration.

� In
rementInitialKeysig. Makes the initial keysig sharper/�atter

� In
rementKeysig. Makes the keysig sharper/�atter, a�e
ts keysig 
hange when 
ursor is on one or appending after one,

otherwise a�e
ts initial keysig

� AddMovement. Appends a new movement without 
opying sta� stru
ture.
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� ChangeChordNotes. Takes a string of LilyPond note names. Repla
es the notes of the 
hord at the 
ursor with these

notes, preserving other attributes

� PutNoteName. Takes a LilyPond note name, and 
hanges the note at the 
ursor to that note

� SetA

idental. Takes a LilyPond note name, 
hanges the note at the 
ursor to have the a

idental passed in either

LilyPond string or integer -2..+2. Returns #f if 
ursor is not on a note position.

� PutRest. Inserts a rest at the 
ursor; either passed in duration or if none passed the prevailing duration.

� PutNote. Inserts a note at the 
ursor; either passed in duration or if none passed the prevailing duration.

� InsertNoteInChord. Takes a LilyPond note name, and adds that note to the 
hord

� Diatoni
Shift. Moves the note at the 
ursor by the number of diatoni
 steps passed in

� NextObje
t. Moves the 
ursor to the right returning #t if this was possible

� PrevObje
t. Moves the 
ursor to the left returning #t if the 
ursor moved

� NextObje
tInMeasure. Moves the 
ursor to the next obje
t in the 
urrent measure, returning #f if there were no more

obje
ts to the left in the 
urrent measure

� PrevObje
tInMeasure. Moves the 
ursor to the previous obje
t in the 
urrent measure, returning #f if the 
ursor was

on the �rst obje
t

� NextSele
tedObje
t. Moves the 
ursor to the next obje
t in the sele
tion. Returns #t if the 
ursor moved

� PrevSele
tedObje
t. Moves the 
ursor to the previous obje
t in the sele
tion. Returns #t if the 
ursor moved

� NextChord. Moves the 
ursor the the next obje
t of type CHORD in the 
urrent sta�. Returns #f if the 
ursor did not

move

� PrevChord. Moves the 
ursor the the previous obje
t of type CHORD in the 
urrent sta�. Returns #f if the 
ursor did

not move

� NextChordInMeasure. Moves the 
ursor the the next obje
t of type CHORD in the 
urrent measure. Returns #f if the


ursor did not move

� PrevChordInMeasure. Moves the 
ursor the the previous obje
t of type CHORD in the 
urrent measure. Returns #f if

the 
ursor did not move

� NextNote. Moves the 
ursor the next obje
t of type CHORD whi
h is not a rest in the 
urrent sta�. Returns #f if the


ursor did not move

� PrevNote. Moves the 
ursor the previous obje
t of type CHORD whi
h is not a rest in the 
urrent sta�. Returns #f if

the 
ursor did not move

� CreateSnippetFromObje
t. Creates a musi
 Snippet 
omprising the obje
t at the 
ursor Returns #f if not possible,

otherwise an identi�er for that snippet

� Sele
tSnippet. Sele
ts musi
 Snippet from passed id Returns #f if not possible

� InsertSnippet. Inserts musi
 Snippet from passed id Returns #f if not possible, a se
ond boolean parameter determines

if the snippet be
omes sele
ted.

� NextStandaloneDire
tive. Moves the 
ursor the next obje
t that is a Denemo Dire
tive in the 
urrent sta�. Returns #f

if the 
ursor did not move

� PrevStandaloneDire
tive. Moves the 
ursor the previous obje
t that is a Denemo Dire
tive in the 
urrent sta�. Returns

#f if the 
ursor did not move

� NextStandaloneDire
tiveInMeasure. Moves the 
ursor within the 
urrent measure to the next obje
t that is a Denemo

Dire
tive in the 
urrent sta�. Returns #f if the 
ursor did not move

� PrevStandaloneDire
tiveInMeasure. Moves the 
ursor within the 
urrent measure to the previous obje
t that is a

Denemo Dire
tive in the 
urrent sta�. Returns #f if the 
ursor did not move

� Chordize. Enfor
es the treatment of the note at the 
ursor as a 
hord in LilyPond

� SetPrefs. Takes xml representation of a preferen
e and adds it to the Denemo preferen
es

� GetBooleanPref. Takes string name of a boolean-valued preferen
e and returns the 
urrent value. Non-existent prefs

return #f, ensure that the preferen
e name is 
orre
t before using.
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� GetIntPref. Takes string name of an int-valued preferen
e and returns the 
urrent value. Non-existent prefs return #f

� GetStringPref. Takes string name of a string-valued preferen
e and returns the 
urrent value. Non-existent prefs return

#f

� Atta
hQuitCallba
k. Takes a s
ript as a string, whi
h will be stored. All the 
allba
ks are 
alled when the musi
al s
ore

is 
losed

� Deta
hQuitCallba
k. Removes a 
allba
k from the 
urrent musi
al s
ore

� GetInputSour
e. Returns DENEMO_INPUTMIDI, DENEMO_INPUTKEYBOARD, DENEMO_INPUTAUDIO de-

pending on the sour
e of input to Denemo.

� PopupMenu. Pops up a menu given by the list of pairs in the argument. Ea
h pair should be a label string and an

expression, the expression for the 
hosen label is returned. Alternatively the label string 
an be repla
ed by a pair of

strings, label . tooltip. The third syntax is just a list of string labels, the 
hosen string is returned.

� GetTargetInfo. Returns a list of the target type and grob (if a dire
tive). Target is set by 
li
king on the typeset version

of the s
ore at a link that LilyPond has inserted.

� GetNewTarget. Intera
tively sets a target (a 
li
k on a LilyPond link in the printview window) from the user

� GetNewPoint. Intera
tively sets a point in the printview window from the user

� GetReferen
ePoint. Intera
tively sets a referen
e point (a 
li
k on a point in the printview window) from the user

showing a 
ross hairs prompt

� GetO�set. Intera
tively gets an o�set from the user in the print view window. The o�set is from the last 
li
ked obje
t

in the print view window. Returns pair of numbers x is positive to the right, y is positive upwards.

� GetControlPoint. Intera
tively sets a 
ontrol point for a 
urve in the print view window. Takes one parameter the

number 1�4 of the 
ontrol point to set.

� GetCurve. Intera
tively gets a 
urve from the user in the print view window. Returns a list of pairs of numbers, the


ontrol points of the 
urve.

� GetPositions. Intera
tively gets two positions from the user in the print view window. Returns pair of pairs numbers.

� HTTP. Takes 4 parameters and makes http transa
tion with www.denemo.org

� GoToPosition. Move to given Movement, voi
e measure and obje
t position. Takes 4 parameters integers starting from

1, use #f for no 
hange. Returns #f if it fails

� CreatePaletteButton. Takes a palette name, label, tooltip and s
ript

� SetPaletteShape. Takes a palette name, boolean, and limit

� ShowPalettes. Hides/Un-hides a palette. Pass a palette name (or #t to 
hoose a palette) with se
ond parameter #f

hides the palette otherwise show.

� Sele
tPalette. Returns the 
urrent palette name. The palette status is not 
hanged � it may be hidden. Pass a palette

name to be
ome the 
urrent palette or pass #t to 
hoose a palette as the 
urrent palette.

� A
tivatePaletteButton. Allows the user to type a label to a
tivate a palette button.

� GetUserInput. Takes up to three strings, title, prompt and initial value. Shows these to the user and returns the user's

string. Fourth parameter makes the dialog not blo
k waiting for input

� GetUserInputWithSnippets. Takes up to three strings, title, prompt and initial value. Shows these to the user with

a text editor for the user to return a string. Buttons are present to insert snippets whi
h are bra
keted with se
tion


hara
ters. Fourth parameter makes the dialog not blo
k waiting for input. Returns a pair 
omprising the user's text

and formatted LilyPond syntax.

� Sele
tFont. Allows the user to sele
t a font returns a string des
ribing the font. Takes an optional title.

� Sele
tColor. Allows the user to sele
t a 
olor returns a list of r g b values between 0-255.\nTakes an optional title.

� WarningDialog. Takes a message as a string. Pops up the message for the user to take note of as a warning

� InfoDialog. Takes a message as a string and boolean noblo
k parameter. Pops up the message for the user to take note

of as a informative message, blo
ks if noblo
k is #f

� ProgressBar. Takes a message as a string. Pops up the message inside of a pulsing progressbar

67



� ProgressBarStop. If running, Stops the ProgressBar.

� TypesetForS
ript. Typesets the s
ore. Takes a s
ript whi
h will be 
alled when Refresh is performed on the typeset

window.

� PrintTypesetPDF. Prints from the PDF �le generated by TypesetForS
ript.

� GetChar. Inter
epts the next keypress and returns a string 
ontaining the 
hara
ter. Returns #f if keyboard inter
eption

was not possible.

� GetKeypress. Inter
epts the next keypress and returns a string 
ontaining the name of the keypress (the short
ut name).

Returns #f if keyboard inter
eption was not possible.

� GetCommandKeypress. Returns the last keypress that su

essfully invoked a 
ommand

� GetCommand. Inter
epts the next keypress and returns the name of the 
ommand invoked, before invoking the 
om-

mand. Returns #f if the keypress is not a short
ut for any 
ommand

� GetCommandFromUser. Inter
epts the next keyboard short
ut and returns the name of the 
ommand invoked, before

invoking the 
ommand. Returns #f if the keypress(es) are not a short
ut for any 
ommand

� Lo
kDire
tive. Lo
ks the standalone dire
tive at the 
ursor so that it runs its delete a
tion when deleted. The tag

should be the name of a 
ommand that responds to the delete parameter.

� SetDire
tiveTagA
tionS
ript. Sets an \"a
tion s
ript\" on the dire
tive of the given tag

� PutStandaloneDire
tive. Inserts a Denemo Dire
tive of the given tag, even if one already exists at the 
ursor, a pixel

width 
an be passed as well

� Dire
tiveChangeTag. Changes the tag of the Denemo Dire
tive at the 
ursor

� Dire
tiveTextEdit-standalone. Start a low-level edit of the standalone dire
tive at the 
ursor

� PutTextClipboard. The passed string is pla
ed on the system 
lipboard

� GetUserName. Asks the user for a user name whi
h is returned

� GetPassword. Asks the user for a password whi
h is returned

� GetKeyboardState. Returns an integer value, a set of bit�elds representing the keyboard state, e. g. GDK_SHIFT_MASK

et


� SetMidiThru. Routes the MIDI in to MIDI out if it is not inter
epted by d-GetMidi

� GetRe
ordedMidiOnTi
k. Returns the ti
ks of the next event on the re
orded MIDI tra
k -ve if it is a NOTEOFF or

#f if none. Advan
es to the next note.

� GetNoteForMidiKey. Returns the LilyPond representation of the passed MIDI key number, using the 
urrent enharmoni


set.

� GetRe
ordedMidiNote. Returns the ti
ks of the next event on the re
orded MIDI tra
k -ve if it is a NOTEOFF or #f

if none

� RewindRe
ordedMidi. Rewinds the re
orded MIDI tra
k returns #f if no MIDI tra
k re
orded

� GetMidi. Inter
epts a MIDI event and returns it as a 4 byte number

� SetMidiCapture. Takes one bool parameter � MIDI events will be 
aptured/not 
aptured depending on the value passed

in, returns previous value.

� TogglePlayAlong. Swit
hes to playalong playba
k. When playing or re
ording playba
k will not advan
e beyond the


ursor position unless then mouse is moved or the next note is played in via MIDI in.

� ToggleCondu
t. Swit
hes to mouse 
ondu
ting playba
k. Playba
k will not advan
e beyond the 
ursor position unless

then mouse is moved in the drawing area.

� MidiRe
ord. Starts playba
k and syn
hronously re
ords from MIDI in. any s
ript passed in is run at the end of the

re
ording. The re
ording will play ba
k with future play until deleted. The re
ording is not saved with the s
ore �


onvert to notation �rst,

� ComputeMidiNoteDurations. Computes durationss for re
orded/imported MIDI notes based on tempo and timing of

note o� from previous note o� or start.

� GetMarkedMidiNote. Gets the marked re
orded midi note as LilyPond
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� GetMarkedMidiNoteSe
onds. Gets the time in se
onds of marked re
orded midi note or #f if none

� Advan
eMarkedMidi. Advan
es the marked re
orded midi note 
an take an integer for number of steps to advan
e, or

#f to 
lear the mark. Returns #f if no more marks.

� InsertMarkedMidiNote. Inserts the marked re
orded or imported MIDI note using the duration guessed from the note

length. Returns #f if nothing marked.

� CreateTimebase. Generates the MIDI timings for the musi
 of the 
urrent movement. Returns TRUE if the MIDI was

re-
omputed else FALSE (
all was unne
essary).

� PutMidi. Takes and int as MIDI data and simulates a midi event, avoiding 
apturing of midi by s
ripts. Value 0 is

spe
ial and is re
eived by s
ripts.

� OutputMidi. Takes and int as MIDI data and sends it dire
tly to the MIDI out ba
kend

� OutputMidiBytes. Takes a string of spa
e-separated bytes. The $ 
har stands for the 
urrent 
hannel. Sends the passed

bytes to the MIDI out

� PlayMidiKey. Depre
ated � takes an integer whi
h is de
omposed into a MIDI note played for 100ms

� PendingMidi. Takes a midi note key and plays it with next rhythm e�e
t

� PlayMidiNote. Takes midi key number, volume 0�255, duration in ms and 
hannel 0�15 and plays the note on midi out.

� OneShotTimer. Takes duration and exe
utable s
heme s
ript. Exe
utes the passed s
heme 
ode after the passed duration

millise
onds

� Timer. Takes a duration and s
heme s
ript, starts a timer that tries to exe
ute the s
ript after every duration ms. It

returns a timer id whi
h must be passed ba
k to destroy the timer

� KillTimer. Takes a timer id and destroys the timer

� HasFigures. Returns #f if the 
urrent sta� has no �gures (or will not print out �gured bass. See d-ShowFiguredBass)

� BassFigure. Returns a string for the bass �gure for the two MIDI keys passed in

� SpellChe
kMidiChord. returns #t if the passed list of MIDI keys fails the pit
h spell
he
k

� GetCursorNoteAsMidi. Gets the MIDI key number for the note-position where the 
ursor is

� GetNoteAsMidi. Returns the MIDI key number for the note at the 
ursor, or 0 if none

� RefreshDisplay. Re-draws the Denemo display, whi
h 
an have side e�e
ts on the data

� SetSaved. Sets the status of the 
urrent musi
al s
ore to saved, or unsaved if passed #f

� GetSaved. Gets the saved status of the 
urrent musi
al s
ore

� MarkStatus. Returns #f if mark is not set

� GetHelp. Takes a 
ommand name and returns the tooltip or #f if none

� LoadKeybindings. Takes a �le name, loads keybindings from a
tions/menus returns #f if it fails

� SaveKeybindings. Takes a �le name, saves keybindings from a
tions/menus returns #f if it fails

� ClearKeybindings. Clears all keybindings returns #t

� LoadCommandset. Takes a �le name for xml format 
ommandset, loads 
ommands, returns #f if it fails

� Zoom. Takes a double or string and s
ales the display; return #f for invalid value else the value set. With no parameter

returns the 
urrent value.

� MasterTempo. Takes a double or string and s
ales the tempo; returns the tempo set. With no parameter returns the


urrent master tempo

� MovementTempo. Takes an integer or string number of beats (quarter notes) per minute as the tempo for the 
urrent

movement; returns the tempo set

� MasterVolume. Takes a double or string and s
ales the volume; returns the volume set

� Sta�MasterVolume. Takes a double 0�1 and sets the sta� master volume for the 
urrent sta�, returns the value.\nWith

no parameter returns the 
urrent value or zero if sta� is muted.\nPass #f to mute the 
urrent sta� and #t to unmute,

leaving master volume un
hanged.
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� SetEnharmoni
Position. Takes a integer sets the enharmoni
 range to use 0 = E-�at to G-sharp

� GetMidiTuning. Return a string of tuning bytes (o�sets from 64) for MIDI tuning message

� GetFlattest. Return name of �attest degree of 
urrent temperament

� GetSharpest. Return name of sharpest degree of 
urrent temperament

� GetTemperament. Return name of 
urrent temperament

� RewindMidi. Rewind the MIDI generated for the 
urrent movement. Given a time in se
onds it tries to rewind to there.

� NextMidiNotes. Takes an interval, returns a pair, a list of the next note-on events that o

ur within that interval and

the time of these events.

� RestartPlay. Restart midi play, 
an
elling any pause

� GetMidiOnTime. Return a number, the midi time in se
onds for the start of the obje
t at the 
ursor; return #f if none

� GetMidiO�Time. Return a number, the midi time in se
onds for the end of the obje
t at the 
ursor; return #f if none

� MidiInListening. Set the MIDI in 
ontroller to listening mode. All signals are dire
ted straight to the output.

� MidiInChe
king. Set the MIDI in 
ontroller to 
he
king mode. The 
ursor will advan
e and the note sounded only if it

is the (lowest) note at the 
ursor.

� MidiInAppendEdit. Set the MIDI in 
ontroller to append/edit mode. The MIDI key sounded will be inserted in s
ore,

or appended if in appending position. MIDI signals 
an be �ltered by s
heme s
ripts in this mode.

� SetPlayba
kInterval. Set start and/or end time for playba
k to the passed numbers/strings in se
onds. Use #t if a value

is not to be 
hanged. Returns #f for bad parameters

� AdjustPlayba
kStart. Adjust start time for playba
k by passed number of se
onds. Returns #f for bad parameter

� AdjustPlayba
kEnd. Adjust end time for playba
k by passed number of se
onds. Returns #f for bad parameter

� UserS
reenshot. Takes a parameter #t or #f and optional position: Get a s
reenshot from the user and append or insert

it in a list (one per measure) either applying a
ross the sta�s or to the 
urrent sta�.

� DeleteS
reenshot. Takes a parameter #t or #f: Delete a s
reenshot for the 
urrent measure, either a
ross sta�s or for


urrent sta�.

� PushClipboard. Pushes the Denemo 
lipboard (
ut/
opy bu�er) onto a sta
k; Use d-PopClipboard to retrieve it.

� PopClipboard. Pops the Denemo 
lipboard (
ut/
opy bu�er) from a sta
k 
reated by d-PushClipboard. Returns #f if

nothing on sta
k, else #t.

� DeleteSele
tion. Deletes all obje
ts in the sele
tion Returns #f if no sele
tion else #t.

� SetThumbnailSele
tion. Sets the sele
tion to be used for a thumbnail. Returns #f if no sele
tion or sele
tion not in �rst

movement else #t.

� CreateThumbnail. Creates a thumbnail for the 
urrent s
ore. With no argument it waits for the thumbnail to 
omplete,

freezing any display. With #t it generates the thumbnail asyn
hrously. It does not report on 
ompletion.

� Exit. Exits Denemo without saving history, prefs et
.

� TakeSnapshot. Snapshots the 
urrent movement putting it in the undo queue returns #f if no snapshot was taken

be
ause of a guard

� Sele
tDefaultLayout. Creates the default layout.

� CreateLayout. Creates a 
ustom layout from the 
urrently sele
ted (standard). Uses the passed name for the new layout.

Returns #f if nothing happened.

� DeleteLayout. Deletes a 
ustom layout of the passed name. Returns #f if no layout with passed name.

� GetLayoutId. Returns the id of the 
urrently sele
ted s
ore layout (see View->S
ore Layout). Returns #f if no layout

is sele
ted.

� GetCurrentSta�LayoutId. Returns the id of a s
ore layout for typesetting the part for the 
urrent sta�. Returns #f if

not a primary voi
e.

� Sele
tLayoutId. Sele
ts the s
ore layout with the passed id. Returns #f if there is no su
h layout.
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� LilyPondForPart. Generates LilyPond layout for the 
urrent part (ie sta�s with the name of the sta� with the 
ursor),

all movements and sta�s with that sta� name are generated.

� TypesetPart. Typesets the 
urrent part (ie the sta� with the 
ursor), all movements and sta�s with that sta� name are

typeset.

� Redu
eLayoutToLilyPond. Converts the 
urrent s
ore layout to editable LilyPond text. After this the s
ore layout is

only a�e
ted by editing the LilyPond syntax.

� GetLayoutName. Returns the name of the 
urrently sele
ted s
ore layout (see View->S
ore Layout). Returns #f if no

layout is sele
ted.

� Sele
tNextLayout. Sele
ts the next s
ore layout. If the 
urrent layout is the last, returns #f otherwise #t.

� Sele
tFirstLayout. Sele
ts the �rst s
ore layout.

� Sele
tNextCustomLayout. Sele
ts the next 
ustom s
ore layout. If the 
urrent layout is the last, returns #f otherwise

#t.

� Sele
tFirstCustomLayout. Sele
ts the �rst 
ustom s
ore layout.

� GetFilename. Returns the full path to the 
urrently opened Denemo s
ore or #f if it does not have a disk �le yet.

� PathFromFilename. Returns the dire
tory 
omponent of the passed �lename.

� FileExists. Returns the #t if �le passed in exists.

� FilenameFromPath. Returns the �lename 
omponent of the passed path.

� ChooseFile. Gives dialog to 
hoose a �le. Takes a title, start dire
tory and list of extensions. Returns a string or #f if

user 
an
esl

� OpenSour
e. Follows a link to a sour
e �le of form string \"�lename:x:y:page\". It opens the �le and pla
es a marker

there.

� EditGraphi
s. Takes an optional �lename and optional new name. Opens an en
apsulated posts
ript �le for editing.

Returns the �lename (without extension) if su

essful.\nStarts the graphi
s editor on the passed in �lename or one from

a dialog.\nThe returned .eps �le may not exist when this pro
edure returns, an editor is open on it. With no �lename

parameter allows the user to 
hoose,\n
opying to the proje
t dire
tory or the users graphi
s templates (if a new name

is given)

� OpenProofReadFile. Opens a PDF �le previously generated by Denemo whi
h has proof reading annotations. The notes

in the �le 
an be 
li
ked on to lo
ate the musi
 in the Denemo display

� ExportRe
ordedAudio. Converts the re
orded audio to user 
hosen audio �le.

� OpenSour
eFile. Opens a sour
e �le for trans
ribing from. Links to this sour
e �le 
an be pla
ed by shift-
li
king on

its 
ontents

� OpenSour
eAudioFile. Opens a sour
e audio �le for trans
ribing from. Returns the number of se
onds of audio su

ess-

fully opened or #f if failed.

� CloseSour
eAudio. Closes a sour
e audio atta
hed to the 
urrent movement.

� StartAudioPlay. Plays audio allowing timings to be entered via keypresses if passed #t as parameter.

� StopAudioPlay. Stops audio playba
k

� SetAudioLeadIn. Takes a number of se
onds to be used as lead-in for audio. If negative 
lips that mu
h from the start

of the audio.

� AudioIsPlaying. returns #f if audio is not playing else #t

� NextAudioTiming. Returns the next in the list of timings registered by the user during audio play.

� In
reaseGuard. Stop 
olle
ting undo information. Call De
reaseGuard when �nished. Returns #f if already guarded,

#t if this 
all is stopping the undo 
olle
tion

� De
reaseGuard. Drop one guard against 
olle
ting undo information. Returns #t if there are no more guards \n(undo

information will be 
olle
ted) \nor #f if there are still guards in pla
e.

� Undo. Undoes the a
tions performed by the s
ript so far, starts another undo stage for the subsequent a
tions of the

s
ript. Note this 
ommand has the same name as the built-in Undo 
ommand, to override it when 
alled from a s
ript.

Returns #t
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� NewWindow. Creates a new tab. Note this 
ommand has the same name as the built-in NewWindow 
ommand, to

override it when 
alled from a s
ript. Returns #t

� StageForUndo. Undo normally undoes all the a
tions performed by a s
ript. This puts a stage at the point in a s
ript

where it is 
alled, so that a user-invoked undo will stop at this point, 
ontinuing when a further undo is invoked. Returns

#t

� GetLastChange. return a string giving the latest step available for Undo

� GetMenuPath. Takes a 
ommand name and returns the menu path to that 
ommand or #f if none

� GetChe
ksum. Takes a string and returns a string representing an MD5 
he
ksum for the passed string.

� SetNewbie. Sets the newbie status to the passed value

� GetVerse. Gets the 
urrent verse of the 
urrent sta� or #f if none, with an integer parameter, gets the nth verse

� Syn
hronizeLyri
Cursor. Moves the lyri
 
ursor to mat
h the 
urrent Denemo Cursor position, swit
hing the keyboard

input to the lyri
s pane

� InsertTextInVerse. Inserts passed text at the lyri
 
ursor in the lyri
s pane, returns #f if no verse at 
ursor

� PutVerse. Puts the passed string as the 
urrent verse of the 
urrent sta�

� AppendToVerse. Appends the passed string to the 
urrent verse of the 
urrent sta�

� GetId. Takes a 
ommand name and returns and id for it or #f if no 
ommand of that name exists

� AddKeybinding. Takes a 
ommand name or 
ommand id and binding name and sets that binding on that 
ommand

returns the 
ommand id that previously had the binding or #f if none

� GetLabel. Takes a 
ommand name and returns the label for the menu item that exe
utes the 
ommand or #f if none

� GetMenuPosition. Takes a non-built-in 
ommand name and returns position in the menu system for he 
ommand or #f

if none

� GetLilyVersion. Returns the installed LilyPond version

� Che
kLilyVersion. Returns a boolean if the installed version of LilyPond is greater than or equal to the passed in version

string

� InputFilterNames. Takes a string putting it on the s
heme-
ontrolled status bar as a list of a
tive �lters

� WriteStatus. Takes a string putting the s
heme 
ontrolled status bar; with no argument it hides this status bar

� Debug. Display a debug message

� Info. Display an info message

� Message. Display a regular message

� Warning. Display a warning message

� Criti
al. Display a 
riti
al message

� Error. Display an error message and abort

29.9 Commands for MIDI Import

A MIDI �le 
an be loaded into Denemo in order to 
onvert it to musi
 notation. This is not generally possible (be
ause of

the nature of the information stored in the MIDI format), but it is worth trying sometimes.

� (d-ImportMidi "guided=true") this 
all lets the user 
hoose a MIDI �le and 
reates a MIDI stru
ture to represent its


ontents.

� (d-GetImportedMidiTra
ks) returns the number of MIDI tra
ks that have been loaded or #f if none

� (d-GetImportedMidiTra
k n) gets the n'th MIDI tra
k loads a MIDI tra
k 
hosen by the user, using the Clef, Time signa-

ture and key signature of the 
urrent sta�. The tra
k is represented by . . . the C routine 
ompute_midi_note_durations()

is 
alled

� (d-CreateCli
kSta�ForMidi)
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29.10 . . . and More

This is a hand-made list most of whi
h already appear in the 
omprehensive list above, but with hand-written 
omments.

� d-PutNoteName takes a string argument, a note in LilyPond notation. Changes the note at the 
ursor. Not for use with

multi-note 
hords.F

� d-NextObje
t moves 
ursor to next obje
t, returning TRUE if 
urrent obje
t has 
hanged

� d-NextChord as d-NextObje
t, but skipping non-
hord obje
ts. 
hords in
ludes rests and 
hords with 1 or more notes.

� d-NextNote as d-NextChord but skipping rests (i. e. 
hords with 0 notes).

� d-NextStandaloneDire
tive as NextObje
t, stopping on a standalone dire
tive. Using d-Dire
tiveGet-standalone tag a

dire
tive of a parti
ular tag 
an be found.

� (d-Dire
tive-type? optional-tag) where type is one of s
ore, s
oreheader, movement
ontrol, header, paper, layout, 
lef,

timesig, keysig, sta�, voi
e, standalone, 
hord or note.This returns #t if the 
ursor is on a dire
tive of type (with tag

optional-tag if optional-tag is present) else #fGef

� (d-Dire
tivePut-standalone tag) inserts a standalone dire
tive with the given tag at the 
urrent 
ursor position and

pla
es the 
ursor on it.

� (d-Dire
tiveGetTag-type) where type is one of s
ore, s
oreheader, movement
ontrol, header, paper, layout, 
lef, timesig,

keysig, sta�, voi
e, standalone, 
hord or note. This returns the tag if the 
ursor is on a dire
tive of type else #f

� (d-Dire
tiveGetTagForTag-type tag) returns the tag passed in if the 
ursor is on dire
tive of type with that tag, else it

returns the tag of the �rst dire
tive of type that is present at the 
ursor, else #f

� d-WarningDialog Pass a string argument to pop up a warning.

� d-GetOption (parameter string of options). Takes a null separated set of options and pops up a dialog o�ering them to

the user. Returns the one 
hosen or #f if the user 
an
els.

� d-GetMidi

� d-PutMidi

� d-PlayMidiKey

� d-BassFigure

� d-GetNoteAsMidi

� d-RefreshDisplay

� d-InputFilterNames sets the status bar

� d-Chordize Ensure that even a single note is treated as a 
hord � needed for some LilyPond 
onstru
ts (e. g. �ngerings)

Standard Denemo 
ommands that pop up dialogs will work as usual if no argument is passed to them from S
heme. In general

if a string 
onsisting of strings of the form "name=value" is passed these will be used and no popup will o

ur. The �eld

"name" will be given the value "value". The \0 is a NULL 
hara
ter that separates the assignment strings. As a shorthand if

there is only one value being passed you 
an just pass the value. The names of the �elds depend on the a
tion being 
alled.

So for example:

(d-Open "filename=myfile.denemo")

will open the �le "my�le.denemo".

This feature is being rolled out, and 
urrently works for:

� d-InsertLilyDire
tive (dire
tive, display. minpixels) (depre
ated fun
tion)

� d-Atta
hLilyToChord (pre�x, post�x, display) depre
ated see d-Dire
tiveGet-
hord-* and d-Dire
tivePut-
hord-* below

� d-Atta
hLilyToNote (pre�x, post�x, display) depre
ated see d-Dire
tiveGet-note* and Put below

� d-Sta�Properties understands a 
ouple of property=value settings

� d-InitialClef

� d-InsertClef

73



� d-InitialKey

� d-InsertKey

� d-Open �lename

� d-S
oreProperties (fontsize= size of font to be used for s
ore)

� GetMeasureTi
ks

� MeasureFillStatus

29.11 Midi Filters

The MIDI �lters are s
heme s
ripts, so they 
an be tailored to do whatever you wish. One example is a �lter that enables you

to enter Figured Bass �gures by playing the notes 
orresponding to the �gures while holding down the bass note. Another is

the "AngryDelete" �lter. With this �lter on notes are entered normally with the 
ursor advan
ing automati
ally, but if you

make a mistake and press the wrong note just hit the next one mu
h louder and it will make the 
orre
tion for you! MIDI

�lters are found under Input -> MIDI.

29.12 LilyPond Editing

Introdu
tion From version 0.7.8 we have the ability to edit the LilyPond output within Denemo. This approa
h immediately

makes Denemo able to do many more things (e. g. multiple verses for songs) with the musi
 still editable from within Denemo.

The gallery of examples and the standard templates 
ontain examples whi
h you 
an use.

These 
an be used without knowing the LilyPond language (provided a suitable template or example �le exists). Alter-

natively, with a general idea of how a LilyPond �le works tweaks from the LilyPond do
umentation 
an be inserted into the

LilyPond output and stored with the Denemo, leaving open the possibility of further editing of the notes within Denemo

without the need to re-apply tweaks or keep separate LilyPond �les.

29.12.1 Using the LilyPond Window

Under the View menu is a Show LilyPond item whi
h pops up a window with the LilyPond output in it. The text is interspersed

with buttons whi
h enable you to hide or show the various se
tions or to 
reate 
ustom versions. The text in bold 
an be

altered and the alterations are kept in the Denemo �le.

The two windows are kept in syn
, so you 
an move ba
k and forth between editing textually and editing in Denemo.

Right 
li
king on the text gives a menu for a
tions on the LilyPond text. LilyPond text 
an be inserted between notes,

and the �nal se
tion (the s
ore layout) 
an be turned into editable text (see S
ore Layout). There is one for moving the 
ursor

to the LilyPond text for the 
urrent Denemo obje
t. Moving the 
ursor in the text window with the arrow keys 
auses the

Denemo window 
ursor to move in syn
hronism.

This menu also in
ludes a Print 
ommand that operates on the visible LilyPond text in the window. This means you 
an

open spe
i�
 
ustom s
ore layouts and print from them, or even make a temporary edit for just one print. If you save the

s
ore with 
ustom layouts then these are remembered. So when you reload and the 
ustom s
ore layout will be printed.

Detail Several 
ustom layouts 
an be kept, sele
ting them in the S
ore Layout view enables the same Denemo �le to print

a variety of things from the same musi
 input.

For example, a full s
ore or a set of parts, or several voi
es on group of sta�s or even a piano redu
tion.

The various Voi
es/Sta�s for the di�erent Movements are separated by buttons. These are labelled by enumerating the

movements and sta�s in order, so the �rst voi
e in the �rst movement has the musi
 de�ned as "MvmntIVoi
eIMusi
" and

so on. Within these musi
 blo
ks you 
an insert arbitrary LilyPond text between notes, (the insertion points are marked by

grey blo
ks) and the text inserted will appear as a LilyPond dire
tives in the main Denemo window.

The main Denemo window also moves its 
ursor to 
orrespond with where you are editing. (It should of 
ourse move the


ursor immediately you 
li
k on a point in the musi
, but, as yet, it only moves the 
ursor when you press a key just before

the note name � one of the arrow keys will do).

Custom layout blo
ks 
an be 
reated by right-
li
king on the Standard s
ore layout and sele
ting 
reate 
ustom s
ore layout.

The S
ore Layout window allows 
reation of 
ustomized layouts via a GUI. If you print a single part from all movements, you

get the standard s
oreblo
k for this and 
an add it to your 
ustom s
ore blo
k so that a single print 
ommand prints, e. g.

both a full s
ore and parts. Using the \book {} blo
k you 
an put these into separate �les (stored in the folder .denemo in

your home folder).

The musi
 de�ned by MvmntIVoi
eIMusi
 is then used in the s
ore blo
ks at the end of the LilyPond window, by the

expression \MvmntIVoi
eIMusi
. This means that the same musi
 
an be output in several di�erent ways, so that the same

Denemo �le 
an 
ontain 
ustom s
ore blo
ks to output the musi
 as a Piano S
ore with several voi
es or separate parts, for

example.

The de�nitions for MvmntIVoi
eIMusi
 a
tually look like this:

� MvmntIVoi
eIProlog = {\MvmntIVoi
eITimeSig \MvmntIVoi
eIKeySig \MvmntIVoi
eIClef}
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� MvmntIVoi
eIMusi
 = {\MvmntIVoi
eIProlog \MvmntIVoi
eI}

Where \MvmntIVoi
eI is the a
tual blo
k of notes you have written, while the other de�nitions hold the time signature, 
lef

et
. By using these, you 
an print the same musi
 with di�erent 
lefs, still maintaining the ability to edit the notes in Denemo.

Note that the normal Denemo Print 
ommands are still operate as they do if you never look at the LilyPond window.

What happens is that if you sele
t the Print Current Part menu item then this 
reates a tailored standard s
oreblo
k for that

part. However, if you use the File->Print 
ommand then it prints the �rst 
ustom s
oreblo
k that is open (visible) (or the

standard s
oreblo
k if you do not have any 
ustom s
oreblo
ks).

Cli
king (as opposed to using the arrow keys) in the LilyPond text does not move the 
ursor in the Denemo window. When

you delete a LilyPond dire
tive textually you have to move the 
ursor to start re-inserting it.

29.13 Musi
al S
ores that Do Things!

By saving a Denemo s
ore with a s
ript de�ned (in the s
ript window) you 
an 
reate musi
 lessons, automati
 midi player

. . . the possibilities are endless. When you open su
h a s
ore, the s
ript is run � it 
an take user input and manipulate the

s
ore, or do other a
tions as your fan
y takes you.

There is a spe
ial s
ore init.denemo that is run on startup. By editing this you 
an startup with whatever template and

whatever a
tions you wish to be performed. If you set it to do something that quits Denemo, you may need to delete the

�le before using Denemo normally again. Your lo
al init.denemo is stored in the dire
tory .denemo/a
tions in your home

dire
tory.To 
reate it put the s
ript you want in the s
ript window and use SaveAs sele
ting ~/.denemo/a
tions/init.denemo

as your �le to save to.

29.13.1 What Happens at Startup

On starting the s
heme s
ript ~/.denemo-(version number)/a
tions/denemo.s
m is exe
uted (where ~ means your home

dire
tory and version number is 1.1.2 or later).

A denemo �le 
alled init.denemo is/was loaded, but this is depre
ated.

In addition, on startup a set of keyboard and mouse short
uts, and a sele
tion of optional menu items are loaded. Other

sets are available via the Edit->Customize Commands . . . ->Manage Command Set dialog.

29.14 Starting Denemo � Command Line Options

Denemo �help shows the options at startup. You 
an open a spe
i�
 s
ore, exe
ute a s
heme s
ript (from a �le or on the


ommand line) and more.

Part IV

Te
hni
al Referen
e � Denemo Dire
tives

30 Denemo Obje
ts

Denemo Obje
ts are all the things that are pla
ed in the measures of the sta�s in the Denemo Display. These are Chords,

Notes (single note 
hords), Rests, Clef Changes, Key Changes, Time Signature Changes, Voi
e Changes (stemming 
ontrol),

Tuplet Starts, Tuplet Ends and Denemo Dire
tives. The Denemo 
ursor 
an be stepped through every Denemo Obje
t in the

bar and by double 
li
king the obje
t 
an be inspe
ted and edited in detail.

31 Denemo Dire
tives

Denemo Dire
tives give attributes to obje
ts that are not built-in but 
an be 
hanged by the user.

Denemo Dire
tives 
an be atta
hed at almost every level of a Denemo s
ore and 
an modify the behavior of the element


on
erned. They 
ontain �elds to des
ribe how the element's properties should be modi�ed, either in the display or in the

printing. Elements, su
h as 
lefs notes et
 have their own built-in display and print properties; Denemo Dire
tives allow you

(or s
ripts you invoke) to modify them for many more purposes than the built-in set allows. This means Denemo 
an grow �

you 
an add features � without getting a new version.

For example the drum 
lef is not built-in to Denemo. Instead a dire
tive atta
hed to the 
lef has a �eld (graphi
) set to an

image of the drum 
lef, and another �eld (post�x) set to the LilyPond syntax for a drum 
lef, while another �eld (override)

is set to indi
ate that these values should repla
e the normal ones, rather than adding to them.

The elements that 
an be modi�ed in this way are the following:

s
ore: the LilyPond �elds (pre�x and post�x) are pla
ed at the start of the s
ore and just before ea
h movement. The

display �eld is shown at the top of the display.
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s
oreheader: Atta
hed to the s
ore. The post�x �eld is put inside a \header{} blo
k at the start of the s
ore.

movement
ontrol: Atta
hed to a movement. The pre�x �eld is pla
ed before the movements \s
ore{} blo
k, the post�x after

it.

header: Atta
hed to a movement. As s
oreheader but for \header{} blo
ks inside the movement's s
ore blo
k.

paper: Atta
hed to the s
ore. The post�x is pla
ed inside a \paper{} blo
k.

layout: Atta
hed to a movement. The post�x is pla
ed inside a \layout{} blo
k in the movement's s
oreblo
k.


lef: Atta
hed to a 
lef or 
lef 
hange. The graphi
 holds the displayed i
on, gx,gy its position. The post�x �eld is put

into the musi
 at the point where the 
lef is found, repla
ing the normal text if the override is set.

timesig: Atta
hed to a time signature or time signature 
hange. The graphi
 holds the displayed i
on, gx,gy its position.

The post�x �eld is put into the musi
 at the point where the time signature is found, repla
ing the normal text if

the override is set.

keysig: as timesig but for key signatures. (e. g. used to supress keysignatures in drum 
lef).

sta�: The post�x �eld modi�es the whole sta� 
ontext, with the display �eld printed at the start of the sta�

voi
e: The post�x �eld modi�es the voi
e 
ontext, with the display �eld printed at the start of the sta� 
ontaining the

voi
e

standalone: A dire
tive not atta
hed to an musi
 element � it 
omes with the musi
 and is used for things like repeat bars

et
.


hord: The pre�x �eld is emitted before the LilyPond for the 
hord and the post�x after it.

note: The pre�x �eld is emitted before the LilyPond for the note and the post�x after it. Examples are �ngerings

atta
hed to notes et
. Again the display and graphi
 �elds a pla
ed in the display positioned relative to the note

via the 
oordinate �elds gx, gy (for the graphi
) and tx, ty for the display text.

The Dire
tives are su�
iently important to have their own 
ommands.

d-Dire
tivePut-type-�eld where type is one of s
ore, s
oreheader, movement
ontrol, header, paper, layout, 
lef, timesig,

keysig, sta�, voi
e, standalone, 
hord or note and �eld is one of display, tx, ty, gx, gy, graphi
, pre�x, post�x, override,

midibytes. These 
ommands take two arguments, a tag (string) and a value to set. For example:

(d-Dire
tivePut-note-postfix "LHFinger" "3")

will put the �ngering 3 on (after) the note at the 
ursor.

d-Dire
tiveGet-type-�eld type is one of s
ore, s
oreheader, movement
ontrol, header, paper, layout, 
lef, timesig, keysig, sta�,

voi
e, standalone, 
hord or note and �eld is one of display, tx, ty, gx, gy, graphi
, pre�x, post�x, override, midibytes.

This fun
tion returns the value in the �eld or #f if there is no dire
tive with the given tag at the 
ursor.

d-Dire
tiveDelete-type type is one of s
ore, s
oreheader, movement
ontrol, header, paper, layout, 
lef, timesig, keysig, sta�,

voi
e, standalone, 
hord or note. This fun
tion returns #t or #f if a dire
tive with the given tag was deleted.

d-Dire
tive-type? returns true if a dire
tive with passed tag is present at 
ursor, with no tag argument returns true if any

su
h dire
tive is present

d-Dire
tiveGetForTag-type returns the tag for the dire
tive at the 
ursor of type

d-Dire
tiveGetNthTag-
hord index Gets the index'th tag of type at the 
ursor, index starts at 0.

31.1 The Dire
tive Fields

The �elds of the Denemo Dire
tive 
an 
ontrol the Denemo Display and the LilyPond output.

The �elds in d-Dire
tiveGet/Put have the following meanings:

post�x � A fragment of LilyPond to be output (after the LilyPond for any obje
t the dire
tive is atta
hed to).

pre�x � A fragment of LilyPond to be output (before the LilyPond for any obje
t the dire
tive is atta
hed to).

display � text to be shown in the Denemo Display

tx,ty � where to show the text in the Denemo Display
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graphi
 � For dire
tives that are in the musi
 this is a .png image to be shown in the Denemo Display (the dire
tory

bitmaps holds these). The graphi
 
an be saved for a 
ommand using the right-
li
k -> Save Graphi
 
ommand,

after sele
ting a portion of the print preview as the image required. For dire
tives atta
hed to the s
ore, movement

et
 the string set here will be displayed on the button in the button box for that sort of dire
tive (see Show S
ore

Titles et
 in view menu for showing this button box).

gx,gy � where to show thegraphi
 in the Denemo Display

minpixels � how mu
h spa
e to leave for this item in the Denemo Display

override � Contains bits to determine whether the LilyPond 
ontained in the Dire
tive (post�x and/or pre�x �elds) should

override the normal LilyPond output, and whether the Graphi
 should repla
e the normal Denemo display for

the item. A further tran
he of bits 
ontrols MIDI output for the dire
tive, whi
h 
an override the normal MIDI

interpretation of the musi
 and provide additional information not expli
it in the musi
 notation (e. g. the tempo

of an Adagio marking).

midibytes � a string of numbers (in hexade
imal format) whose interpretation is given by the MIDI bits in the override �eld

The override �eld 
ontains the following bits:

DENEMO_OVERRIDE_LILYPOND: override the LilyPond output normally used at this point, rather than adding to the

normal output. The text used is in the pre�x and post�x �elds.

DENEMO_OVERRIDE_GRAPHIC: overrides what Denemo would normally show in the display with the image named in

the graphi
 �eld of the dire
tive

The MIDI bits in the override �eld are as follows

DENEMO_OVERRIDE_VOLUME: the MIDI velo
ity to use

DENEMO_OVERRIDE_DURATION: a�e
ts the duration of a note. not yet implemented

DENEMO_OVERRIDE_REPEAT: indi
ates that an earlier passage should be repeated (from a dire
tive of the same tag).

not yet implemented

DENEMO_OVERRIDE_CHANNEL: midibytes �eld gives the MIDI 
hannel to use (? implemented?)

DENEMO_OVERRIDE_TEMPO: midibytes �eld gives the tempo to use.

The interpretation of these �ags is modi�ed by the following �ags:

DENEMO_OVERRIDE_ONCE: the value in midibytes is to be used just for the item the dire
tive is atta
hed to. not yet

implemented

DENEMO_OVERRIDE_STEP: the value in midibytes is to be used from this point on

DENEMO_OVERRIDE_RAMP: the value in midibytes is to be used as a starting value, a 
orresponding dire
tive (i. e. with

the same tag) gives the �ndal value, values are then interpolated between these. not yet implemented

DENEMO_OVERRIDE_RELATIVE: value in midibytes is used relative to the 
urrent value (otherwise it is an absolute

value; e. g. an absolute velo
ity et
)

DENEMO_OVERRIDE_PERCENT: value in midibytes is interpreted as per
entage value. not yet implemented

These �ags are 
ombined together to get the 
ombination required for the dire
tive using the s
heme pro
edure 
alled logior.

Here is an example, making a step-
hange in volume of 0x40 in the MIDI output, and printing "più mosso" in the output

s
ore

;;;;;;;;;; piu mosso

(d-Dire
tivePut-standalone-minpixels "StepTempo" 20)

(d-CursorLeft)

(d-Dire
tivePut-standalone-override "StepTempo" (logior DENEMO_OVERRIDE_TEMPO DENEMO_OVERRIDE_STEP DENEMO_OVERRIDE_RELATIVE))

(d-Dire
tivePut-standalone-midibytes "StepTempo" "40")

(d-Dire
tivePut-standalone-display "StepTempo" "piu mosso")

(d-Dire
tivePut-standalone-postfix "StepTempo" "^\\markup {\\bold \\itali
 \"più mosso\"}")

(d-RefreshDisplay)

In this example the dire
tive is a standalone dire
tive. MIDI 
ommands are being extended to apply to 
hords and notes.

Implementation of the 
ommands for Voi
es, Movements, S
ore et
 are not yet done.
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31.2 Dire
tive Edit S
ripts

Introdu
tion S
ore and movement dire
tives 
an de�ne a value for their graphi
 � a button then appears at the top of the

s
ore whi
h 
an be used to edit the dire
tive. Likewise Sta� and Voi
e dire
tives show as a properties i
on before the sta� to

whi
h they apply (sta� dire
tives above, voi
e dire
tives below). Cli
king on these lets you edit the dire
tive.

The 
ommand EditDire
tive 
an be used when the 
ursor is on a Denemo Dire
tive obje
t, or an obje
t with a Denemo

Dire
tive atta
hed to it. What happens then is determined by a s
ript named after the "tag", or name of the dire
tive. For

example the 
ommand RehearsalMark 
reates a Dire
tive with tag "RehearsalMark" and EditDire
tive runs a s
ript 
alled

RehearsalMark.s
m.

There is also a low-level editing dialog whi
h is invoked if no editing s
ript exists or dire
tly from s
heme using (d-

Dire
tiveTextEdit-* tagname). This allows you to edit and delete a dire
tive dire
tly. The other dire
tive editing 
ommands

are EditS
oreDire
tive EditMovementDire
tive EditSta�Dire
tive EditVoi
eDire
tive EditClefDire
tive EditKeysigDire
tive

EditTimesigDire
tive for dire
tives atta
hed to the relevant obje
ts.

The low level edit of dire
tives from s
heme uses the following 
ommand:

(d-Dire
tiveTextEdit-<field> <tagname>)

Where <tagname> spe
i�es the dire
tive to be edited and <�eld> is one of s
ore, s
oreheader, movement
ontrol, header,

paper, layout, 
lef, timesig, keysig, sta�, voi
e, standalone, 
hord or note.

For example,

(d-Dire
tiveTextEdit-paper "PrintAllHeaders")

gives low-level a

ess to the dire
tive setting the print all headers 
ommand in the paper blo
k of the LilyPond output.

31.2.1 Initialization S
ripts

Ea
h menu 
an have an initialization s
ript, whi
h 
an 
ontain pro
edures that would be too time 
onsuming to de�ne every

time they are needed. These s
ripts are guaranteed to be run before any menu item is a
tivated within the menu. They 
an

be read/written using the right 
li
k menu on any s
ripted menu item.

31.2.2 Edit S
ripts

Ea
h dire
tive has a tag �eld, so that it 
an be re
ognized by the s
ripts that manipulate it. In parti
ular for ea
h tag there


an be an edit s
ript, for editing a dire
tive of that tag.

Edit s
ripts are kept in a dire
tory a
tions/edits
ripts parallel with the dire
tory a
tions/menus where the 
ommands

themselves are kept.

You 
an read and write edit s
ripts by using the low level editing dialog on a dire
tive with the tag you are writing for.

The low level editing dialog is the one that is presented if there is no edit s
ript. Edit s
ripts 
an themselves give a

ess

to this dialog by in
luding an option 
ue-Advan
ed whi
h 
alls (d-Dire
tiveTextEdit-�eld tag) for the appropriate �eld and

tag. For an example see the edit s
ript for Instruments -> Or
hestra -> RehearsalMark.

They have available fun
tions to enable editing of dire
tives whi
h are de�ned in a
tions//denemo.s
m exe
uted at startup.

The fun
tions and variables for s
ript editing are:

� d-GetOption followed by a nul separated list of options, o�ers the options to the user and returns one, or #f if the user


an
els. More useful 
ommands RadioBoxMenu and RadioBoxMenuList are built on this for a ni
er interfa
e.

� Extra-O�set tag type 
ontext. Takes three string options: tag is the name of the dire
tive to be edited, whi
h must be

the name of a LilyPond obje
t, type is the type of dire
tive (note, 
hord, standalone, sta�, voi
e or s
ore), 
ontext is

the LilyPond 
ontext of the obje
t. Only tag is required. Shifts the obje
t in the LilyPond output.

� SetPadding tag type 
ontext. As Extra-O�set, it sets the spa
e left around the item in the LilyPond engraving pro
ess.

� SetRelativeFontSize tag type 
ontext. As Extra-O�set, it shifts the font size of the following text in the LilyPond

engraving pro
ess.

� CreateButton tag label this is just a 
onvenien
e fun
tion to put a button with the passed in label onto a button box at

the top of the s
reen. S
ripts 
an atta
h a
tions to su
h tagged buttons.

� d-SetDire
tiveTagA
tionS
ript tag s
heme-a
tions. This 
ommand sets s
heme-a
tions as the a
tions to be performed

when the button of the given tag is 
li
ked. The default a
tion is to run any edits
ript asso
iated with tag, and if none

to run the d-Dire
tiveTextEdit-s
ore on the dire
tive that displays the button.

� d-Dire
tiveGetForTag-�eld tag. Useful variables de�ned:

� (de�ne stop "\0")
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� (de�ne 
ue-Advan
ed "Advan
ed")

� (de�ne 
ue-Pla
eAbove "Pla
e above sta�")

� (de�ne 
ue-Pla
eBelow "Pla
e below sta�")

� (de�ne 
ue-SetRelativeFontSize "Set Relative Font Size")

� (de�ne 
ue-O�setPositionAll "O�set Position (All)")

� (de�ne 
ue-O�setPositionOne "O�set Position (One)")

� (de�ne 
ue-EditText "Edit Text")

� (de�ne 
ue-SetPadding "Set Padding")

� (de�ne 
ue-Delete "Delete")

Part V

Obtaining and Installing Denemo

Denemo is available from the Downloads page of the Denemo website http://denemo.org, where more up-to-date information

will be found. This is the preferred way of obtaining Denemo, as the various o�erings from elsewhere are often either broken

or out-of-date.

A Upgrading Denemo

If you already have a version of Denemo then installing a new version brings with it the question of retaining your preferen
es,

short
uts et
. These are stored in a dire
tory (�folder� in windows) in your home dire
tory that is named after the Denemo

version number. So for version number 2.0.0 the dire
tory is 
alled �.denemo-2.0.0�.

They are 
opied for you from the old dire
tory to the new one if you ask for this on startup. If you forget to do this

you 
an delete the new dire
tory .denemo-2.0.2 (say) and when you start Denemo it will again ask if you want to keep your

preferen
es from the earlier version.

B Obtaining the Sour
e

Denemo is available from a variety of sour
es for di�erent distributions. The latest stable release (tar.gz and .deb formats) is

available for download from http://denemo.org/downloads-page/. You 
an install Denemo from the Debian unstable repos-

itories, using the 
ommand apt-get install denemo. Builds for Ma
intosh are available from the Gnu-Darwin proje
t. The

Denemo development bran
h 
an be downloaded using anonymous CVS or Git.

Anonymous Git 
he
kout:

git 
lone git://git.savannah.gnu.org/denemo.git

Anonymous CVS 
he
kout:


vs -d:pserver:anonymous�pserver.git.sv.gnu.org:/denemo.git 
o -d denemo master

Dependen
ies To build Denemo from a sour
e pa
kage, pleas see the website for an up-to-date list of dependen
ies.

Remember to install the development pa
kages as well (
he
k your distribution for the spe
i�
 pa
kage name):

For Debian Users: Type apt-
a
he showsr
 denemo at a 
ommand line to determine what are the pa
kage names for Denemo

dependen
ies. Type apt-get build-dep denemo to build the dependent �les or use apt-get to install the pa
kages individually

by 
opying and pasting their names to the 
ommand line.

C Installing Denemo from Sour
e Code

Denemo is available in a variety of formats. The 
urrent stable release is available either as sour
e 
ode or in binary format.

The Development bran
h of Denemo is available as a GIT sour
e tree.
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C.1 To install from sour
e 
ode:

1. Open a terminal window.

2. Change dire
tory to the dire
tory to whi
h you downloaded the Denemo sour
e pa
kage.

3. Un
ompress the sour
e pa
kage using standard Linux tools (tar and gunzip).

4. Change dire
tory to the un
ompressed sour
e dire
tory.

C.2 Generating a Con�gure S
ript

Git does not 
ome with a Con�gure s
ript; generate one by typing and pressing Enter after the line:

./autogen.sh

To build from sour
e, press Enter after ea
h line:

./
onfigure

make

make install

If you are not logged in as root user, for the last step type su and your root password, or alternately type sudo make install.
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Seek, 28, 56

Sele
tion, 8

Slurs, 14, 24, 45

Sour
e View, 53

Spanning, 14, 48, 56

Sta�, 1, 13
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81



Whole Measure Rest, 15

WYSIWYG, 24

82


	I Getting Started
	Input Methods
	Some Common Keyboard Shortcuts
	Some Common Mouse Shortcuts
	Some Common Uses of MIDI in
	Note and Rest Entry Palettes


	II Using Denemo
	General Concepts
	Denemo Main Window
	The Denemo Display 
	The Page View
	Transition Animation

	The Main Menubar
	File
	Navigation
	Edit
	View
	Input
	More
	Playback
	Educational
	Help

	Toolbar
	Playback Controls
	Midi In Controls 
	Object Menus
	Score Menu
	Movements Menu
	Staff/Voices Menu
	Clefs Menu
	Keys Menu
	Time Signatures Menus Menu
	Measures Menu Menu
	Chords Menu
	Notes/Rests Menu
	Directives Menu 
	Lyrics Menu 
	Notation Magick Menu


	Palettes
	Articulations Palette
	Barlines Palette
	Beaming Palette
	Chord Symbols Palette
	Insert or Append Chords Palette
	Custom Ornaments Palette
	Dynamics Palette
	Figured Bass Palette
	MIDI Import Palette
	Ornaments Palette
	Piano/Organ Notation Palette
	Polyphony Palette
	Repeats Palette
	Stringed Instruments Palette
	Tied Notes/Chords Palette

	The Command Center
	Music Snippets
	Overview
	Details

	The Print View Window
	The Buttons
	Mouse Controls
	Editing in the Print View – WYSIWYG
	Editing Positions and Padding
	Re-shaping Slurs and Ties
	Adding Line or Page Breaks.


	The LilyPond View
	The Playback View
	Introduction
	MIDI Playback.
	Scrolling
	Simple Scrolling Control
	Scroll Points


	The Object Inspector
	The Object Editor
	Editing Objects and their properties.
	Seeking, Editing and Conditionals
	Making the Directive Conditional
	Making a Copy of the Directive
	Creating Palette Buttons for Objects and Properties.


	The Score and Movement Properties Editor
	The Staff and Voice Properties Editor
	Omission Criteria
	The Score Layouts Window
	Preferences Dialog
	The View Tab
	The Command Tab
	The Externals Tab
	The Auto-Typeset Tab
	The Miscellaneous Tab
	The Audio Tab
	The MIDI tab

	Score and Movement Button Bars
	Style, Layout, Titling
	Simple Titles
	Book Titles

	Lyrics
	Overview of Lyrics
	Special Syntax for Lyric Verses


	Musical Elements – everything on and around the notes.
	Beaming
	Barlines
	Ties and Slurs
	Triplets and Friends
	Grace Notes
	Ornaments
	Dynamics
	Tempo Markings
	Text
	Simple Text
	Multi-line Text and Music
	Text Spanning 
	Rehearsal Marks

	

	A Survey of the Input Methods
	Introduction
	Playing Notes into Denemo – MIDI
	The Numeric Keypad

	Using an On-screen Piano Keyboard
	Using the Denemo From the PC keyboard
	Note Entry
	Chord Entry
	Editing Music

	Playing Notes into Denemo – Audio (Soundcard Mic Input)

	Transcribing from Facsimile or Hand-written Score
	Comparing Scores
	Creating an Index
	Using a Proof-Read PDF
	Score Setup
	Using Templates to Setup Scores

	More Features
	Transposition
	Physical Transposition

	Search and ``Replace''
	Rapidly Marking Passages
	Piano Staffs, Orchestral Scores etc
	Single Staff Polyphony
	Entering Figured Bass
	Fret Diagrams
	Tablature
	Entering Chord Symbols


	III Advanced Topics
	Customizing Denemo
	Adding and Editing Key/Mouse Shortcuts
	More Commands
	Recording a Denemo Macro 
	Editing a LilyPond Tweak


	Writing Scheme Scripts 
	Commands Getting User Input
	Commands Getting Information about Object at Cursor
	Predicates
	Iterators
	Directives
	Message Bar
	Move and Search
	More …
	Commands for MIDI Import
	… and More
	Midi Filters
	LilyPond Editing
	Using the LilyPond Window

	Musical Scores that Do Things!
	What Happens at Startup

	Starting Denemo – Command Line Options


	IV Technical Reference – Denemo Directives
	Denemo Objects
	Denemo Directives
	The Directive Fields
	Directive Edit Scripts
	Initialization Scripts
	Edit Scripts



	V Obtaining and Installing Denemo
	Upgrading Denemo
	Obtaining the Source
	Installing Denemo from Source Code
	To install from source code:
	Generating a Configure Script



